
Dan Gookin
Bestselling author of all previous 
editions of Word For Dummies

Learn to:
•  Work with all the newest Microsoft Word 

features

•  Create and edit documents quickly and 
easily

•  Share your work and collaborate with 
others

•  Use mail merge, create labels, and send 
e-mails in Word

Word 2010Microsoft®

Making Everything Easier!™

         Open the book and find:

•  What all the keys on the keyboard 
are for

•  How to use the Ribbon 

•  Things to know about saving and 
naming files

•  How to recover a document you 
thought was lost

•  Tools for collaborating with others 

•  Tips for taming mail merge

•  A whole chapter on Word’s tools 
for writers

•  The ten commandments of Word

Dan Gookin created the For Dummies format with the original book, 

DOS For Dummies, in 1991. With more than 11 million copies in print, 

his books have been translated into 32 languages. Recent titles include 

PCs For Dummies, Windows 7 Edition and Laptops For Dummies. Visit Dan 

at www.wambooli.com.   

$24.99 US / $29.99 CN / £17.99 UK

ISBN 978-0-470-48772-3

Desktop Applications/Word Processing

Go to Dummies.com®

for videos, step-by-step examples, 
how-to articles, or to shop!

Here’s the last word on Word, 
from the master of 
plain-English explanations!
It’s a whole new Word, so jump right into this book and 
learn how to make the most of it! Here’s what you need to 
know, from firing up Word, understanding how to use the 
spell checker, and turning off features that drive you crazy 
to formatting documents, using templates, adding images, 
and saving your stuff. You can even find special tips for the 
writer in you.

•  New to Word? — here’s the stuff most books assume you already 
know, such as how to use the keyboard, mouse, and gizmos in 
the Word window 

•  Watch your words — clean up errors, replace sections of text, use 
copy-and-paste, and work with text blocks 

•  The grammar cop — make the most of the grammar and spell 
checkers

•  Make friends with formats — format characters, paragraphs, 
and pages to make your documents reader-friendly

•  Stylin’ — create styles to give your documents character

•  The fancy stuff — work with borders, lines, and boxes; add 
tables; and build an index

•  Multitasking — manage multiple documents, convert documents 
from different versions of Word, or save documents in different 
file formats

•  Publish or perish — print your documents or prepare them for 
sharing electronically

W
ord 2010

M
icrosoft

® 

Gookin

spine=.816”



Mobile Apps

There’s a Dummies App for This and That
With more than 200 million books in print and over 1,600 unique 
titles, Dummies is a global leader in how-to information. Now 
you can get the same great Dummies information in an App. With 
topics such as Wine, Spanish, Digital Photography, Certification, 
and more, you’ll have instant access to the topics you need to 
know in a format you can trust.

To get information on all our Dummies apps, visit the following:

www.Dummies.com/go/mobile from your computer.

www.Dummies.com/go/iphone/apps from your phone.

spine=.816”

Start with FREE Cheat Sheets
Cheat Sheets include
 • Checklists
 • Charts
 • Common Instructions
 • And Other Good Stuff!

Get Smart at Dummies.com 
Dummies.com makes your life easier with 1,000s 
of answers on everything from removing wallpaper 
to using the latest version of Windows. 

Check out our
 • Videos
 • Illustrated Articles
 • Step-by-Step Instructions

Plus, each month you can win valuable prizes by entering 
our Dummies.com sweepstakes. *

Want a weekly dose of Dummies? Sign up for Newsletters on
 • Digital Photography
 • Microsoft Windows & Office
 • Personal Finance & Investing
 • Health & Wellness
 • Computing, iPods & Cell Phones
 • eBay
 • Internet
 • Food, Home & Garden

Find out “HOW” at Dummies.com

*Sweepstakes not currently available in all countries; visit Dummies.com for official rules.

Get More and Do More at Dummies.com®

To access the Cheat Sheet created specifically for this book, go to 
www.dummies.com/cheatsheet/word2010

www.dummies.com/cheatsheet/word2010
www.dummies.com
www.dummies.com
www.dummies.com
www.dummies.com


by Dan Gookin

Word 2010
FOR

DUMmIES
‰

01_487723-ffirs.indd   i01_487723-ffirs.indd   i 3/27/10   10:37 AM3/27/10   10:37 AM



Word 2010 For Dummies®

Published by
Wiley Publishing, Inc.
111 River Street
Hoboken, NJ 07030-5774

www.wiley.com

Copyright © 2010 by Wiley Publishing, Inc., Indianapolis, Indiana

Published by Wiley Publishing, Inc., Indianapolis, Indiana

Published simultaneously in Canada

No part of this publication may be reproduced, stored in a retrieval system or transmitted in any form or 
by any means, electronic, mechanical, photocopying, recording, scanning or otherwise, except as permit-
ted under Sections 107 or 108 of the 1976 United States Copyright Act, without either the prior written 
permission of the Publisher, or authorization through payment of the appropriate per-copy fee to the 
Copyright Clearance Center, 222 Rosewood Drive, Danvers, MA 01923, (978) 750-8400, fax (978) 646-8600. 
Requests to the Publisher for permission should be addressed to the Permission Department, John Wiley 
& Sons, Inc., 111 River Street, Hoboken, NJ 07030, (201) 748-6011, fax (201) 748-6008, or online at http://
www.wiley.com/go/permissions.

Trademarks: Wiley, the Wiley Publishing logo, For Dummies, the Dummies Man logo, A Reference for the 
Rest of Us!, The Dummies Way, Dummies Daily, The Fun and Easy Way, Dummies.com, Making Everything 
Easier, and related trade dress are trademarks or registered trademarks of John Wiley & Sons, Inc. and/
or its affi liates in the United States and other countries, and may not be used without written permission. 
All other trademarks are the property of their respective owners. Wiley Publishing, Inc., is not associated 
with any product or vendor mentioned in this book.

LIMIT OF LIABILITY/DISCLAIMER OF WARRANTY: THE PUBLISHER AND THE AUTHOR MAKE NO 
REPRESENTATIONS OR WARRANTIES WITH RESPECT TO THE ACCURACY OR COMPLETENESS OF 
THE CONTENTS OF THIS WORK AND SPECIFICALLY DISCLAIM ALL WARRANTIES, INCLUDING WITH-
OUT LIMITATION WARRANTIES OF FITNESS FOR A PARTICULAR PURPOSE. NO WARRANTY MAY BE 
CREATED OR EXTENDED BY SALES OR PROMOTIONAL MATERIALS. THE ADVICE AND STRATEGIES 
CONTAINED HEREIN MAY NOT BE SUITABLE FOR EVERY SITUATION. THIS WORK IS SOLD WITH THE 
UNDERSTANDING THAT THE PUBLISHER IS NOT ENGAGED IN RENDERING LEGAL, ACCOUNTING, OR 
OTHER PROFESSIONAL SERVICES. IF PROFESSIONAL ASSISTANCE IS REQUIRED, THE SERVICES OF 
A COMPETENT PROFESSIONAL PERSON SHOULD BE SOUGHT. NEITHER THE PUBLISHER NOR THE 
AUTHOR SHALL BE LIABLE FOR DAMAGES ARISING HEREFROM. THE FACT THAT AN ORGANIZA-
TION OR WEBSITE IS REFERRED TO IN THIS WORK AS A CITATION AND/OR A POTENTIAL SOURCE 
OF FURTHER INFORMATION DOES NOT MEAN THAT THE AUTHOR OR THE PUBLISHER ENDORSES 
THE INFORMATION THE ORGANIZATION OR WEBSITE MAY PROVIDE OR RECOMMENDATIONS IT 
MAY MAKE. FURTHER, READERS SHOULD BE AWARE THAT INTERNET WEBSITES LISTED IN THIS 
WORK MAY HAVE CHANGED OR DISAPPEARED BETWEEN WHEN THIS WORK WAS WRITTEN AND 
WHEN IT IS READ. 

For general information on our other products and services, please contact our Customer Care 
Department within the U.S. at 877-762-2974, outside the U.S. at 317-572-3993, or fax 317-572-4002.

For technical support, please visit www.wiley.com/techsupport.

Wiley also publishes its books in a variety of electronic formats. Some content that appears in print may 
not be available in electronic books.

Library of Congress Control Number: 2010923553 

ISBN: 978-0-470-48772-3

Manufactured in the United States of America

10   9   8   7   6   5   4   3   2   1

01_487723-ffirs.indd   ii01_487723-ffirs.indd   ii 3/27/10   10:37 AM3/27/10   10:37 AM

www.wiley.com
www.wiley.com/go/permissions
www.wiley.com/go/permissions
www.wiley.com/techsupport


About the Author
After physically destroying three typewriters, Dan Gookin bought his fi rst 
computer in 1982 at the urging of the guy in the typewriter repair shop. 
Contrary to his prejudices, Dan quickly discovered that computers were 
about more than math, and he quickly took to the quirky little devices.

Thirty years later, Mr. Gookin has written over 100 books about computers and 
high tech and gone through more than 50 computers, including a dozen or so 
laptops and portables. He has achieved fame as one of the fi rst computer radio 
talk show hosts, the editor of a computer magazine, a national technology 
spokesman, and an occasional actor on the community theater stage.

Dan still considers himself a writer and computer “guru” whose job it is 
to remind everyone that computers are not to be taken too seriously. His 
approach to computers is light and humorous, yet very informative. He 
knows that the complex beasts are important and can do a great deal to 
help people become productive and successful. Dan mixes his vast knowl-
edge of computers with a unique, dry sense of humor that keeps everyone 
informed — and awake. His favorite quote is “Computers are a notoriously 
dull subject, but that doesn’t mean I have to write about them that way.”

Dan Gookin’s most recent books are PCs For Dummies, Windows 7 Edition, 
and Laptops For Dummies, 4th Edition. He holds a degree in communications/
visual arts from the University of California, San Diego. Dan dwells in North 
Idaho, where he enjoys woodworking, music, theater, riding his bicycle, and 
spending time with his boys.

01_487723-ffirs.indd   iii01_487723-ffirs.indd   iii 3/27/10   10:37 AM3/27/10   10:37 AM



Publisher’s Acknowledgments

We’re proud of this book; please send us your comments through our online registration form located 
at http://dummies.custhelp.com. For other comments, please contact our Customer Care 
Department within the U.S. at 877-762-2974, outside the U.S. at 317-572-3993, or fax 317-572-4002.

Some of the people who helped bring this book to market include the following:

Acquisitions and Editorial

Senior Project Editor: Mark Enochs

Acquisitions Editor: Katie Mohr

Copy Editor: Rebecca Whitney

Technical Editor: James F. Kelly

Editorial Manager: Leah Cameron

Editorial Assistant: Amanda Graham

Sr. Editorial Assistant: Cherie Case

Cartoons: Rich Tennant 
(www.the5thwave.com)

Composition Services

Project Coordinator: Lynsey Stanford 

Layout and Graphics: Ashley Chamberlain, 
Samantha K. Cherolis, Christine Williams

Proofreaders: The Well-Chosen Word

Indexer: Steve Rath

Publishing and Editorial for Technology Dummies

Richard Swadley, Vice President and Executive Group Publisher

Andy Cummings, Vice President and Publisher

Mary Bednarek, Executive Acquisitions Director

Mary C. Corder, Editorial Director

Publishing for Consumer Dummies

Diane Graves Steele, Vice President and Publisher

Composition Services

Debbie Stailey, Director of Composition Services

01_487723-ffirs.indd   iv01_487723-ffirs.indd   iv 3/27/10   10:37 AM3/27/10   10:37 AM



Contents at a Glance
Introduction ................................................................ 1

Part I: Your Introduction to Word .................................. 7
Chapter 1: Hello, Word! ..................................................................................................... 9
Chapter 2: The Typing Chapter...................................................................................... 21

Part II: Your Basic Word ............................................ 31
Chapter 3: To and Fro in a Document ........................................................................... 33
Chapter 4: Text Editing ................................................................................................... 41
Chapter 5: Search for This, Replace It with That ......................................................... 49
Chapter 6: Blocks o’ Text ................................................................................................ 63
Chapter 7: Spell It Write .................................................................................................. 77
Chapter 8: Documents and Such .................................................................................... 89
Chapter 9: Publish Your Document ............................................................................. 103

Part III: Formatting ................................................. 117
Chapter 10: Character Formatting ............................................................................... 119
Chapter 11: Paragraph Formatting .............................................................................. 131
Chapter 12: Tab Formatting ......................................................................................... 145
Chapter 13: Page Formatting ........................................................................................ 161
Chapter 14: Document Formatting .............................................................................. 173
Chapter 15: Word Formatting Styles ........................................................................... 185
Chapter 16: Fun with Themes and Template Formatting ......................................... 199
Chapter 17: Sundry Formatting .................................................................................... 209

Part IV: Spruce Up a Dull Document ......................... 219
Chapter 18: Lines and Colors ....................................................................................... 221
Chapter 19: Able Tables ................................................................................................ 229
Chapter 20: Columns of Text ........................................................................................ 241
Chapter 21: Lots of Lists ............................................................................................... 249
Chapter 22: Here Come the Graphics .......................................................................... 257
Chapter 23: Even More Things to Insert in Your Document .................................... 271

02_487723-ftoc.indd   v02_487723-ftoc.indd   v 3/27/10   10:38 AM3/27/10   10:38 AM



Part V: Even More Word ........................................... 281
Chapter 24: Multiple Documents, Windows, and File Formats ................................ 283
Chapter 25: Word for Writers ....................................................................................... 291
Chapter 26: Let’s Work This Out .................................................................................. 305
Chapter 27: Mail Merge Mania...................................................................................... 315
Chapter 28: Labels of Love ........................................................................................... 331
Chapter 29: A More Custom Word ............................................................................... 339

Part VI: The Part of Tens .......................................... 347
Chapter 30: The Ten Commandments of Word ......................................................... 349
Chapter 31: Ten Cool Tricks ......................................................................................... 353
Chapter 32: Ten Bizarre Things ................................................................................... 361
Chapter 33: Ten Avuncular Suggestions ..................................................................... 367

Index ...................................................................... 371

02_487723-ftoc.indd   vi02_487723-ftoc.indd   vi 3/27/10   10:38 AM3/27/10   10:38 AM



Table of Contents

Introduction ................................................................. 1
About This Book .............................................................................................. 1
How to Use This Book ..................................................................................... 2
Foolish Assumptions ....................................................................................... 3
How This Book Is Organized .......................................................................... 3

Part I: Your Introduction to Word ....................................................... 4
Part II: Your Basic Word........................................................................ 4
Part III: Formatting ................................................................................. 4
Part IV: Spruce Up a Dull Document .................................................... 4
Part V: Even More Word ....................................................................... 4
Part VI: The Part of Tens ....................................................................... 5

What’s Not Here ............................................................................................... 5
Icons Used in This Book ................................................................................. 5
Where to Go from Here ................................................................................... 6

Part I: Your Introduction to Word .................................. 7

Chapter 1: Hello, Word! . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9

Getting Word Started ...................................................................................... 9
The good, yet unimaginative, way to start Word ............................ 10
The better way to start Word ............................................................. 11
The best way to start Word ................................................................ 11
Start Word by opening a document .................................................. 12

Looking at Word ............................................................................................ 13
Around the Word window .................................................................. 14
The blank place where you write....................................................... 16
The mouse pointer in Word ............................................................... 17

Ending Your Word Processing Day ............................................................. 18
To quit Word ........................................................................................ 18
Quit what you’re doing without quitting Word ................................ 19
Set Word aside ..................................................................................... 20

Chapter 2: The Typing Chapter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .21

Behold the PC Keyboard! .............................................................................. 21
The Old Hunt-and-Peck ................................................................................. 23

Follow the blinking cursor .................................................................. 24
When to whack the spacebar ............................................................. 24
Backup and erase keys ........................................................................ 25
When to press that Enter key ............................................................. 26

02_487723-ftoc.indd   vii02_487723-ftoc.indd   vii 3/27/10   10:38 AM3/27/10   10:38 AM



Word 2010 For Dummies viii
Stuff That Happens While You Type ........................................................... 27

The left end of the status bar ............................................................. 27
Between the pages ............................................................................... 27
Spots and clutter in your text ............................................................ 28
Strange underlines and colored text ................................................. 29

Part II: Your Basic Word ............................................. 31

Chapter 3: To and Fro in a Document  . . . . . . . . . . . . . . . . . . . . . . . . . . . .33

Scroll Through a Document ......................................................................... 33
Using the vertical scroll bar ............................................................... 34
Using the horizontal scroll bar .......................................................... 35
Scrolling your document with the mouse......................................... 35

Move the Insertion Pointer ........................................................................... 36
Commanding the insertion pointer with the mouse ....................... 36
Moving in small increments (basic arrow keys) .............................. 36
Moving from beginning to end ........................................................... 37

The Browse Buttons ...................................................................................... 38
Get Back to Where You Once Edited .......................................................... 39
Go to Wherever with the Go To Command ................................................ 39

Chapter 4: Text Editing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .41

Remove Text You Don’t Want ...................................................................... 41
Deleting single characters .................................................................. 42
Deleting a word .................................................................................... 42
Deleting more than a word ................................................................. 43

Split and Join Paragraphs ............................................................................. 45
Making two paragraphs from one ...................................................... 45
Making one paragraph from two ........................................................ 45

The Soft and Hard Returns ........................................................................... 46
Undo Mistakes with Undo Haste .................................................................. 47

Redo, the Undo-Undo command ........................................................ 47
Redo, the Repeat Typing command .................................................. 48

Chapter 5: Search for This, Replace It with That  . . . . . . . . . . . . . . . . . .49

Text Happily Found ....................................................................................... 49
Using the Find command .................................................................... 50
Using the traditional Find command ................................................. 52
Finding more than text ........................................................................ 53
Finding stuff you can’t type in ............................................................ 55
Finding formatting ............................................................................... 57

Replace Found Text and Stuff ...................................................................... 59
Replacing it all at once ........................................................................ 61
Finding and replacing formatting....................................................... 61

02_487723-ftoc.indd   viii02_487723-ftoc.indd   viii 3/27/10   10:38 AM3/27/10   10:38 AM



ix Table of Contents

Chapter 6: Blocks o’ Text  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .63

Understanding Blocks ................................................................................... 63
Selecting Blocks of Text ................................................................................ 65

Using the keyboard to select text ...................................................... 65
Marking a block with the mouse ........................................................ 66
Using the F8 key to mark a block ....................................................... 68
Blocking the whole dang-doodle document ..................................... 69

Deselecting a Block ....................................................................................... 70
Manipulating Blocks of Text ......................................................................... 70

Copying a block .................................................................................... 70
Moving a block ..................................................................................... 71
Setting the pasted text format ............................................................ 72
Copying or moving a block with the mouse ..................................... 73

Collecting and Pasting .................................................................................. 74
Looking at the Clipboard pane ........................................................... 74
Pasting from the Clipboard pane ....................................................... 75
Cleansing the Clipboard pane ............................................................ 75

Chapter 7: Spell It Write  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .77

Hue Right Grate .............................................................................................. 77
Check Your Spelling ...................................................................................... 78

Dealing with on-the-fl y spell checking ............................................... 78
Dealing with words incorrectly fl agged as being misspelled ......... 79
Undoing the Ignore All command ...................................................... 80
Removing words from the custom dictionary ................................. 81

AutoCorrect Your Common Typos ............................................................. 82
Understanding AutoCorrect ............................................................... 82
Creating your own AutoCorrect entries............................................ 83
Undoing an AutoCorrect correction .................................................. 84

Grammar Be Good ......................................................................................... 84
All-at-Once Document Proofi ng ................................................................... 85
Control Word’s Proofi ng Options ................................................................ 86

Changing spell-check and grammar settings .................................... 87
Perusing AutoCorrect options ........................................................... 87

Chapter 8: Documents and Such  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .89

What Is a File? ................................................................................................ 89
A New Document ........................................................................................... 90
Save Your Stuff! .............................................................................................. 92

Saving a document the fi rst time ....................................................... 92
Dealing with document-save errors .................................................. 94
Saving or updating a document ......................................................... 95
Forgetting to save before you quit .................................................... 95

02_487723-ftoc.indd   ix02_487723-ftoc.indd   ix 3/27/10   10:38 AM3/27/10   10:38 AM



Word 2010 For Dummies x
Open a Document .......................................................................................... 96

Using the Open command .................................................................. 96
Opening a document icon ................................................................... 98
Accessing recently opened fi les ......................................................... 98
Opening more than one document at a time .................................... 99
Opening one document inside another............................................. 99

Close a Document ........................................................................................ 100
Recover a Draft ............................................................................................ 101

Chapter 9: Publish Your Document . . . . . . . . . . . . . . . . . . . . . . . . . . . . .103

Your Document on Paper ........................................................................... 103
Preparing the printer ......................................................................... 104
Previewing a document ..................................................................... 105
Printing the whole document ........................................................... 106
Printing a specifi c page ..................................................................... 108
Printing a range of pages .................................................................. 108
Printing a block .................................................................................. 109
Printing more than one copy of something .................................... 109
Choosing another printer ................................................................. 110
Canceling a print job ......................................................................... 110

Electronic Publishing .................................................................................. 112
Preparing a document for sharing ................................................... 112
Sending a Word document by e-mail ............................................... 113
Saving a Word document in a sharable format .............................. 114
Saving a Word document as a PDF .................................................. 115

Part III: Formatting .................................................. 117

Chapter 10: Character Formatting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .119

How to Format Characters ......................................................................... 119
Basic Character Formatting ....................................................................... 120

Changing the font ............................................................................... 121
Applying character formats .............................................................. 122
Using less-common character attributes ........................................ 124

Text Transcending Teeny to Titanic ......................................................... 124
Understanding points ........................................................................ 124
Setting the text size ........................................................................... 125
Nudging text size ................................................................................ 126

More Colorful Characters ........................................................................... 126
Text Formatting with the Font Dialog Box ............................................... 127
Changing Text Case ..................................................................................... 129
Removing Character Formatting ............................................................... 130

02_487723-ftoc.indd   x02_487723-ftoc.indd   x 3/27/10   10:38 AM3/27/10   10:38 AM



xi Table of Contents

Chapter 11: Paragraph Formatting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .131

How to Format a Paragraph ....................................................................... 131
Where the Paragraph Formatting Commands Lurk ................................ 132
Paragraph Justifi cation and Alignment ..................................................... 134

Line up on the left! ............................................................................. 134
Everyone center! ................................................................................ 134
Line up on the right! .......................................................................... 135
Line up on both sides! ....................................................................... 135

Make Room Before, After, or Inside Paragraphs ..................................... 135
Setting the line spacing ..................................................................... 136
Setting specifi c line spacing options ............................................... 137
Making space between paragraphs ................................................. 138

Paragraph Indentation ................................................................................ 139
Indenting the fi rst line of a paragraph............................................. 139
Making a hanging indent (an outdent) ............................................ 140
Indenting a whole paragraph ........................................................... 140

Who Died and Made This Thing Ruler? .................................................... 141

Chapter 12: Tab Formatting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .145

Once Upon a Tab ......................................................................................... 145
The Standard Left Tab Stop ....................................................................... 147

Creating a basic tabbed list .............................................................. 148
Creating a two-tab paragraph thing................................................. 149

The Center Tab Stop ................................................................................... 151
The Right Tab Stop ...................................................................................... 152

Making a right-stop, left-stop list ..................................................... 152
Building a two-column right stop list .............................................. 153

The Decimal Tab .......................................................................................... 154
The Bar Tab .................................................................................................. 155
The Tabs Dialog Box ................................................................................... 156

Setting a tab in the Tabs dialog box ................................................ 157
Setting leader tabs ............................................................................. 158

Tab Stop, Be Gone! ...................................................................................... 159

Chapter 13: Page Formatting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .161

Describe That Page ..................................................................................... 161
Setting page size................................................................................. 162
Setting orientation (landscape or portrait) .................................... 163
Confi guring the page margins .......................................................... 164
Using the Page Setup dialog box ...................................................... 165

Page Numbering ........................................................................................... 167
Adding an automatic page number ................................................. 167
Starting off with a different page number ....................................... 168
Numbering with roman numerals .................................................... 169
Removing page numbers .................................................................. 169

02_487723-ftoc.indd   xi02_487723-ftoc.indd   xi 3/27/10   10:38 AM3/27/10   10:38 AM



Word 2010 For Dummies xii
New Pages from Nowhere ........................................................................... 169

Starting on a new page ...................................................................... 170
Inserting a whole, blank page ........................................................... 170

Page Froufrou ............................................................................................... 171
Coloring pages .................................................................................... 171
Adding a watermark .......................................................................... 172

Chapter 14: Document Formatting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .173

The Oft Misunderstood Yet Useful Concept of Sections ........................ 173
Understanding sections .................................................................... 174
Creating a section .............................................................................. 175
Using a section ................................................................................... 176
Deleting a section break .................................................................... 176

Add a Cover Page (Sneaky and Quick) ..................................................... 177
Headers and Footers ................................................................................... 178

Adding a header or footer................................................................. 178
Editing a header or footer ................................................................. 179
Making odd and even headers or footers ....................................... 181
Removing the header and footer from the fi rst page .................... 182
Working with headers and footers in document sections ............ 183
Removing a header or footer ............................................................ 184

Chapter 15: Word Formatting Styles . . . . . . . . . . . . . . . . . . . . . . . . . . . .185

The Big Style Overview ............................................................................... 185
Understanding style types ................................................................ 186
Finding the styles in Word ................................................................ 187
Using a style........................................................................................ 188
Understanding heading styles .......................................................... 189
Determining which style you’re using ............................................. 190
Switching to another style set .......................................................... 191
Unapplying a style ............................................................................. 191

Make Your Own Styles ................................................................................ 192
Creating a style based on text 

you’ve already formatted .............................................................. 192
Creating a style from scratch ........................................................... 194
Modifying a style ................................................................................ 194
Giving your style a shortcut key ...................................................... 195
Customizing the Quick Style Gallery ............................................... 196
Deleting a style ................................................................................... 197

Chapter 16: Fun with Themes and Template Formatting. . . . . . . . . . .199

The Theme of Things .................................................................................. 199
Applying a document theme ............................................................ 200
Modifying or creating a theme ......................................................... 201

02_487723-ftoc.indd   xii02_487723-ftoc.indd   xii 3/27/10   10:38 AM3/27/10   10:38 AM



xiii Table of Contents

Create Instant Documents by Using Templates ...................................... 202
Starting a new document by using a template ............................... 203
Creating a template based on a document you already have ...... 204
Making a new template from scratch .............................................. 205
Modifying a template ......................................................................... 205
Attaching a template to a document ............................................... 206
Borrowing an existing document as a template ............................ 207

Chapter 17: Sundry Formatting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .209

Weird and Fun Text Attributes .................................................................. 209
Automatic Formatting ................................................................................. 211

Enjoying automagical text ................................................................ 211
Paragraph formatting tricks ............................................................. 212
Undoing an AutoFormat .................................................................... 214
Disabling the @#$%&! AutoFormat .................................................. 214

Center a Page, Top to Bottom .................................................................... 215
Steal This Format! ........................................................................................ 216

Part IV: Spruce Up a Dull Document .......................... 219

Chapter 18: Lines and Colors  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .221

The Basics of Lines and Colors .................................................................. 221
Using the Border command button ................................................. 222
Summoning the Borders and Shading dialog box .......................... 223
Using the Shading command button ............................................... 223

Lines, Borders, and Boxes .......................................................................... 224
Putting a line above a heading ......................................................... 224
Boxing text or paragraphs ................................................................ 224
Boxing a title ....................................................................................... 225
Making rules ....................................................................................... 225
Drawing a fat, thick line..................................................................... 226
Putting a border around a page of text ........................................... 226
Removing borders ............................................................................. 227

Background Colors and Shading ............................................................... 228

Chapter 19: Able Tables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .229

Suddenly There’s a Table in Your Document .......................................... 229
Working with tables in Word ............................................................ 230
Creating an instant table ................................................................... 231
Making a table “this” big ................................................................... 231
Drawing a table .................................................................................. 232

02_487723-ftoc.indd   xiii02_487723-ftoc.indd   xiii 3/27/10   10:38 AM3/27/10   10:38 AM



Word 2010 For Dummies xiv
Text in Tables ............................................................................................... 233

Putting text into a table ..................................................................... 234
Selecting text in a table ..................................................................... 234
Converting text into a table .............................................................. 235
Turning a table back into plain text ................................................ 235

Table Formatting ......................................................................................... 236
Manipulating a table with the mouse .............................................. 236
Adjusting the table............................................................................. 237
Designing a table ................................................................................ 238
Deleting a table................................................................................... 239

Chapter 20: Columns of Text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .241

All about Columns ....................................................................................... 241
Making more than three columns .................................................... 243
Mixing column formats ..................................................................... 244
Adjusting the columns in the Columns dialog box ........................ 244

The End of the Column ............................................................................... 244
Giving up and going back to one column........................................ 245
Ending multiple columns in the middle of a document ................ 245
Using a column break ........................................................................ 246

Chapter 21: Lots of Lists. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .249

Lists with Bullets and Numbers ................................................................. 249
Making a bulleted list ........................................................................ 249
Numbering a list ................................................................................. 250
Creating a multilevel numbered list ................................................ 251
Numbering lines on a page ............................................................... 251

Lists of Document Contents ....................................................................... 252
Creating a table of contents ............................................................. 252
Building an index ............................................................................... 253

Footnotes and Endnotes ............................................................................. 255

Chapter 22: Here Come the Graphics  . . . . . . . . . . . . . . . . . . . . . . . . . . .257

Graphical Goobers in Your Text ................................................................ 258
Plopping down a picture ................................................................... 258
Inserting clip art ................................................................................. 259
Slapping down a shape...................................................................... 260
Saving time with SmartArt ................................................................ 261
Choosing a chart ................................................................................ 262
Adding some WordArt ....................................................................... 262
Taking a screenshot .......................................................................... 263
Adding a caption ................................................................................ 263
Deleting an image or artwork ........................................................... 264

Images in and around Your Text ............................................................... 265
Wrapping text around an image ....................................................... 265
Moving an image hither and thither ................................................ 266

02_487723-ftoc.indd   xiv02_487723-ftoc.indd   xiv 3/27/10   10:38 AM3/27/10   10:38 AM



xv Table of Contents

Image Editing ................................................................................................ 267
Resizing an image............................................................................... 267
Cropping an image ............................................................................. 268
Rotating an image .............................................................................. 269
Changing an image’s appearance .................................................... 269
Arranging multiple images ................................................................ 270

Chapter 23: Even More Things to Insert in Your Document  . . . . . . . .271

Characters Fun and Funky .......................................................................... 271
Nonbreaking spaces and hyphens ................................................... 272
Typing characters such as Ü, Ç, and Ñ ........................................... 272
Inserting special characters and symbols ...................................... 273

Spice Up Your Document with a Text Box ............................................... 274
A Vast Depth of Fields ................................................................................. 275

Placing a fi eld in a document ........................................................... 275
Playing with fi elds .............................................................................. 278

The Date and Time ...................................................................................... 279
Sticking the current date or time into a document ....................... 279
Typing date-and time keyboard shortcuts ..................................... 280
Using the PrintDate fi eld ................................................................... 280

Part V: Even More Word ............................................ 281

Chapter 24: Multiple Documents, Windows, and File Formats  . . . . .283

Multiple Document Mania .......................................................................... 283
Opening several documents at once ............................................... 284
Switching between multiple documents ......................................... 284
Viewing more than one document at a time .................................. 285
Comparing two documents side by side......................................... 285
Viewing the same document in multiple windows ........................ 286
Using the old split-screen trick ........................................................ 286

Many, Many Document Types ................................................................... 287
Understanding document formats ................................................... 287
Opening a non-Word document ....................................................... 288
Saving a document in another fi le format ....................................... 289
Converting an older Word document.............................................. 290

Chapter 25: Word for Writers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .291

Organize Your Thoughts ............................................................................ 291
Entering Outline view ........................................................................ 292

Putting Topics in the Outline ..................................................................... 293
Demoting a topic (creating subtopics) ........................................... 294
Promoting a topic .............................................................................. 295
Adding a text topic ............................................................................ 295

02_487723-ftoc.indd   xv02_487723-ftoc.indd   xv 3/27/10   10:38 AM3/27/10   10:38 AM



Word 2010 For Dummies xvi
Rearranging topics ............................................................................. 296
Expanding and contracting topics ................................................... 296
Printing an outline ............................................................................. 297

Large Document Organization ................................................................... 297
Setting up for a large document ....................................................... 297
Creating a master document ............................................................ 299
Splitting a document ......................................................................... 300

Improve Your Word Power ........................................................................ 300
Finding the best word ....................................................................... 301
Using the Research task pane .......................................................... 302

Dan’s Writing Tips ....................................................................................... 302
Writing for writers ............................................................................. 303
Making every word count ................................................................. 303
Avoiding writer’s block ..................................................................... 304

Chapter 26: Let’s Work This Out. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .305

Comments on Your Text ............................................................................. 305
Adding a comment ............................................................................. 305
Hiding comments ............................................................................... 307
Reviewing comments......................................................................... 307
Printing comments (or not) .............................................................. 308
Deleting comments ............................................................................ 308

Whip Out the Yellow Highlighter ............................................................... 309
Look What They’ve Done to My Text, Ma ................................................ 310

Comparing two versions of the same document ........................... 310
Tracking changes as you make them .............................................. 312
Reviewing changes ............................................................................ 312

Chapter 27: Mail Merge Mania  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .315

About Mail Merge ........................................................................................ 315
Understanding Word’s mail merge terminology ............................ 316
Reviewing the mail merge process .................................................. 317

The Main Document .................................................................................... 318
Creating a mail merge letter ............................................................. 318
Creating mail merge e-mail messages ............................................. 319
Creating mail merge envelopes ........................................................ 320
Creating a mail merge directory ...................................................... 321

The Recipient List ........................................................................................ 321
Creating a recipient list ..................................................................... 321
Using an already created recipient list ........................................... 324
Grabbing a recipient list from Outlook ........................................... 325
Editing a recipient list ....................................................................... 326

Fold in the Fields ......................................................................................... 326

02_487723-ftoc.indd   xvi02_487723-ftoc.indd   xvi 3/27/10   10:38 AM3/27/10   10:38 AM



xvii Table of Contents

Mail Merge Ho! ............................................................................................. 327
Previewing the merged documents ................................................. 328
Merging to a new set of documents................................................. 329
Merging to the printer ....................................................................... 329
Merging to e-mail ............................................................................... 330

Chapter 28: Labels of Love  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .331

The Label Thing ........................................................................................... 331
Here’s a Sheet of Identical Labels .............................................................. 332
Print That Address List ............................................................................... 333
A Label Trick with Graphics ....................................................................... 335

Chapter 29: A More Custom Word . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .339

My, What Big Text You Have! ..................................................................... 339
Working the Status Bar Zoom control ............................................. 340
Using the Zoom commands .............................................................. 340

A Better Status Bar ...................................................................................... 341
Word’s Changing Interface ......................................................................... 342

Finding the Quick Access toolbar .................................................... 342
Customizing the Quick Access toolbar ........................................... 343
Adding stuff to the Ribbon................................................................ 345

Part VI: The Part of Tens ........................................... 347

Chapter 30: The Ten Commandments of Word  . . . . . . . . . . . . . . . . . . .349

Thou Shalt Remember to Save Thy Work ................................................ 349
Thou Shalt Not Use More Than One Space .............................................. 350
Thou Shalt Not Press Enter at the End of Each Line ............................... 350
Thou Shalt Not Neglect Thy Keyboard ..................................................... 350
Thou Shalt Not Manually Number Thy Pages .......................................... 351
Thou Shalt Not Use the Enter Key to Start a New Page .......................... 351
Thou Shalt Not Forget Thy Undo Command ............................................ 351
Honor Thy Printer ....................................................................................... 351
Thou Shalt Have Multiple Document Windows Before Thee ................. 352
Neglecteth Not Windows ............................................................................ 352

Chapter 31: Ten Cool Tricks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .353

Automatic Save with AutoRecover ............................................................ 353
Keyboard Power! ......................................................................................... 354
Build Your Own Fractions .......................................................................... 355
Electronic Bookmarks ................................................................................. 355
Lock Your Document .................................................................................. 356

02_487723-ftoc.indd   xvii02_487723-ftoc.indd   xvii 3/27/10   10:38 AM3/27/10   10:38 AM



Word 2010 For Dummies xviii
The Drop Cap ............................................................................................... 356
Map Your Document ................................................................................... 357
Add an Envelope to Your Letter ................................................................ 358
Sort Your Text .............................................................................................. 358
Text That Doesn’t Print .............................................................................. 359

Chapter 32: Ten Bizarre Things  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .361

Equations ...................................................................................................... 361
Math .............................................................................................................. 362
Make a Macro ............................................................................................... 362
The Developer Tab ...................................................................................... 363
Hyphenation ................................................................................................. 364
Document Properties .................................................................................. 364
Cross-References ......................................................................................... 364
Smart Tags .................................................................................................... 365
Click-and-Type ............................................................................................. 365
Word and the Internet ................................................................................. 366

Chapter 33: Ten Avuncular Suggestions  . . . . . . . . . . . . . . . . . . . . . . . .367

Keep Printer Paper, Toner, and Supplies Handy ..................................... 367
Get Some References ................................................................................... 368
Keep Your Computer Files Organized ...................................................... 368
Add the Junk Later ...................................................................................... 368
Back Up Your Work ..................................................................................... 369
Use AutoCorrect .......................................................................................... 369
Use Those Keyboard Shortcuts ................................................................. 369
Try New Things ............................................................................................ 369
Let Word Do the Work ................................................................................ 370
Don’t Take It All Too Seriously .................................................................. 370

Index ....................................................................... 371

02_487723-ftoc.indd   xviii02_487723-ftoc.indd   xviii 3/27/10   10:38 AM3/27/10   10:38 AM



Introduction

The only thing standing between you and your writing is your word 
processor. Yeah, I know: It’s supposed to be helpful. Well, it tries. 

Computers can do only so much. But you, as a smart person, are capable of 
so much more. I’m guessing that’s why you’ve opened this book.

Welcome to Word 2010 For Dummies, which takes the pain from using 
Microsoft’s latest, greatest, most confusing word processing software ever! 
This book is your friendly, informative, and entertaining guide to the new-
fangled way of processing words that is Word 2010.

Be warned: I’m not out to make you love Word. I don’t even want you to enjoy 
the program. Use it, yes. Tolerate it, of course. The only promise I’m offering 
is that this book helps ease the pain that everyone feels from using Microsoft 
Word at the dawn of the 21st century. Along the way, I kick Word in the butt 
and you will, I hope, enjoy reading about it.

About This Book
I don’t intend for you to read this book from cover to cover. It’s not a novel, 
and if it were, it would be a political space opera with an antihero and a 
princess fighting elected officials who are in cahoots with a galactic urban 
renewal development corporation. The ending would be extremely satisfying, 
but it would be a long novel because I need something to balance out Atlas 
Shrugged on my bookshelf. Anyway.

This book is a reference. Each chapter covers a specific topic or task that 
Word does. Within a chapter, you find self-contained sections, each of which 
describes how to perform a specific task or get something done. Sample sec-
tions you encounter in this book include

 ✓ Save your stuff

 ✓ Moving a block of text

 ✓ Check your spelling

 ✓ How to format a paragraph

 ✓ Putting text into a table

 ✓ Inserting clip art

 ✓ Mail merge, ho!
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I give you no keys to memorize, no secret codes, no tricks, no videos to sleep 
through, and no wall charts. Instead, each section explains a topic as though 
it’s the first thing you read in this book. Nothing is assumed, and everything 
is cross-referenced. Technical terms and topics, when they come up, are 
neatly shoved to the side, where you can easily avoid reading them. The idea 
here isn’t for you to learn anything. This book’s philosophy is to help you 
look it up, figure it out, and get back to work.

How to Use This Book
You hold in your hands an active book. The topics between this book’s 
yellow-and-black covers are all geared toward getting things done in Word 
2010. Because nothing is assumed, all you need to do is find the topic that 
interests you and read.

Word uses the mouse and keyboard to get things done.

This is a keyboard shortcut:

Ctrl+P

This shortcut means that you should press and hold the Ctrl (control) key 
and type the letter P, just as you would press Shift+P to create a capital P. 
Sometimes, you must press more than two keys at the same time:

Ctrl+Shift+T

In this line, you press Ctrl and Shift together and then press the T key. 
Release all three keys.

Commands in Word 2010 exist as command buttons on the Ribbon interface. 
This book may refer to the tab, the command group, and then the button 
itself to help you locate that command button — for example, the Page 
Color button in the Page Background group on the Page Layout tab. Or, I 
might write, “the Page Color button found in the Page Layout tab’s Page 
Background group.”

Menu commands are listed like this:

Table➪Insert Table

This command tells you to choose from the Table menu the command named 
Insert Table. The Table menu appears as a button on the Ribbon.

The main menu in Word 2010 is the File tab menu. It replaces the File menu 
from older versions of Word, and the Office Button menu, found in Microsoft 
Office 2007. Clicking the File tab displays the File tab menu, which fills the 
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entire Word window. To return to Word, click the File tab menu again or 
press the Esc key.

When I describe a message or something you see onscreen, it looks like this:

Why should I bother to love Glenda when robots will
eventually destroy the human race?

If you need further help in operating your computer I can recommend my 
book PCs For Dummies. It contains lots of useful information to supplement 
what you find in this book.

Foolish Assumptions
Though this book was written with the beginner in mind, I still make a few 
assumptions. Foremost, I assume that you’re a human being, though you 
might also be an alien from another planet. If so, welcome to Earth. When you 
conquer our planet, please do Idaho last. Thanks.

Another foolish assumption I make is that you use Windows as the com-
puter’s operating system, either Windows Vista or Windows 7 or any other 
version of Windows that can run Word 2010. Word and Windows have no spe-
cific issues as far as this book is concerned, but keep in mind that this book 
isn’t about Windows.

Your word processor is Microsoft Word 2010. It is not Microsoft Works. It 
is not an earlier version of Word. It is not WordPerfect. It is not a version of 
Word that runs on a Macintosh.

Throughout this book, I use the term Word to refer to the Microsoft Word 
program. The program may also be called Word 2010 or even Microsoft Office 
Word 2010. It’s all Word as far as this book is concerned. Word 2010 is a part 
of the Microsoft Office 2010 suite of programs. This book doesn’t cover any 
other part of Microsoft Office, though I mention Excel and Outlook wherever 
they encroach upon Word’s turf.

How This Book Is Organized
This book contains six major parts, each of which is divided into two or 
more chapters. The chapters themselves have been sliced into smaller, 
modular sections. You can pick up the book and read any section without 
necessarily knowing what has already been covered in the rest of the book. 
Start anywhere.
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4 Word 2010 For Dummies 

Here’s a breakdown of the parts and what you can find in them:

Part I: Your Introduction to Word
This part provides a quick introduction to Word and word processing. You 
can find information on how to start and quit Word and a simple overview of 
the typical word processing day.

Part II: Your Basic Word
The chapters in this part of the book cover the seven basic tasks of any word 
processor: move around a document, edit text, search and replace, work 
with blocks of text, proof documents, save and open, and, finally, publish. 
(Publishing has replaced printing as the final result of your word process-
ing efforts, though printing is still covered as part of the whole publishing 
milieu.)

Part III: Formatting
This part deals with formatting, from the smallest iota of text to formatting 
commands that span an entire document and more. Formatting is the art of 
making your document look less ugly.

Part IV: Spruce Up a Dull Document
This part is formatting dessert, or tasks you can do beyond regular for-
matting to help make your document look like more than a typical, boring 
document. Part IV covers lines, borders, tables, columns, lists, graphical 
goodness, and all sorts of stuff that makes Word more than a typical word 
processor.

Part V: Even More Word
This part covers a few dangling details that I consider myself fortunate to 
write about, such as outlining, collaboration, mail merge, label-making, and 
other interesting things that Word does.
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Part VI: The Part of Tens
The traditional last part of any For Dummies book contains chapters with 
lists of ten items. You’ll find lots of helpful information there, some weird 
things you may not know about, plus even more useful tips, tricks, and good 
suggestions.

What’s Not Here
Word is one heck of a program. Covering the entire thing would fill a book 
several thousand pages long. (I kid you not.) My approach in this book is 
to cover as much basic word processing as possible. Because of that, some 
advanced features got pushed off the table of contents.

I give you some information about macros, though it’s not meaty. Covering 
macros without a technical description is difficult. If the publisher ever lets 
me increase this book’s size to more than 400 pages, I’d be happy to add a 
macro chapter; the publisher’s address is in this book’s front matter, in case 
you want to lobby on my behalf.

Some of the more esoteric features are touched on lightly here. For example, 
I could spend about 70 pages detailing what can be done with graphics in 
Word, but I limited myself to only a dozen pages.

Finally, this book doesn’t cover using Word to make a blog post, create a 
Web page, or how to use Word as your e-mail program.Word does those 
things, but I consider this a word processing book rather than a Word-does-
everything book.

Icons Used in This Book
 This icon flags useful, helpful tips or shortcuts.

 This icon marks a friendly reminder to do something.
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 This icon marks a friendly reminder not to do something.

 This icon alerts you to overly nerdy information and technical discussions of 
the topic at hand. The information is optional reading, but it may enhance 
your reputation at cocktail parties if you repeat it.

Where to Go from Here
Start reading! Observe the table of contents and find something that interests 
you. Or, look up your puzzle in the index.

If you’ve been using an older version of Word, you’re probably somewhat 
surprised at the look of Word 2010. Therefore, I recommend that you start 
reading at Chapter 1.

Read! Write! Let your brilliance shine!

My e-mail address is dgookin@wambooli.com. Yes, that’s my real address. I 
reply to all e-mail I receive, and you’ll get a quick reply if you keep your ques-
tion short and specific to this book or to Word itself. Although I enjoy saying 
“Hi,” I cannot answer technical support questions or help you troubleshoot 
your computer. Thanks for understanding.

You can also visit my Web page for more information or as a diversion: 
www.wambooli.com.

Enjoy this book. And enjoy Word. Or at least tolerate it.
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In this part . . .

Word processing may seem routine these days, but 
that hasn’t always been the case. Being able to 

dance your fingers across a computer keyboard and have 
your prose lit up by teensy dots of light on a screen is, 
well, sort of magic. It most certainly beats the pants off 
using a typewriter. For me, it’s better than trying to com-
municate using my nearly illegible handwriting. Routine or 
not, word processing is a blessing.

Historically speaking, word processing is the culmination 
of an evolution that began 10,000 years ago, when the first 
humans started scrawling those “Look what I killed! Aren’t 
I cool?” cave paintings. Today, you can communicate 
these simple messages with technological power unri-
valed in human history. This part of the book introduces 
you to that technology.
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Chapter 1

Hello, Word!
In This Chapter
▶ Starting Word

▶ Deciphering the Word screen

▶ Quitting Word

▶ Setting Word aside

You can’t do squat with a computer until you start the thing. Likewise, 
you can’t even write the word squat on a computer until you start a 

word processing program. Because you bought this book and not Pencils For 
Dummies, the program you need to start is Microsoft Word. This chapter 
tells you how to get Word started and begin your word processing day. Let 
me also mention that reading this chapter is a far more enriching experience 
than reading Pencils For Dummies, which is barely a pamphlet, albeit one 
that’s charmingly illustrated.

Getting Word Started
There is no single way to start Word. The Windows operating system is all 
about offering many different (and, often, confusing) ways to get things done. 
Rather than bore you by listing all those ways, I figure you just want to find 
the best way to start Word for how you use the computer. This section offers 
three solid choices.

 ✓ Before you can use Word, your computer must be on and toasty. Log 
in to Windows. Start your computer day. (But — seriously — don’t put 
bread into your computer and expect toast to appear.)

 ✓ Make sure you’re seated, with a nice, upright, firm posture as you use 
your computer. They tell me that your wrists should be even with your 
elbows and that you shouldn’t have to tilt your head forward. Shoulders 
are back and relaxed.
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 ✓ Don’t freak out because you’re using a computer. You are in charge! 
Keep that in mind. Chant silently to yourself, over and over: “I am the 
master.”

 ✓ If you need help starting your computer, refer to my book PCs For 
Dummies for quick and accurate turning-on-the-computer instructions.

 ✓ You can stop chanting “I am the master” now.

The good, yet unimaginative, 
way to start Word
Without fail, the place to start any program in Windows is at the fabled Start 
button. It may not be the fastest or the most interesting or most convenient 
way to start a program, but it’s consistent and reliable — both good qualities 
to have in a computer. Obey these steps:

 1. Click the Start button.

  Use your computer mouse to click the Start button, which is often found 
on the left side of the taskbar and at the bottom of the screen, adorned 
with the Windows logo.

  Clicking the Start button displays the Start menu.

 2. Choose Microsoft Word 2010 from the list of programs.

   As luck may have it, you might find the Microsoft Word 2010 program 
icon (shown in the margin) right there on the Start menu. Click the icon 
to run the program. Otherwise, keep plowing away in Step 3.

 3. Choose All Programs to pop up the All Programs menu and choose 
Microsoft Word 2010.

  If you don’t see the Microsoft Word 2010 icon or program name, you 
must obey Step 4, which is almost certain to work.

 4. Choose the Microsoft Office item (submenu) to display its contents, 
and then choose Microsoft Word 2010.

Behold! Word starts! Watch in amazement as the program unfurls its sails on 
your computer’s monitor.

Don’t let Word’s appearance overwhelm you! I describe what you’re looking 
at in the section “Looking at Word,” later in this chapter.

 ✓ If you can’t find Word anywhere on the All Programs menu, it may not be 
installed on your computer. This book is specific to Microsoft Word, not 
the Microsoft Works word processor or any other word processor. (See 
the section “Foolish Assumptions” in this book’s Introduction.)
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 ✓ Supposedly, every program ever installed on your computer has 
installed its icon in a spot somewhere on the All Programs menu.

 ✓ I refer to the program as Word, though its icon may be labeled Microsoft 
Word, Microsoft Office Word, Microsoft Word 2010, or another variation.

The better way to start Word
When you use Word a lot, it helps to have quick access to its program icon; 
opening that icon is the way you start Word and then start your work. A 
better way than keeping Word hidden on the All Programs menu is to create 
a Word shortcut icon on the desktop. Heed these steps:

 1. Locate the Word icon on the Start button’s All Programs menu.

  Don’t start Word now! Just point the mouse at the Word icon on the 
Start button’s All Programs menu or wherever else it may be found. 
(Refer to the preceding section.)

 2. Right-click the Microsoft Word 2010 menu item.

  A pop-up menu appears.

 3. Choose Send To➪Desktop (Create Shortcut).

 4. Press the Esc key to hide the Start button menu and view the desktop.

  You haven’t changed anything, but you have added the Word program icon 
to the desktop (shown in the margin). You can use that icon to start Word: 
Just double-click the icon and Word starts.

The best way to start Word
The best way to start Word, and the way I do it every day, is to place the 
Word icon on the taskbar in Windows 7, or what’s called the Quick Launch 
toolbar in older versions of Windows. To do so, follow these steps:

 1. Find the Word icon on the Start button’s All Programs menu.

  Don’t click the icon — just find it!

 2. Right-click the Word icon on the All Programs menu.

 3a. In Windows 7, choose the command Pin to Taskbar.

 3b. In Windows Vista, choose the command Add to Quick Launch.

  The Word icon is pinned (permanently added to) the taskbar in 
Windows 7; in Windows Vista, the Word icon is slapped on the Quick 
Launch Toolbar.
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12 Part I: Your Introduction to Word 

To start Word, you merely click the Word icon placed on the taskbar. Click! 
And then Word starts. That’s the fastest and bestest way to begin your word 
processing day.

 Another way to have the Word icon always handy is to pin it to the Start menu 
directly. In Step 3, choose the item named Pin to Start Menu. That way, the 
Word icon always appears at the top of the list on the Start button menu.

Start Word by opening a document
You use the Word program to create documents, which are stored on your 
computer in much the same way as people pile junk into boxes and store 
them in their garages. But that’s not important. What is important is that you 
can use those documents to start Word: Opening a Word document causes 
Word to start and to display that document for editing, printing, or just giving 
others the impression that you’re doing something.

What’s your point, Dan?

  My point is that you can also start Word by opening a Word document. 
Simply locate the Word document icon (shown in the margin) in a folder 
window. Double-click to open that document and Word starts up on the 
screen, instantly (more or less) displaying that document for editing, reading, 
modifying, perusing, cussing, mangling, and potentially fouling up beyond all 
recognition.

 ✓ The Word document you open can be on the desktop, in the My 
Documents or Documents folder, or in any other folder or location 
where a Word document icon can lurk.

 ✓ The document name appears beneath or to the right of the icon. You 
can use the name to determine the document’s contents — as long as 
the document was properly named when it was saved to disk. (More on 
that elsewhere in this book.)

 ✓ In Windows 7, you can see a Jump List of recently opened documents by 
either right-clicking the Word icon on the taskbar or clicking the right-
pointing arrow next to the Word icon on the Start button menu. Choose 
a document from the list to start Word and open that document.

 ✓ Word is capable of opening other types of documents, including docu-
ments from previous versions of Word, Rich Text Format documents, 
and others. Each of these documents has its own icon, though the icon 
looks similar to the standard Word document icon. See Chapter 24 for 
more information on opening alien documents in Word.
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Looking at Word
Like all programs in Windows, Word offers its visage in a program window. 
It’s the electronic version of a blank sheet of paper — and more. It’s the more 
part that you might find daunting. The dee-dads and goo-bobs that surround 
the Word program window all have specific names that you need to know to 
get the most from the program. Figure 1-1 shows the big picture.

 

Figure 1-1: 
Word’s 
visage.
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Maximize
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Document information Blank page
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Vertical
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Figure 1-2 highlights the gizmos at the top of the Word window, showcasing 
the Ribbon interface.
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Figure 1-2: 
The Ribbon.
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The details of how all the dee-dads and goo-bobs in the Word window work 
are covered elsewhere in this book. Use this book’s index to help you find 
topics you might be curious about.

 ✓ The very first time you start Word, you may be asked some questions: 
Enter your name and initials, set up Word security, and set Microsoft 
update options. I recommend the updates.

 ✓ To get the most from Word’s window, change the window size: As with 
any window, you can use the mouse to drag the window’s edges in or 
out or click the window’s Maximize button (the middle button in the 
window’s upper right corner) to have the window fill the screen.

 ✓ Word’s window size affects what you see in the Ribbon command 
groups. When the Word window is smaller, fewer buttons show up, or 
they may show up in three rows. When the window is larger, you see 
more buttons, usually in two rows.

Around the Word window
Word processing is about writing, so the things you see in the Word window 
are all there for your writing pleasure. Or, if you find writing a pain, the items 
festooning the Word window are there for your agony. The word for the 
whole of those items is interface, which is how a computer program presents 
itself to the human world.

The largest portion of the Word screen is for composing text. It’s blank and 
white, just like a fresh sheet of paper. (Refer to Figure 1-1.) That’s where you 
compose and format your text, and I cover that area specifically in the next 
section.
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Surrounding the text-composing area is a host of goobers that are as bewil-
dering as an exhibit in a modern art museum, as intimidating as the cockpit 
of a jet fighter, and almost as dangerous as a plate of sushi. Despite their 
intimidating presence, those items exist to help you write. The following list 
gives you a quick top-to-bottom explanation. Use Figure 1-1 for reference. 
And, please: Do not memorize anything!

 ✓ The title bar lists the document’s title, or merely Document1 until you 
give the document a title by saving it to disk. (See Chapter 8 for informa-
tion on saving documents — very important!)

 ✓ The File tab replaces the traditional File menu of older Windows pro-
grams. Clicking the File tab replaces the contents of the Word window 
with a full-screen menu full of commands and their descriptions. To 
return to the Word window, click the File tab or any other tab on the 
Ribbon. Speaking of which:

 ✓ The Ribbon contains all Word commands, which appear as buttons, 
input boxes, and menus. The Ribbon is divided into tabs (refer to Figure 
1-2). The commands on the Ribbon are separated into groups. Some tabs 
may appear and disappear depending on what you’re doing in Word. 
And the commands in groups change as you change the window’s size.

 ✓ The Ruler may or may not be visible. When it’s visible, it helps you set 
margins and tabs. The View Ruler button (refer to Figure 1-1) shows and 
hides the Ruler.

Below the writing area dwells the status bar. This informative strip of graphi-
cal goodness contains trivial information about your document as well as the 
following ornaments:

 ✓ Document information lists optional data that’s specific to your 
document.

 ✓ The View buttons specify how the blank page appears in the window 
(also refer to the next section).

 ✓ The Zoom thing specifies how large or small your document appears 
inside the window. (See Chapter 29 for more information on zooming.)

Don’t fret over these things! What’s important now is that you recognize the 
names so that you don’t get lost later.

 ✓ You can hide the Ribbon if you would rather have more room to write: 
Use the Expand the Ribbon button (refer to Figure 1-2).

 ✓ The Windows taskbar, located at the bottom of the screen, is a part 
of Windows itself and not Word. However, as you open documents in 
Word, buttons representing those documents appear on the Windows 
taskbar.

05_487723-ch01.indd   1505_487723-ch01.indd   15 3/27/10   10:37 AM3/27/10   10:37 AM



16 Part I: Your Introduction to Word 

 ✓ Unlike in previous versions of Word, the tabs, groups, and command 
buttons cannot be changed. You can customize the Quick Access 
Toolbar (refer to Figure 1-1), and you can add your own, custom groups 
and tabs, a topic I cover in Chapter 29.

The blank place where you write
Word’s equivalent of the mind-numbing, writer’s-block-inducing blank page 
can be found in the center part of the Word program window (refer to Figure 
1-1). That’s where the text you write, edit, and format appears. Unlike with 
a sheet of paper, however, the text you create in Word can be viewed in five 
different ways.

Relax. Of all the different ways to view text in Word, only these two are useful 
enough to describe here:

  ✓ Print Layout: Word’s native mode is named Print Layout, shown in 
Figure 1-1. In this view, the entire page of text is displayed on the screen 
just as it prints. Print Layout view shows graphical images, columns, and 
all sorts of other fancy effects. You even see the blank space between 
pages, described as the ethereal void in Figure 1-1.

  ✓ Draft: I prefer using Word in Draft view, which shows only basic text and 
not all the fancy features. Because Draft view doesn’t show any fancy 
formatting (graphics, columns, or page breaks, for example), you can 
more easily concentrate on writing.

The three other ways to view your document are Full Screen Reading, Web 
Layout, and Outline. None of these views has anything to do with basic word 
processing.

Switch between views by using the View buttons found in the lower right 
corner of the Word program window (refer to Figure 1-1). Clicking a button 
with the mouse changes the view.

 ✓ When you’re working in Draft view and you want to edit a header or 
insert a picture, Print Layout view is activated. You can switch back 
to Drafts view by clicking the Drafts button when you’re done going 
graphical.

 ✓ One thing that’s visible in Draft view that you don’t find in Print Layout 
view is a thick, horizontal bar on the left side of the page, just below a 
document’s last line of text. That heavy bar marks the end of your docu-
ment’s text.

 ✓ Draft view may also be referred to as Normal view, as it was in previous 
versions of Word.
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17 Chapter 1: Hello, Word!

 ✓ Any weird stuff you see onscreen (a ¶, for example) is a Word secret 
symbol. Chapter 2 tells you why you may want to view those secret sym-
bols and how to hide them if they annoy you.

The mouse pointer in Word
Though word processing is a keyboard thing, you’ll find that the computer 
mouse does come in handy. You use the mouse to choose commands, move 
around the document you’re editing, and do something called selecting text. 
This book explains all those topics elsewhere. For now, it helps to under-
stand how the mouse pointer changes its look as you work in Word:

  For editing text, the mouse pointer becomes the I-beam.

  For choosing items, the standard 11 o’clock mouse pointer is used.

  For selecting lines of text, a 1 o’clock mouse pointer is used.

The mouse pointer may change its look when click-and-type mode is active: 
Lines appear to the left and right of, and below, the I-beam mouse pointer. 
Refer to Chapter 32 for more information on using click-and-type.

 ✓ You can use the mouse to see what some of the little buttons and items 
with pictures on them do in Word. Just hover the mouse pointer over 
the button, and — voilà! — it’s like Folgers instant information crystals.

 ✓ Chapter 4 discusses how to use the mouse pointer to move around a 
document to edit different parts of your text.

Cajoling Word to help you
Like most programs in Windows, a Help system 
is available in Word. You can summon it by 
pressing the F1 key, which displays the Word 
Help window. There you can type a topic, a 
command name, or even a question into the box 
to search for help. Or, you can browse the table 
of contents for helpful information.

The F1 key also works any time you’re deep 
in the bowels of Word and doing something 

specific. The Help information that’s displayed 
tends to be specific to whatever you’re doing 
in Word. Little buttons that look like question 
marks in blue circles also summon Word Help.

Though it’s nice to have the help available, the 
information offered is little more than the “Word 
manual,” which is as cryptic and unforgiving as 
the computer manuals that were once printed 
on paper.
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Ending Your Word Processing Day
It’s the pinnacle of etiquette to know when and how to excuse oneself. 
Leaving can be done well or poorly. For example, the phrase “Well, I must be 
off,” works lots better than “Something more interesting must be happening 
somewhere else” — especially at Thanksgiving.

Just as there are many ways to start Word, there are several ways to quit. 
You can quit the program outright, you can pause and start over, or you can 
set Word aside. These options are covered in the following sections.

To quit Word
When you’re done word processing and you don’t expect to return to it any-
time soon, you can quit the Word program. Quitting a computer program is 
like putting away a book on a shelf. In the electronic world of the computer, 
this is how you do such a thing:

 1. Click the File tab.

  The Word screen is replaced by the File tab menu screen. Do not be 
alarmed.

 2. Choose the Exit command.

  Word vanishes from the screen.

The only time Word doesn’t vanish is during that shameful circumstance 
when you have unsaved documents. If so, you’re prompted to save the docu-
ment, as shown in Figure 1-3. My advice is to click the Save button to save 
your work.

 

Figure 1-3: 
Better click 

that Save 
button!
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If you click the Don’t Save button, your work isn’t saved, Word quits. If you 
click the Cancel button, Word doesn’t quit and you can continue working.

 ✓ See Chapter 8 for more information on saving documents.

 ✓ Also see Chapter 8 on how to recover drafts of documents you failed to 
save.

 ✓ You don’t have to quit Word just to start editing another document. 
Refer to the next couple of sections for helpful, time-saving information!

 ✓ After quitting Word, you can continue to use Windows, by starting up 
any other program, such as Spider Solitaire, or perhaps something more 
calming, such as Call Of Duty.

Quit what you’re doing 
without quitting Word
You don’t always have to quit Word. For example, if you’re merely stopping 
work on one document to work on another, quitting Word is a waste of time. 
Instead, you can close the document.

To close a document in Word, click the File tab and choose the Close com-
mand. Word banishes the document from its window, but then the program 
sits there and waits for you to do something else, such as start working on a 
new document or open a document you previously saved.

Bottom line: There’s no point is quitting Word when all you want to do is 
start editing a new document.

 ✓ When you try to close a document before it has been saved, Word 
displays a warning dialog box. Click the Save button to save your docu-
ment. If you want to continue editing, click the Cancel button and get 
back to work.

 ✓ There’s no need to close a document, really. In fact, I work on a docu-
ment over a period of days and keep it open (and my PC turned on) the 
entire time. Doesn’t hurt a thing. (I occasionally save it to disk, which is 
important.)

 ✓ See Chapter 8 for more information about starting a new document.

 ✓ The keyboard shortcut for the Close command is Ctrl+W. That command 
may seem weird, but it’s used to close documents in many programs.
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Set Word aside
There’s no need to quit Word if you know that you will use it again soon. In 
fact, I’ve been known to keep Word open and running on my computer for 
weeks at a time. The secret is to use the Minimize button.

  Clicking the Minimize button shrinks the Word window to the taskbar, where it 
exists as a button. With the Word program window out of the way, you can do 
other things with your computer. Then, when you’re ready to word-process 
again, click the Word button on the taskbar to restore the Word window to the 
screen.

The Minimize button is the first of the three buttons in the window’s upper 
right corner. Refer to Figure 1-1.
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Chapter 2

The Typing Chapter
In This Chapter
▶ Knowing the PC keyboard

▶ Typing tips

▶ Using the spacebar

▶ Using the Enter key

▶ Backspacing and deleting

▶ Observing the status bar

▶ Minding the space between pages

▶ Seeing stuff in your text that isn’t there

▶ Living with weird underlines and colored text

Word processing is about using the computer keyboard. It’s typing. 
That’s the way computers were used for years, long before the 

mouse and all the fancy graphics became popular. Yep, ask a grizzled old-
timer and you’ll hear tales of ugly text screens and keyboard commands that 
would tie your fingers in knots. Though things aren’t that bad today, I highly 
recommend that you bone up on using your computer’s keyboard to get the 
most from your word processing duties. This chapter tells you what you 
need to know.

Behold the PC Keyboard!
Typing happens on a computer keyboard. Though I’m sure you can easily 
recognize a computer keyboard, you should know how to refer to the various 
keys. To assist you, I’ve illustrated a typical, generic computer keyboard in 
Figure 2-1.
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Figure 2-1: 
Famous 

attractions 
on the 

typical PC 
keyboard.
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Here’s a summary of what you see:

 ✓ Function keys: Labeled F1 through F12 and used alone or in cahoots 
with the Ctrl, Alt, and Shift keys.

 ✓ Typewriter keys: The standard alphanumeric keys that the computer 
inherited from the ancient typewriter: a through z and the number keys 
plus symbols and other exotic characters.

 ✓ Cursor keys: Also called arrow keys; they control the cursor. Also 
included are the non-arrow keys: Home, End, PgUp (or Page Up), PgDn 
(or Page Down), Insert, and Delete.

 ✓ Mon key: A cute little primate that you don’t want to have as a pet.

 ✓ Numeric keypad: Keys that serve sometimes as cursor keys and some-
times as number keys. The split personality is evident on each key cap, 
which displays two symbols. The Num Lock key and its corresponding 
light are on if the numeric keypad (1, 2, 3) is active. If the cursor keys 
(arrows, Home) are active, Num Lock is off.

 ✓ Modifier keys: Don’t do anything by themselves. Instead, the Shift, Ctrl, 
and Alt keys work in combination with other keys.

Here are some individual keys worth noting:

 ✓ Enter: Marked with the word Enter and sometimes a cryptic, left-arrow 
thing: ;. You use this key to end a paragraph of text.

 ✓ Esc: The “escape” key doesn’t exactly do anything in Word. However, 
pressing the Esc key in a dialog box is the same as clicking the Cancel 
button with the mouse.

 ✓ Spacebar: The only key with no symbol; inserts spaces between the 
words.
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 ✓ Tab: Inserts the tab “character,” which shoves the next text you type 
over to the next tab stop; an interesting and potentially frustrating for-
matting key (and nicely covered in Chapter 12).

 ✓ Backspace: Your backing-up-and-erasing key — very handy.

 ✓ Delete: Also labeled Del; works like Backspace but doesn’t back up to 
erase. Read more on that in Chapter 4.

Every character key you press on the keyboard produces a character on the 
screen, on the blank part where you write. Typing those character keys over 
and over is how you write text on a word processor.

 ✓ The Shift key is used to produce capital letters; otherwise, the text you 
see is in lowercase.

 ✓ The Caps Lock key lets you type text in UPPERCASE letters. After you 
press Caps Lock, the Caps Lock light on your keyboard comes on, indi-
cating that you’re entering ALL CAPS mode. Press the Caps Lock key 
again to return to normal.

 ✓ Ctrl is pronounced “control.” The variety of names that people give to 
the Ctrl key before they know it as the control key is amazing.

The Old Hunt-and-Peck
After starting Word, you’ll most likely type these words next:

Clackity-clack-clack-clack.

The text you type on the keyboard appears on the screen — even the typos 
and mistakes and bad grammar: It all falls into place regardless of your 
intent, posture, or good looks. This section offers some basic typing tips, sug-
gestions, and advice.

Depressing the keys
You don’t actually depress a key on a com-
puter keyboard. Nope. Instead, you press and 
release. Any swift tapping motion will do. Some 
keyboards even generate a pleasing click 
sound when a key is pressed.

Now, if you really want to depress a key, just 
stare at it and say, “You’re one ugly, good-for-
nothing key!” If that doesn’t work, continue the 
insults. Eventually, any well-adjusted key will 
succumb to your verbal taunts and find itself 
sufficiently depressed.
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Follow the blinking cursor
The key to writing in Word is to look for the insertion pointer in your text. It’s 
a flashing vertical bar:

|

Text you type appears before the insertion pointer, one character at a time. 
After a character appears, the insertion pointer hops to the right, making 
room for more text.

For example, type this line:

Let’s go see the clowns!

The insertion pointer moves to the right, marching along as you type. It’s 
called insertion pointer for a reason: Press the left-arrow key a few times to 
move the insertion pointer back before the word go.

Type the word not and a space. The word (and the space) is inserted into 
your text. The text to the right is pushed off to make room for the new text. 
Now the sentence should read:

Let’s not go see the clowns!

Chapter 4 covers moving the insertion pointer around in more detail.

When to whack the spacebar
The spacebar isn’t the same thing as the right-arrow key on the keyboard. 
Pressing the spacebar doesn’t just move the insertion pointer; it inserts a 

“Do I need to learn to type?”
No one needs to learn to type to use a word 
processor, but you do yourself a favor when you 
learn. My advice is to get a computer program 
that teaches you to type. I can recommend the 
Mavis Beacon Teaches Typing program, even 
though I don’t get any money from her and 

none of her children resembles me. I just like 
the name Mavis, I suppose.

Knowing how to type makes a painful experi-
ence like using Word a wee bit more enjoyable.

06_487723-ch02.indd   2406_487723-ch02.indd   24 3/27/10   10:37 AM3/27/10   10:37 AM
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space character into the text. Spaces are important between words and sen-
tences. Withoutthemreadingwouldbedifficult.

The most important thing to remember about the spacebar is that you need to 
whack it only once. In word processing, as in all typing done on a computer, 
only one space appears between words and after punctuation. That’s it!

 ✓ I’m serious! If you’re an old-timer, you’re probably used to putting two 
spaces after a period, which is what they once taught in typing class. 
This extra space is wrong on a computer; typing it doesn’t really add 
more space between words or sentences. Trust me on that.

 ✓ Anytime you feel like using two or more spaces, what you need is a tab. 
Tabs are best for indenting text as well as for lining up text in columns. 
See Chapter 12 for more information.

 ✓ The reason that only one space is needed between sentences is that 
computers use proportionally spaced type. Old-fashioned typewriters 
used monospace type, so pressing the spacebar twice after a sentence 
was supposed to aid in readability (though it’s debatable). Computer 
type is more like professionally typeset material, and both typesetters 
and professional-document folk now put only one space after a period or 
a colon.

 ✓ If you want to type two spaces after a period and actually see them, 
choose a monospace font, such as Courier.

Backup and erase keys
When you make a typo or another type of typing error, press the Backspace 
key on the keyboard. The Backspace key is used to back up and erase. The 
Delete key can also be used to erase text, though it gobbles up characters to 
the right of the insertion pointer.

 ✓ Refer to Chapter 4 for more information on deleting text with Backspace 
and Delete.

 ✓ The Backspace key is named Backspace on your keyboard, or it may 
have a long, left-pointing arrow on it: ←.

 ✓ Backspace backs up and erases. If you merely want to move the inser-
tion pointer to the left, press the left-arrow key. See Chapter 3.
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When to press that Enter key
In word processing, you press the Enter key only when you reach the end of a 
paragraph. Though pressing Enter at the end of a line of text might seem logi-
cal, there is no need: Word takes the text that hangs over at the end of a line 
and wraps that text down to the next line. Therefore, you press Enter only to 
end a paragraph.

To practice pressing the Enter key at the end of a paragraph, type the follow-
ing text:

It was the scratching at the front door that alerted us.
For a second I thought it might be Jasper, showing up
late. It wasn’t. You see, around these parts, during the
full moon, we have an issue: The dead won’t stay buried.
Still, it was a good stew, so we decided to finish eating
before getting busy with the axes and shovels.

Now that you’re done typing the paragraph, press the Enter key. There. You 
did it right.

 ✓ There’s no need to use the Enter key when you want to double-space 
your text. Double-spacing uses a text formatting command in Word. See 
Chapter 11 for more information.

 ✓ Neither do you need to press the Enter key twice to add extra space 
between your paragraphs. Word can automatically add space before or 
after paragraphs, which is also covered in Chapter 11.

 ✓ If you want to indent a paragraph, press the Tab key after pressing 
Enter. This can also be done automatically; refer to (you guessed it) 
Chapter 11.

 ✓ The process of taking text from the end of one line and placing it at the 
start of the next line is named word wrap.

Curse you, StickyKeys!
As your mind wanders, your fingers absently 
press and release the Shift key. Suddenly, you 
see the warning: StickyKeys! By pressing the 
Shift, Ctrl, or Alt key five times in a row, you acti-
vate the Windows StickyKeys function, a tool 
designed to make a computer keyboard more 
accessible to people. If you don’t need the help, 
you’ll probably find the intrusion annoying.

Don’t panic! You can easily turn off the 
StickyKeys feature: Open the Windows Control 
Panel and choose the Ease of Access link. On 
the next screen, find and click the link labeled 
Change How Your Keyboard Works. Remove 
the check mark by Turn On Sticky Keys. Click 
OK and you’ll never be bothered again!
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Stuff That Happens While You Type
As you madly compose your text, fingers energetically jabbing the buttons 
on the keyboard, you may notice a few things happening on the screen. You 
might see spots. You might see lines and boxes. You may even see lightning! 
All are side effects of typing in Word. They’re normal, and they’re explained 
in this section.

The left end of the status bar
The reason it’s the status bar is that it can show you the status of your docu-
ment, lively updating the information as you type, as shown in Figure 2-2.

 

Figure 2-2: 
Stuff that 

lurks on the 
status bar.

 

Page location

Document proofing

Total pages

Word count

Other stuff may appear here.

The type of information that’s displayed, as well as how much information is 
displayed, depends on how you configured Word. Chapter 29 explains which 
features the status bar can display.

 ✓ The status bar also displays information when you initially open a docu-
ment, giving the document’s name and character count. The info disap-
pears quickly, however.

 ✓ When a document is saved, the status bar displays information about 
the save, though often the information disappears too fast to see.

Between the pages
Word tries its best to show you where one page ends and another page 
begins. This feature is most helpful because often times you want to keep 
elements on one page, or maybe folks just like to know when the text they’re 
writing flows from one page to the next.
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The status bar helps you discover which page you’re working on. For exam-
ple, the Page Number indicator changes from 6 to 7 when you start a new 
page. Word also shows you graphically where one page ends and another 
begins.

In Print Layout view, you see virtual pages and a space between them, as 
shown in Figure 2-3.

 

Figure 2-3: 
Page break 

in Print 
Layout view.

 

In Draft mode, the visual break between pages is shown as a faint line of dots, 
like ants marching across the page:

  
Text appearing above the line of dots is on one page, and text below it is on 
the next page.

 ✓ Refer to Chapter 1 for more information on Print Layout and Draft views.

  ✓ You can change the gap between pages in Print Layout view. Point the 
mouse at the gap. When the mouse pointer changes, as shown in the 
margin, double-click to either close or open the gap.

 ✓ Because the page break is, technically, a soft page break, one page is full 
of text and Word must start putting text on a new page. See Chapter 13 
for information on forcing page breaks and other types of page breaks in 
Word.

Spots and clutter in your text
There’s no cause for alarm if you see spots — or dots — amid the text you 
type, such as

This•can•be•very•annoying.¶

What you’re seeing are nonprinting characters. Word uses various symbols 
to represent things you normally don’t see: spaces, tabs, the Enter key, and 
more.

06_487723-ch02.indd   2806_487723-ch02.indd   28 3/27/10   10:37 AM3/27/10   10:37 AM



29 Chapter 2: The Typing Chapter

  To turn these items on or off, click the Show/Hide button on the Home tab in 
the Paragraph group. Click once to show the goobers; click again to hide 
them.

Why bother? Sometimes it’s useful to see the marks to check out what’s up 
with formatting, find stray tabs visually, or locate missing paragraphs, for 
example. (WordPerfect users: It’s as close as you can get to the Reveal Codes 
command in Word.)

Strange underlines and colored text
Adding underlining to your text in Word is cinchy; Chapter 10 tells you all 
about that character format. Yet sometimes Word may do some underlining 
and add strange-colored text on its own. 

Red zigzag: Spelling errors in Word are underlined with red zigzags. See 
Chapter 7.

Green zigzag: Grammatical errors in Word are underlined with green zig-
zags. See Chapter 7.

Blue zigzag: Word-choice errors are grammatical errors, but Word flags 
them with a special blue zigzag regardless. The blue underlined word is 
most likely not the best word to use given the sentence structure. Again, 
see Chapter 7.

Purple dots: Word’s Smart Tags feature uses purple dots to highlight 
information such as names, dates, places, and similar data that can be 
shared with other programs in Microsoft Office. Smart tags are briefly 
discussed in Chapter 32.

Blue underlines: Word courteously highlights Web page addresses using 
blue, underlined text in your document. You can Ctrl+click the blue 
underline text to visit the Web page.

Red underlines and strikethrough: The red text that appears either 
underlined or in strikethrough means that you’re using Word’s Track 
Changes feature. It can drive you nuts when you don’t know what’s going 
on, so see Chapter 26 to keep your sanity.
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Part II

Your Basic Word
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In this part . . .

Word is a massive program, almost too huge to 
comprehend. If you try, your head will explode. I 

don’t recommend it.

You’ll find that, in all of Word’s bulk, you need to use only 
the bare minimum for the typical, basic word processing 
chore. I’d estimate that the typical user never takes 
advantage of 90 percent of what the Word program can 
do. That’s okay. You’ll find that the 10 percent that 
remains is truly the most useful part, your basic Word. 
That’s the topic for this part of the book.
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Chapter 3

To and Fro in a Document
In This Chapter
▶ Using the scroll bars

▶ Moving the insertion pointer

▶ Getting around with keyboard shortcuts

▶ Navigating with the browse buttons

▶ Getting lost and getting back

▶ Using the Go To command

I like the word fro. I like the word yon. They’re archaic in the English lan  
 guage, referring to a direction and a location, respectively. Fro doesn’t 

make sense by itself, so it’s used in the phrase to and fro, which refers to 
going somewhere and then back again. Yon is often seen with its friends 
hither and thither, meaning “here” and “there.” In that context, yon is a place 
beyond there (wherever there is). It’s also short for yonder, which is another 
cool word that few people use any more.

As you work in Word, you find yourself moving to and fro and hither, thither, 
and yon. That’s because writing text isn’t always a linear task. You need to 
move that little insertion pointer guy around the document. It’s basic move-
ment. It’s the topic of this chapter.

Scroll Through a Document
It’s ironic that the word scroll is used to refer to an electronic document. The 
scroll was the first form of recorded text, existing long before bound books. 
On a computer, scrolling is the process by which you view a little bit of big 
document in a tiny window. This section explains how scrolling is relevant in 
Word.
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Using the vertical scroll bar
On the right side of the Word program window you find the vertical scroll 
bar, illustrated in Figure 3-1. Its operation is similar to the scroll bar in any 
Windows program:

 

Figure 3-1: 
The vertical 

scroll bar.
 

Show/Hide Ruler

Portion of document
visible on screen

Browse buttons

Scroll up one line

Scroll up one screen

Elevator button
(drag to scroll)

Indicates relative
position in document

Scroll down one screen

Scroll down one line

 ✓ Click the up- or down-arrow buttons at the top and bottom of the verti-
cal scroll bar to scroll your document up or down. The document scrolls 
one line of text for each time you click those up- or down-arrow buttons.

 ✓ An elevator button appears inside the scroll bar. You can drag this 
button with the mouse, up or down, to scroll the document.

 ✓ You can click above or below the elevator button to scroll up or down 
one screen of text at a time.

The elevator button’s size reflects how much of your document you can see 
at a time. When the button doesn’t show up, or is dimmed, the whole docu-
ment appears onscreen. Otherwise, the elevator button becomes smaller as 
your document grows longer.

The elevator button’s position also helps show you which part of your document 
is visible. When the elevator button is at the top of the scroll bar, you’re view-
ing text near the start of the document. When the elevator button is toward the 
bottom of the scroll bar, you’re seeing text near the document’s end.

Special bonuses are involved when you drag the elevator button to scroll 
through your document. As you drag the button up or down, you see a page 
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35 Chapter 3: To and Fro in a Document

number displayed, as shown in Figure 3-2. When a document is formatted 
with heading styles, you also see the heading title below the page number.

 

Figure 3-2: 
Scroll bar 

page-
number info.

 

Scrolling through your document doesn’t move the insertion pointer. If you 
start typing, don’t be surprised when Word jumps back to where the inser-
tion pointer lurks. (Refer to the later section “Commanding the insertion 
pointer with the mouse” for help if such a thing bugs you.)

 ✓ Scrolling a document doesn’t move the insertion pointer!

 ✓ Refer to the section “The Browse Buttons,” later in this chapter, for 
information on using the browse buttons, which are located below the 
vertical scroll bar.

Using the horizontal scroll bar
The horizontal scroll bar appears just above the status bar at the bottom of 
the Word window — but only when your document is wider than the window. 
When that happens, you can use the horizontal scroll bar to shift the page 
back and forth and left and right.

 When the horizontal (left-right) shifting bugs you, consider using Word’s 
Zoom tool to adjust the size of your document on the screen. See Chapter 29.

Scrolling your document with the mouse
Aside from manipulating the scroll bars, you can use your computer mouse 
to scurry and scamper about your document. Sadly, this suggestions works 
only when you have one of those wheel mice. Coincidentally, you do all these 
tricks by manipulating that unique wheel button:

 ✓ Roll the wheel up or down to scroll your document up or down.

 ✓ Press and hold the wheel button to activate scrolling mode. With the 
wheel button down, you can move the mouse up or down to pan your 
document in that direction.

 ✓ If the mouse’s wheel button also tilts from side to side, you can use it to 
pan left and right.
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Move the Insertion Pointer
The beauty of the word processor is that you can edit any part of your docu-
ment; you don’t always have to work at “the end.” The key to pulling off that 
trick is to know how to move the insertion pointer to the exact spot you want.

Moving the insertion pointer is important! Scientific studies have shown 
that merely looking at the computer screen does no good. As hard as you 
wish, new text appears only at the insertion pointer. And, the text you edit 
or delete? Yup, the insertion pointer’s location is important there as well. 
Obviously, knowing how to move the insertion pointer is a big deal.

Commanding the insertion 
pointer with the mouse
The easiest way to put the insertion pointer exactly where you want it is to 
point the mouse at that spot in your text and then click the mouse button. 
Point, click, move insertion pointer. Simple.

Moving in small increments 
(basic arrow keys)
For short hops, nothing beats using the keyboard’s arrow keys to quickly 
move the insertion pointer around a document. The four basic arrow keys 
move the insertion pointer up, down, right, and left:

Press This Key To Move the Insertion Pointer

↑ Up to the preceding line of text

↓ Down to the next line of text

→ Right to the next character

← Left to the preceding character

 Moving the cursor doesn’t erase characters. See Chapter 4 for information on 
deleting stuff.

If you press and hold the Ctrl (Control) key and then press an arrow key, you 
enter Jump mode. The invigorated insertion pointer leaps desperately in all 
four directions:
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Press This Key Combo To Move the Insertion Pointer

Ctrl+↑ Up to the start of the previous paragraph

Ctrl+↓ Down to the start of the next paragraph

Ctrl+→ Right to the start (first letter) of the next word

Ctrl+← Left to the start (first letter) of the previous word

 You can use either set of arrow keys on the computer keyboard, but when 
using the numeric keypad, ensure that the Num Lock light is off. Do this by 
pressing the Num Lock key. If you don’t, you see numbers in your text rather 
than the insertion pointer dancing all over — like444this.

Moving from beginning to end
The insertion pointer also bows to pressure from those cursor keys without 
arrows on them. The first couple consists of End and Home, which move the 
insertion pointer to the start or end of something, depending on how End and 
Home are used:

Press This Key or Combination To Whisk the Insertion Pointer 

End To the end of a line of text

Home To the start of a line of text

Ctrl+End To the end of the document

Ctrl+Home To the tippy-top of the document

The remaining cursor keys are the Page Up or PgUp key and the Page Down 
or PgDn key. As you would guess, using these keys doesn’t move up or down 
a page in your document. Nope. Instead, they slide through your document 
one screen at a time. Here’s the round-up:

Press This Key or Combination To Whisk the Insertion Pointer 

PgUp Up one screen or to the tippy-top of your docu-
ment, if you happen to be near it

PgDn Down one screen or to the end of the docu-
ment, if you happen to be near it

Ctrl+Alt+PgUp To the top of the current screen

Ctrl+Alt+PgDn To the bottom of the current screen
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 The key combinations to move to the top or bottom of the current screen are 
Ctrl+Alt+PgUp and Ctrl+Alt+PgDn. That’s Ctrl+Alt, not just the Ctrl key. And 
yes, few people use those commands.

You may be tempted to use Ctrl+PgUp and Ctrl+PgDn, but don’t: Those com-
mands don’t work as you would expect. Refer to the following section for the 
details.

The Browse Buttons
Lurking at the bottom of the vertical scroll bar are three buttons, as shown in 
the margin. These browse buttons allow you to scroll through your document 
in leaps and bounds of various sizes.

  The top button is the Browse Up button, which is linked to the Ctrl+PgUp key 
combination.

  The bottom button is the Browse Down button, which is linked to the 
Ctrl+PgDn key combination.

  The center button is the What-the-heck-am-I-browsing-for? button, which is 
linked to the Ctrl+Alt+Home key combination.

When you click the center button, a pop-up palette of items to browse for 
appears, as shown in Figure 3-3. Pointing the mouse at any one of the items 
displays text that explains the item in the bottom part of the palette.

 

Figure 3-3: 
Things to 

browse for.
 

Unless you’ve chosen another item from the browsing palette (refer to Figure 
3-3), the browse buttons (and Ctrl+PgUp and Ctrl+PgDn) leap through your 
document by full pages.

Whenever an option other than Page is chosen from the browsing palette, the 
browse buttons change color. So, when the buttons are black, you know that 
you’re browsing by page. When the browse buttons turn blue, they’re search-
ing for something else. (Alas, the browsing palette doesn’t tell you which 
option is chosen.)

08_487723-ch03.indd   3808_487723-ch03.indd   38 3/27/10   10:38 AM3/27/10   10:38 AM



39 Chapter 3: To and Fro in a Document

Get Back to Where You Once Edited
Considering all the various commands for moving the insertion pointer, it’s 
quite possible to make a mistake and not know where you are in a document. 
Yea, verily, the insertion pointer has gone where no insertion pointer has 
gone before.

 Rather than click your heels together three times and try to get back the wish-
ful way, just remember this keyboard combination:

Shift+F5

Pressing the Shift+F5 keys forces Word to return you to the last spot you 
edited. You can do this as many as three times before the cycle repeats. But 
the first time should get you back to where you were before you got lost.

 ✓ The Shift+F5 command is the same as the Browse by Edits option, found 
on the Browse palette. Refer to the preceding section.

 ✓ Sadly, the Shift+F5 keyboard shortcut works only in Word; you can’t use 
this command in real life.

Go to Wherever with the Go To Command
Word’s Go To command allows you to send the insertion pointer to a specific 
page or line or to the location of a number of interesting elements that Word 
can potentially cram into your document. The Go To command is your word 
processing teleporter to anywhere.

To use the Go To command, click the Find button in the Home tab’s edit-
ing group. Choose the Go To command from the menu. Or, you can use the 
Ctrl+G keyboard shortcut. Either way, the Go To tab portion of the Find and 
Replace dialog box appears, as shown in Figure 3-4.

 

Figure 3-4: 
Telling 

Word to 
Go To 

you-know-
where.
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Choose which element to go to, such as a page, from the scrolling list on the 
left side of the dialog box. Then type the relevant information, such as a page 
number, in the box on the right side of the dialog box. Click the Go To button 
to go to that location.

For example, type 14 in the box and press Enter, and you go to page 14 — if 
you have a page 14 to go to.

 ✓ You can also summon the Go To command by clicking the page number 
on the status bar.

 ✓ Note that you can go to a page relative to the current page. For example, 
to go three pages forward, choose Page and type +3. To go 12 pages 
backward, type -12 in the box.
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Chapter 4

Text Editing
In This Chapter
▶ Deleting characters with Backspace and Delete

▶ Deleting lines, sentences, paragraphs, and pages

▶ Splitting and joining paragraphs

▶ Undoing your mistakes

▶ Using the Redo (Undo-Undo) command

I believe that writing involves two parts of your brain: The wild, creative   
 burst part is the typing part. Then there’s the tame, controlled editing 

part. You need both parts in order to write anything good. In fact, I’d wager 
that people who become frustrated with writing are too quick to enter the 
controlled editing part. Don’t fall into that trap: Write! Spew forth your words! 
Editing your text is easier when you have lots of words than when you have 
only a scant few.

When you’re ready to edit, you’ll use Word’s text editing commands. They all 
basically delete the stuff you’ve written. That’s right: Editing text is basically 
the same task as ruthlessly slashing away words from your text. Word comes 
with ample tools to make that happen. Use them freely, as described in this 
chapter. But get your abundance of words down on paper before you enter 
the vicious slashing mode.

Remove Text You Don’t Want
Credit the guy who put the eraser on the end of the pencil: It’s a given that 
human beings make mistakes. The round, soft eraser counterbalances the 
sharp point of the pencil in more ways than one.

The ability to erase text is just as valuable and necessary as the ability to 
create text. Deleting text is part of writing text, part of thinking and rethink-
ing, and part of self-editing. Writing. Deleting. Rewriting. Redeleting. That’s 
how it goes!
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Both creating and destroying text are accomplished by using the computer key-
board. The majority of keys are used to create text. Only two keys delete text: 
Backspace and Delete. How these keys work, and how much of your text they 
can delete, depends on how the keys are used, as described in this section.

Deleting single characters
By themselves, the Backspace and Delete keys are used to delete single 
characters:

 ✓ Backspace key: Deletes the character to the left of the insertion pointer

 ✓ Delete key: Deletes the character to the right of the insertion pointer

In the following example, the insertion pointer is “flashing” (okay, it would be 
flashing on a computer screen) between the h and the a in that. Pressing the 
Backspace key deletes the h; pressing the Delete key deletes the a.

 Bob proudly announced th|at he feels safe 
enough in his neighborhood to leave his home 
unlocked, but he added that his neighbor has 
nicer stuff.

 ✓ After you delete a character, any text to the right or below the character 
shuffles over to fill the void.

 ✓ You can press and hold Backspace or Delete to continuously “machine-
gun-delete” characters. Release the key to halt such wanton destruction, 
although I recommend using other delete commands (covered in this 
chapter) rather than the machine-gun approach.

 ✓ Special types of text in Word cannot easily be deleted using either the 
Backspace or Delete key. An example is an updating text field, which 
holds special text that always shows, say, today’s date. This type of text 
appears shaded in a light gray color when you try to delete it. That’s 
Word reminding you of the unusualness of the text. Press the Delete or 
Backspace key again to delete such text.

Deleting a word
To gobble up an entire word, add the Ctrl key to the Backspace or Delete 
key’s destructive power:

 ✓ Ctrl+Backspace deletes the word in front (to the left) of the insertion 
pointer.

 ✓ Ctrl+Delete deletes the word behind (to the right) of the insertion 
pointer.
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These keyboard shortcuts work best when the insertion pointer is at the 
start or end of a word. When you’re in the middle of the word, the commands 
delete only from that middle point to the start or end of the word.

After you delete a word, the insertion pointer sits at the end of the preceding 
word (or paragraph) when you use Ctrl+Backspace. Deleting a word by using 
Ctrl+Delete puts the cursor at the beginning of the next word. This is done to 
facilitate the rapid deletion of several words in a row.

After deleting the text, Word neatly wraps up the remaining text, snuggling 
it together in a grammatically proper way; deleting a word doesn’t leave a 
“hole” in your text.

No mere pencil eraser can match Ctrl+Delete or Ctrl+Backspace for sheer 
speed and terror!

Deleting more than a word
Beyond deleting a word or character, Word lacks keyboard-specific commands 
to delete lines or paragraphs of text. Word has ways to delete these things — 
those ways just aren’t obvious. Before the details come some definitions:

 ✓ A line of text is merely a line across the page (not really a grammatical 
issue).

 ✓ A sentence is a sentence. You know: Start with a capital letter and end 
with a period, a question mark, or an exclamation point. You probably 
learned this concept in grammar school, which is why they call it gram-
mar school anyway.

 ✓ A paragraph is one or more sentences, or a heading, ending with a press 
of the Enter key.

 ✓ A page of text is just that — all the text from where the page starts to 
where the page ends.

Word can also delete odd-size chunks of text by marking that text as a block. 
Refer to Chapter 6 for more information on blocks of text.

Deleting a line of text
The easiest way to delete a line of text is to use the mouse:

  1. Move the mouse into the left margin of your document.

   You know you’ve found the sweet spot when the mouse pointer changes 
into a northeast arrow.

 2. Point the mouse pointer arrow at the line of text you want to 
obliterate.
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 3. Click the mouse.

  The line of text is highlighted, or selected.

 4. Press the Delete key to send that line into oblivion.

Deleting a sentence
Making a sentence go bye-bye is cinchy:

 1. Point the mouse at the offending sentence.

 2. Press and hold the Ctrl key and click the mouse.

  The sentence is selected.

 3. Press the Delete key.

  Oomph! It’s gone.

Deleting a paragraph
Here’s the fastest way to delete a full paragraph:

 1. Point the mouse at the paragraph.

 2. Click the mouse button thrice.

  Thrice means “three times.”

 3. Press the Delete key.

If clicking thrice is befuddling you, move the mouse pointer into the left 
margin next to the offending paragraph. When the mouse pointer changes 
to a northeasterly-pointing arrow, click twice. That action selects the entire 
paragraph, which you can now whack by pressing the Delete key.

Deleting a page
Pages aren’t things that Word deals with offhand. In fact, pages are a printer 
issue. Even so, to delete a page, mind these steps:

 1. Press Ctrl+G to summon the Go To tab in the Find and Replace 
dialog box.

  See Chapter 3 for more information on the Go To command.

 2. Type the number of the page you want to delete.

 3. Click the Close button to dismiss the Go To dialog box.

 4. Press the F8 key.

  The F8 key is used to enter a special selection mode in Word, which I 
cover in detail in Chapter 6.
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 5. Press Ctrl+G.

  Once again, the Find and Replace dialog box appears, with the Go To tab 
ready for action.

 6. Type the next page number.

  If you’re deleting page 6, for example, type 7.

 7. Press Enter.

  The entire page is now selected.

 8. Press the Delete key.

  The page is gone.

Refer to Chapter 9 for special information on deleting that annoying extra 
blank page at the end of your document.

Split and Join Paragraphs
For some people, a paragraph in a word processor is a strange thing. It’s basi-
cally a chunk of text. Like most things that come in chunks — cheese, meat, 
large men named Floyd — it’s often necessary to split or combine them. Well, 
maybe not for Floyd.

Making two paragraphs from one
 To split a single paragraph in twain, locate the point where you want them to 

break — say, between two sentences. Move the insertion pointer to that loca-
tion and then press the Enter key. Word splits the paragraph in two; the text 
above the insertion pointer becomes its own paragraph, and the text following 
it then becomes the next paragraph.

Depending on where you placed the insertion pointer, you may need to 
delete an extra space at the beginning of the second paragraph or at the end 
of the first paragraph.

Making one paragraph from two
To join two paragraphs and turn them into one, you delete the Enter char-
acter between the paragraphs. To do that, move the insertion pointer to the 
start of the second paragraph and then press the Backspace key. Removing 
the Enter character joins two paragraphs.
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Depending on how neatly the paragraphs were joined, you may need to add 
a space between the sentences at the spot where the paragraphs were glued 
together.

The Soft and Hard Returns
Pressing the Enter key in Word ends a paragraph. It’s officially known as 
typing a hard return. Yes, it’s return even though the key is known as Enter on 
a PC. Don’t blame me for this odd nomenclature. I only write the books — not 
the programs.

The problem with the hard return is that it adds a bit of “air” after a para-
graph. That’s a good thing; as I explain in Chapter 11, you should have air 
around paragraphs in a document. Those times when you don’t want air, 
when you need to put lines of text close together, you use a soft return.

The soft return, or line break, is used primarily in titles and headings; when 
you have a long title and need to split it up between two lines, you press 
Shift+Enter to insert the soft return. For example, type this line:

Enjoying the Ballet

Press Shift+Enter. A new line starts. Continue typing:

A Guide for Husbands and Boyfriends

The soft return keeps the title text together (in the same paragraph), but on 
separate lines.

 You should also use the soft return when typing an address, either on an enve-
lope or in a letter. Press Shift+Enter after typing each of these lines:

Mr. President
1600 Pennsylvania Ave.
Washington, DC 20500

If you try typing the same text and press Enter instead, you see more space 
between the lines, which isn’t what you want. Nope, that soft return can sure 
come in handy.
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Undo Mistakes with Undo Haste
That quaffing and drinking will undo you.

— Richard II, William Shakespeare

The Undo command undoes anything you do in Word, which includes format-
ting text, moving blocks, typing and deleting text, formatting — the whole 
quesadilla. You have two handy ways to unleash the Undo command:

 ✓ Press Ctrl+Z.

 ✓ Click the Undo command button on the Quick Access Toolbar.

  I prefer using the Ctrl+Z key combination, but an advantage of the Undo com-
mand button is that it sports a drop-down menu that helps you review the 
past several things you’ve done, or that can be undone.

 ✓ Word’s Undo command is handy, but don’t use it as an excuse to be 
sloppy!

 ✓ Regrettably, you cannot pick and choose from the Undo command 
button’s drop-down menu; you can merely undo multiple instances of 
things all at one time.

 ✓ Undo works sporadically sometimes. Before this happens, Word warns 
you. For example, you may see a message such as “There is not enough 
memory to undo this operation, Continue?” Proceed at your own peril.

 ✓ The Undo command doesn’t work when there’s nothing to undo or if 
something just cannot be undone. For example, you cannot undo a save-
to-disk operation.

 ✓ To undo an Undo, choose Redo. See the next section.

Redo, the Undo-Undo command
If you undo something and — whoops! — you didn’t mean to, you must use 
the Redo command to set things back to the way they were. For example, you 
may type some text and then use Undo to “untype” the text. You can use the 
Redo command to restore the typing. You have two choices:

 ✓ Press Ctrl+Y.

 ✓ Click the Redo command button on the Quick Access Toolbar.
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  The Redo command does exactly the opposite of whatever the Undo com-
mand does. So, if you type text, Undo untypes the text and Redo recovers the 
text. If you use Undo to recover deleted text, Redo deletes the text again.

Redo, the Repeat Typing command
  When the Redo command has nothing left to redo, it changes functions and 

becomes the Repeat Typing command. Boy, can the Repeat Typing command 
be a timesaver!

For example, type these lines in Word:

Knock, knock.
Who’s there?
Knock.
Knock who?

Now press Ctrl+Y or choose the Repeat Typing command button from the 
Quick Access Toolbar. Word repeats the last few things you typed. (If you 
had to press the Backspace key to back up and erase, Ctrl+Y repeats only 
from that point on.)

 The Repeat Typing command can also used to reapply formatting. When you’re 
working through a document and changing styles on various chunks of text, 
using the Repeat key or Redo command can save oodles of time, especially in 
applying formatting. (See Part III of this book for information on formatting.)
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Chapter 5

Search for This,
Replace It with That

In This Chapter
▶ Finding text in your document

▶ Using various Find command options

▶ Searching for text that cannot be typed at the keyboard

▶ Hunting down formatting codes

▶ Replacing found text with other text

▶ Fixing formatting with the Replace command

P ity poor Lebnb Nook. He’s lost his Imperial Fleet in the Galactic Empire 
and now Darth Vader is on the other line, requesting an update. One 

must not keep Lord Vader on hold. Too bad for Lebnb that he doesn’t have 
Word. If so, he could use the Find command to instantly locate the absent 
armada. Not only that, but he could also use the Replace command to swap 
out some of those rusty old Corellians for some Super Star Destroyers. That 
would certainly impress the Dark Lord of the Sith! Could Word rival the Force 
as the strongest power in the galaxy?

Text Happily Found
Finding text is the domain of the Editing group, found on the far right end 
of the Home tab on Word’s Ribbon interface. The Editing command button 
group may appear in its full glory, as shown in Figure 5-1, or, when Word’s 
window is too narrow, you simply see an Editing button. When it’s a button, 
you must click the button first to see the palette of commands, which (sur-
prisingly) looks like the one shown in Figure 5-1.
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Figure 5-1: 
The Editing 

group.
 

Using the Find command
Word can quickly and graphically locate text in your document, from the tee-
niest tidbit of text to the world’s longest run-on sentence. It’s handled by the 
Find command. Abide by these steps:

 1. On the Home tab, click the Find button in the Editing group.

  You can also use the keyboard shortcut: Ctrl+F, which is one of the few 
keyboard shortcuts that make sense.

  Clicking the Find button or pressing Ctrl+F summons the Navigation 
pane, illustrated in Figure 5-2.

 

Figure 5-2: 
The 

Navigation 
pane helps 
you locate 

text.

 

Search text Close Navigation pane

Show previous searches
View in-context previews
Search document up/down

Matching text

View by
document
headings

View
page
previews
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 2. Type the text you want to find.

  As you type, matching text is highlighted in the document. Depending 
on which tab is chosen in the Navigation pane, you see matching results 
beneath the text box (refer to Figure 5-2).

  Be exact. For example, if you want to find fame and glory, type fame and 
glory — no period or spaces or quotes. Type only the text you’re look-
ing for.

 3. Page through the search results until you find the exact chunk of text 
you want.

  As you page, the document scrolls to find the next matching bit of text.

 4. Close the Navigation pane when you’re done hunting down text.

If you’d rather use the more traditional Find dialog box to locate text in 
Word, see the next section.

 ✓ When text can’t be found, the Navigation pane’s text box briefly shows 
red. You see the text No Matches displayed. Try again.

 ✓ The Navigation pane may already display text in the Find What box. If 
so, you can delete the text by pressing the Backspace key.

 ✓ Do not end the text with a period unless you want to find the period too.

 ✓ The Find command can find elements that you can’t readily type in, such 
as the Tab or Enter key. See the section “Finding stuff you can’t type in,” 
later in this chapter.

 ✓ If you’re not sure whether the text is typed in uppercase or lowercase 
letters, use lowercase.

 ✓ If the text isn’t found and you’re certain that it’s in there, check your 
spelling. If it’s correct, try searching for a single word rather than two or 
more words or a sentence.

 ✓ Word finds text only in the current document (the one you see on the 
screen). To find text in another document, switch to that document’s 
window and try searching again.

  ✓ After using the Find command, you can use the Browse Down button to 
continue your finding foray. Simply close the Find and Replace dialog 
box and then click the Browse Down button (or press Ctrl+PgDn). So, if 
you’ve already searched for and found nothing, clicking the Browse 
Down button finds even more nothing.
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Using the traditional Find command
Word’s traditional Find command isn’t as fancy as using the Navigation pane, 
but it offers more features. Oddly, you cannot easily summon the old Find 
command dialog box directly. Instead, you have to use a “work-around.” 
Here’s how to do it:

 1. Press Ctrl+G.

  The Ctrl+G keyboard shortcut summons the Find and Replace dialog 
box, with the Go To tab forward. (Go To is covered in Chapter 4.)

 2. Click the Find tab in the Find and Replace dialog box.

  And there you are, looking at something similar to Figure 5-3.

 

Figure 5-3: 
The Find tab 

of the Find 
and Replace 

dialog box.
 

 3. Type the text you want to find into the Find What box.

 4. Click the Find Next button.

  Word searches your document from the insertion pointer’s position to 
the end of the document.

  You can continue to click the Find Next button until the text you want is 
located.

 5. Click the Cancel button to close the Find and Replace dialog box.

If the text you’re looking for isn’t found, Word lets you know; click the OK 
button to dismiss the dismal warning.

 ✓ The advantage of using the traditional Find command in the Find and 
Replace dialog box is that you have many more options for finding text. 
See the next section.

 ✓ As with the newfangled Find command (see the preceding section), you 
can use the Browse buttons on the vertical scroll bar to hop through a 
document to find text in either the up or down direction, depending on 
which Browse button you click.
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 ✓ You can use the drop-down arrow gizmo (to the right of the Find What 
text box) to display a scrolling list of text you’ve previously searched 
for. To search again for a bit of text you’ve already searched for, click 
the drop-down arrow and click the text you want to find again. Click the 
Find Next button, and Word frantically begins searching.

Finding more than text
The Find command is powerful. It can do more than hunt down chunks and 
chunklettes of text. The Find command can find text exactly as it’s typed, text 
you cannot type, text formatting, and just about anything in a document. Yes, 
it’s still the same Find command, but it’s more.

To unleash the Super Find command, you need to summon the traditional 
Find and Replace dialog box: Press Ctrl+G and then click the Find tab 
(described in the preceding section). You unveil the Find command’s über-
abilities by clicking the More button. The Find and Replace dialog box grows 
taller, with a bunch of options and doodads at the bottom, as illustrated in 
Figure 5-4.

 

Figure 5-4: 
The more 

detailed 
Find and 
Replace 

dialog box.
 

The following sections explain how you can use the Find and Replace dialog 
box with its More part hanging open.
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Finding an exact bit of text
There’s a difference between Pat and pat. One is a name, and the other is to 
lightly touch something. To use the Find command to find one and not the 
other, select the Match Case option under Search Options. That way, Pat 
matches only words that start with an uppercase P and have lowercase at in 
them.

Finding a whole word
Use the Find Whole Words Only option to look for words such as elf and ogre 
without also finding words like shelf and progress.

Finding text that you know only a small part of (by using wildcards)
 Here’s a can-o-worms for you. You can use wildcards to find words that you 

know only a part of or a group of words with similar letters. This trick is a 
highly technical operation, so I advise you not to operate heavy machinery or 
sign a long-term lease or marriage contract when reading the following text.

The two basic wildcard characters are ? and *, where ? represents any single 
letter and * represents a group of letters. Suppose that you type the following 
line in the Find What box:

?ove

If you select the Use Wildcards option (in the More part of the Find and 
Replace dialog box), Word searches for any four-letter word that starts with 
any old letter but must end with “oh vee ee” — dove, love, and wove, for 
example.

The asterisk finds a group of characters, so the following wildcard locates 
any word starting with w and ending with s (there are lots of them):

w*s

Finding text that sounds like something else
The Sounds Like (English) option allows you to search for homonyms, or 
words that sound the same as the search word. You know: their and there or 
deer and dear or hear and here. How this is useful, I’ll never know.

Oh! This isn’t a rhyming search command. If you try to use it to find every-
thing that rhymes with Doris, for example, it doesn’t find Boris, chorus, pylo-
rus, or anything of the like.
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Finding variations of a word
Your editor informs you that no one will believe how the protagonist in your 
novel uses a pogo stick to travel the South. So you make him a biker. That 
involves changing every variation of the word hop (hopping and hopped, for 
example) to ride. In Word, you put a check mark by the option Find All Word 
Forms (English) in the über Find command’s dialog box (refer to Figure 5-4) 
and type the word hop in the Find What box. Click the Find Next button and 
you’re on your way.

Searching this way or that
Word normally searches from the insertion pointer’s position to the end of 
a document and then back ‘round the top again. You can override that stub-
bornness by placing your hand on the Find command’s tiller in the Search 
drop-down list, found in the More part of the Find and Replace dialog box. 
You have three options:

 ✓ All: When this option is chosen, Find searches the entire document, 
from the insertion pointer’s location down to the end of the document, 
back up to the beginning, and then back to where you started searching.

 ✓ Down: Find searches from the insertion pointer’s location to the end of 
your document and then it stops.

 ✓ Up: Find searches — backward — from the insertion pointer’s location 
to the start of your document. Then it stops.

 You can also use the Browse buttons on the vertical scroll bar to repeat the 
Find command up or down, depending on which Browse button you press.

Finding stuff you can’t type in
You can search for certain items in a document that you just cannot type at 
the keyboard. No, I’m not talking about nasty things — this isn’t a censorship 
issue. Instead, I’m referring to items such as tabs, Enter keys (paragraphs), 
page breaks, graphics, and other, similar nontypable things.

To find a special, unprintable character, click the More button to see the 
super-duper Find and Replace dialog box (refer to Figure 5-4), and then click 
the Special button. Up pops a list of various items that Word can search for 
but that you would have a dickens of a time typing, similar to the ones shown 
in Figure 5-5.
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Figure 5-5: 
Items to 

search for 
that you 

can’t type.
 

Twenty-two items are on the list, and you probably don’t recognize any of 
them. That’s fine; I’ve used maybe six of them in my entire word processing 
career. Here are some of the handier options you can use from the Special 
pop-up menu:

 ✓ Any Character, Any Digit, and Any Letter are special characters that 
represent, well, just about anything. These items can be used as wild-
cards for matching lots of stuff.

 ✓ Caret Character allows you to search for a caret (^) symbol, which may 
not seem like a big deal, but it is: Word uses the ^ symbol in a special 
way for finding text; see the third bullet in this section.

 ✓ Paragraph Mark (¶) is a special character that’s the same as the Enter 
character — the one you press to end a paragraph.

 ✓ Tab Character moves the cursor to the next tab mark.

 ✓ White Space is any number of blank characters: one or more spaces, 
tabs, empty lines, or a combination of each one.

Choose an item from the list to search for that special character. When you 
do, a special, funky shorthand representation for that character (such as ^t 
for Tab) appears in the Find What box. Click the Find Next button to find that 
character.

 ✓ To search for the Enter keypress, which marks the end of a paragraph, 
choose Paragraph Mark. To search for the paragraph character, ¶, 
choose Paragraph Character.
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 ✓ Yes, you can mix special characters with plain text. For example, to find 
a Tab character followed by Hunter, you use the Special button to insert 
the tab character (^t on the screen) and then type Hunter. It looks like 
this:

^tHunter

 ✓ It’s possible, although nerdy, to type the special characters manually. 
Although this method avoids using the Special menu, which can be big 
and baffling, it means that you need to memorize the character codes. 
Each one starts with the caret character, ^, and some of them are logi-
cal, such as ^p for Paragraph Mark (Enter) or ^t for Tab. Here are a few 
other handy shortcuts, for reference:

 Paragraph mark ^p

 Tab character ^t

 Any character ^?

 Any digit ^#

 Any letter ^$

 Caret character ^^

 Em dash ^+

 En dash ^=

 Manual line break ^1

 Manual page break ^m

 White space ^w

Finding formatting
In its most powerful superhero mode, the Find command can scour your 
document for formatting information. For example, if you want to find only 
those instances of the word lie in boldface type, you can do that. Before you 
attempt this task, I recommend that you understand Word’s formatting abili-
ties and commands, which are covered in Part III of this book.

The formatting options you can search for are revealed to you after a click of 
the Format button, which appears in the Find and Replace dialog box when the 
More button is clicked (refer to Figure 5-4). Clicking the Format button displays 
a pop-up menu of Word’s primary formatting commands, as shown in Figure 
5-6. Choosing any item from that list displays a corresponding dialog box, from 
which you can choose the formatting attributes to search for.
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Figure 5-6: 
Searching 

for 
formatting.

 

Suppose that you want to find a red herring in your document. Follow these 
steps:

 1. Summon the Find and Replace dialog box.

  Press Ctrl+G and then click the Find tab in the Find and Replace 
dialog box.

 2. Type red herring in the Find What box.

 3. If needed, click the More button to display the bottom part of the Find 
and Replace dialog box.

 4. If the No Formatting button is available, click it.

  This button is used to clear any previous formatting attributes you may 
have searched for. If the button can be clicked, click it to clear out those 
attributes and start afresh.

 5. Click the Format button.

 6. Choose Font from the pop-up list.

  The Find Font dialog box appears, which is where you set or control 
various text attributes. Say that the red herring you’re searching for is 
24 points tall.

 7. Choose 24 from the Size list.

  Look in the upper right corner of the Find Font dialog box.

 8. Click OK.

  The Font dialog box goes away and you return to the Find and Replace 
dialog box.

  Notice the text just beneath the Find What box: Format: Font: 24 
pt. That bit of text is telling you that Word is now geared up to find only 
text that’s 24 points tall — about twice the normal size.

 9. Click the Find Next button to find your formatted text.

If you want to search only for a format, leave the Find What text box blank 
(refer to Step 2). That way, you can search for formatting attributes without 
caring what the text reads.

 ✓ To find specific text attributes (bold or underline, for example), use the 
Find Font dialog box to choose those attributes.
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 ✓ You can use this technique to look for specific occurrences of a font, 
such as Courier or Times New Roman, by selecting the font from the 
selection list. Scroll through the font menu to see what you can choose.

 ✓ You can also search for paragraph formatting, such as an indented para-
graph, by choosing Paragraph rather than Font from the Format pop-up 
list in the Find and Replace dialog box.

 ✓ Yes, you can search for more than one formatting attribute at a time. 
Just keep choosing format options from the Format button.

 ✓ Word remembers your formatting options! The next time you want 
to search for plain text, you click the No Formatting button. Doing so 
removes the formatting options and allows you to search for text in any 
format. If you forget to clear out the formatting before you begin your 
next search, don’t be surprised if Word cannot find your text.

Replace Found Text and Stuff
The Find command is good only for finding stuff. Using Find and Replace, 
Little Bo Peep’s dream of becoming a real estate mogul reaches full fruition. 
You can quite easily in Word change every instance of sheep in a document 
to real estate. How that makes the document read, of course, is anyone’s 
guess. But it can be done!

You may opt for a more practical use of the Find and Replace command. For 
example, you may want to change all instances of ungulates in your document 
to ruminants. Here’s how that’s done:

 1. On the Home tab, click the Replace command button, found nestled in 
the Editing group on the far right side.

  When the Replace command button isn’t visible in the Editing group 
(refer to Figure 5-1), click the Editing button and then choose the 
Replace command button from the pop-up group of command buttons 
that appears.

  Choosing the Replace command button displays the Find and Replace 
dialog box, shown in Figure 5-7. This place should be familiar if you’ve 
often used the Find command. After all, finding stuff is the first part of 
using Find and Replace.

 2. In the Find What box, type the text you want to find.

  You want to replace this text with something else. So, if you’re finding 
misery and replacing it with company, type misery.

  Press the Tab key when you’re done typing.
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Figure 5-7: 
The Replace 

part of the 
Find and 
Replace 

dialog box.
 

 3. In the Replace With box, type the text you want to use to replace the 
original text.

  To continue from the example in Step 2, you type company here.

 4. Click the Find Next button.

  At this point, the Replace command works just like the Find command: 
Word scours your document for the text you typed in the Find What 
dialog box. When that text is found, you move on to Step 5; otherwise, 
the Replace command fails because there’s nothing to replace.

 5. Click the Replace button.

  Word replaces the found text, highlighted onscreen, with the text typed 
in the Replace With box.

 6. Continue replacing.

  After you click the Replace button, Word immediately searches for the 
next instance of the text, at which point you repeat Step 5 until the 
entire document has been searched.

 7. Read the summary that’s displayed.

  After the last bit of text is replaced, a dialog box appears and lists a sum-
mary for you. For example, it might say, “Word has completed its search 
of the document and has made 9 replacements.” Of course, the number 
of replacements depends on what you were searching for and yadda-
yadda.

 8. Click the Close button.

You’re done!

 ✓ All the restrictions, options, and rules for the Find command also apply 
to finding and replacing text. Refer to the section “Text Happily Found,” 
at the start of this chapter.

 ✓ The keyboard shortcut for the Replace command is Ctrl+H. The only 
way I can figure that one out is that Ctrl+F is the Find command and 
Ctrl+G is the Go To command. F, G, and H are found together on the 
computer keyboard, and Find, Replace, and Go To are found together in 
the Find and Replace dialog box. Go figure.
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 ✓ The Replace command’s dialog box also sports a More button, which 
can be used exactly as the More button for the Find command. See the 
section “Finding more than text,” earlier in this chapter.

 ✓ Word may find your text in the middle of another word, such as use in 
causes. Oops! Click the More button and select the Find Whole Words 
Only option to prevent such a thing from happening.

 ✓ If you don’t type anything in the Replace With box, Word replaces your 
text with nothing! It’s wanton destruction!

 ✓ Speaking of wanton destruction, the Undo command restores your docu-
ment to its preceding condition if you foul up the Replace operation. See 
Chapter 4 for more information.

Replacing it all at once
The steps in the previous section work well to find and replace tidbits of 
text around your document. But it can often be tedious to keep pressing that 
Replace button over and over. That’s why the Replace command’s dialog box 
sports a handy Replace All button.

The Replace All button directs the Replace command to find all instances 
of the Find What text and — without question — replace it with the Replace 
With text. To use this button, simply click the Replace All button in Step 5 in 
the previous section. Then skip to Step 8.

Finding and replacing formatting
 Just as the Find command can search for text with specific formatting, you can 

use the Replace command to replace text and apply formatting or to replace 
one type of formatting with another. Needless to say, this process can be tricky: 
Not only do I recommend that you be familiar with Word’s formatting com-
mands, but you should also be well practiced in using the Replace command.

Suppose that you want to replace all instances of underlined text with italic. 
Underlined text reeks so much of typewriter, and that’s just too 20th century 
for these modern times. By replacing underline with italic, you’re searching for 
one text format and replacing it with another; you’re not even searching for 
text. So be careful. Do this:

 1. Press Ctrl+H to summon the Find and Replace dialog box.

 2. Click the More button, if necessary, to display the full dialog box.

 3. Click to select any text in the Find What box, and then delete that text 
by pressing the Backspace key.
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 4. Click the Format button and choose Font from the pop-up menu that 
appears.

  The Find Font dialog box appears.

 5. In the Find Font dialog box, choose the single underline graphic from 
the Underline style drop-down list.

 6. Click OK.

  Back in the Find and Replace dialog box, the text Format: Underline 
appears below the Find What box.

 7. Click to select any text in the Replace With box and press Backspace 
to delete that text.

 8. Choose Font from the Format button’s pop-up list.

 9. In the Find Font dialog box, choose (None) as the underline style.

  This step is necessary because otherwise Word wouldn’t remove the 
first style; it would merely add to that style. Likewise, text attributes 
such as Not Bold and Not Italic are found in the Replace Font dialog box.

 10. Choose Italic from the Font Style list.

 11. Click OK to close the Replace Font dialog box.

  Below the Replace With box, it should say Format: Font: Italic, 
No underline. That means Word will search for underlined text and 
replace it with italic text and remove the underline.

 12. Click the Replace All button.

  Word scours your document and replaces any underlined text with 
italic.

 13. Click OK when the find-and-replace is done.

As long as you set things up carefully, searching and replacing text format-
ting is a quick and easy way to spiff up a boring document.

 ✓ To replace one format with another, such as underline with italic, be 
sure to leave the Find What and Replace With text boxes empty. That 
way, only the text formatting is replaced.

 ✓ An easier way to update formatting in a document is to use and apply 
styles. Refer to Chapter 15 for details.

 ✓ Don’t forget about the No Formatting button! You need to click it if you 
want to change the formats or replace text without paying attention to 
formats.
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Chapter 6

Blocks o’ Text
In This Chapter
▶ Using blocks of text

▶ Marking a block with the keyboard

▶ Selecting text with the mouse

▶ Using the F8 key to mark text

▶ Unblocking text

▶ Copying and moving blocks of text

▶ Pasting text in various ways

▶ Working with collect and paste and the Clipboard

There are plenty of interesting blocks when it comes to writing: those 
moveable blocks that the ancient Chinese used for printing, the inevi-

table writer’s block, and, finally, the blocks of text in a document. I believe 
that you’ll find, of these three examples, working with blocks of text in a 
document not only the most useful but also the easiest to understand. That’s 
because working with blocks in Word is like playing with blocks as a kid: Mix 
in some cut, copy, and paste and you have this engaging chapter on working 
with blocks of text.

Understanding Blocks
A block is simply a portion of text in your document, from a single character 
to the entire document. The block has a beginning and an end, and the block 
itself consists of all the text between them.

You create a block by selecting text. You select text by using the keyboard or 
the mouse or one of various other text-selection techniques covered in this 
chapter.
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On the screen, the block appears highlighted, as shown in Figure 6-1.

 

Figure 6-1: 
A block 

of text is 
selected.

 

By marking off text as a block, you can perform certain actions, or use vari-
ous Word commands, that affect only the text in that block. Or, you can copy 
or move the block of text.

 ✓ A block of text in Word includes all letters and characters and the text 
formatting.

 ✓ Graphics and other nontext elements can also be selected as a block. In 
fact, you can select graphics along with text in the same block.

 ✓ When the status bar is displaying a word count, the number of words 
selected in the block of text is displayed, next to the total number of 
words in the document. (Refer to Figure 6-1.)

 ✓ When the Find command locates text, the text is selected as a block. 
Refer to Chapter 5 for more information on the Find command.

 ✓ Selecting text also means selecting characters such as tabs and the 
Enter keypress that marks the end of a paragraph. Fortunately, Word 
shows the Enter “character” as an extra blank space at the end of a 
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paragraph. When you select that blank, you select the whole paragraph 
as a paragraph. To avoid selecting the Enter character, don’t select the 
blank space at the end of a paragraph.

Selecting Blocks of Text
Word offers you many ways to mark text as a block in your document. This 
section mulls over the possibilities.

Using the keyboard to select text
The secret to using the keyboard to select text is the Shift key. By holding 
down the Shift key, you can use the standard keyboard commands that move 
the insertion pointer to select blocks of text. Table 6-1 has some suggestions 
for you.

Table 6-1 Shifty Selection Wizardry

To Select This Press This

A character at a time to the right of the insertion pointer Shift+→
A character at a time to the left of the insertion pointer Shift+←
A block of text from the insertion pointer to the end of the line Shift+End

A block of text from the insertion pointer to the beginning of 
the line

Shift+Home

A block of text from the insertion pointer to a line above Shift+↑
A block of text from the insertion pointer to a line below Shift+↓

You can use any keyboard cursor-movement command (I list them in Chapter 
3), but I recommend using this Shift key method for selecting only small 
chunks of text. Otherwise, you may end up tying your fingers into knots!

 Either Shift key works, although I prefer to use the left Shift key and then work 
the arrow keys on the right side of the keyboard.
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Marking a block with the mouse
Forget cheese. The computer mouse was born to mark text, by selecting vast 
swaths of words with a wide sweep of your hand, by clicking a number of 
times, or by using the old click-and-drag routine. Mickey may rule a kingdom, 
but your computer mouse rules over text selection in your computer.

Dragging over text to select it
The most common way to select text is by using the computer mouse thus:

 1. Point the mouse at the start of the text block.

 2. Click and drag the mouse over the text you want to select.

  As you drag, text becomes highlighted, or selected. (Refer to Figure 6-1.)

 3. Release the mouse — stop the dragging — to mark the end of the block.

You can use these steps to select any old block size in your document.

 ✓ This selection technique works best when you use the mouse to drag 
over only the text you can see on the screen. When you try to select text 
beyond what you see on the screen, you have to select and scroll — 
which can be unwieldy; the mouse scrolls the text up and down quickly 
and, well, things get out of hand.

 ✓ When you find yourself becoming frustrated over not selecting all or 
part of a word, refer to the nearby sidebar, “Would you rather select text 
by letter or by word?”

Out, damn Mini toolbar!
When the mouse is used to select text, Word 
displays the Mini toolbar, looking like this:

The Mini toolbar is a palette of common format-
ting commands that Word supposes you need 
for a quick format on that selected text. After 
initially disliking the Mini toolbar, I’ve grown 
to enjoy it. But I recognize that you may find it 
more annoying than useful. If so, you can sup-
press its display. Follow these steps:

 1. Choose the Options command from the File 
tab’s menu.

 2. If necessary, choose General from the 
list on the left side of the Word Options 
window.

 3. Remove the check mark by the item Show 
Mini Toolbar on Selection.

 4. Click OK.

If you would rather not eternally banish the Mini 
toolbar, note that it hides itself whenever you 
move the mouse beyond the selected chunk of 
text.
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Selecting text by clicking the mouse
A speedy way to select specific sizes of chunks of text is to match the power 
of the mouse with the dexterity of your index finger. Table 6-2 explains some 
clicking-and-selecting techniques worth noting.

Table 6-2 Mouse Selection Arcana

To Select This Chunk of Text Click the Mouse Thus

A single word Point at the word with your mouse and 
double-click.

A line

Move the mouse pointer into the left margin 
beside the line you want to select. The mouse 
pointer changes to an arrow pointing northeast-
ward. Click the mouse to select a line of text or 
drag the mouse up or down to select several 
lines.

A sentence Point the mouse at the sentence and Ctrl+click. 
(Press the Ctrl key and click the mouse.)

A paragraph Point the mouse somewhere in the paragraph’s 
midst and triple-click.

Selecting text with the old poke-and-point
 Here’s the best way to select a chunk of text of any size, especially when that 

chunk of text is larger than what you can see on the screen at one time:

 1. Click the mouse to set the insertion pointer wherever you want the 
block to start — the anchor point.

Would you rather select text by letter or by word?
When you’re selecting more than a single word, 
the mouse tends to grab text a full word at a 
time. If you want Word to select text by char-
acters rather than by words (which is what I 
prefer), follow these steps:

 1. Choose the Options command from the File 
tab’s menu.

 2. Choose Advanced from the list on the left 
side of the Applications Settings window.

 3. Under the Editing Options heading, remove 
the check mark by the item labeled When 
Selecting Automatically Select Entire 
Word.

 4. Click OK.
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 2. Scroll through your document using the scroll bar.

  You must use the scroll bar to scroll through your document. If you use 
the cursor-movement keys, you reposition the insertion pointer, which 
isn’t what you want.

 3. To mark the end of the block, press and hold the Shift key and click 
the mouse where you want the block to end.

  The text from the insertion pointer to wherever you clicked the mouse is 
selected as a block.

Using the F8 key to mark a block
 If you can remember that the F8 key on the computer’s keyboard can be used 

to mark text, you can exploit one of the most powerful but seldom used text-
marking tools that Word has to offer.

Yes, wacky as it sounds, the F8 key is used to mark a block of text. Pressing 
F8 once enters extended selection mode. That’s where Word drops anchor at 
the insertion pointer’s location and then lets you use either the mouse or the 
cursor keys to select text. In fact, you cannot do anything but select text in 
extended selection mode (unless you press the Esc key to exit this mode).

Don’t let the F8 key weirdness boggle you. Instead, consider these steps the 
next time you need to mark a block of text:

 1. Position the insertion pointer at the start of the block of text.

 2. Press the F8 key.

  The F8 key drops anchor and marks one end of the block.

 3. Use the keyboard’s cursor keys to select the block of text.

  The cursor-navigation keys are discussed in Chapter 3.

  Press a letter key to select text up to and including that letter. If you 
press N, you select all text up to and including the next N in your docu-
ment. Nice. Nifty. Neat-o.

  Word highlights text from the point where you dropped anchor with F8 
to wherever you move the insertion pointer.

 4. Do something with the selected block of text.

  Word remains in extended selection mode until you do something with 
the block.
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Doing something with a block of text is covered in the second half of this 
chapter.

 To cancel the extended selection, press the Esc key. That action ends 
extended selection mode and keeps the block of text marked.

 ✓ You can use the mouse and the F8 key to get fancy. Position the cursor 
at either end of the block you want to mark and press the F8 key. Then 
position the mouse cursor at the other end of the block and press the 
left mouse button. Everything from there to there is marked.

 ✓ After pressing the F8 key, you can use the Find command to locate a 
specific bit of text. Word marks all text between the spot where F8 was 
pressed (the anchor) and the text that the Find command locates.

 ✓ Press the F8 key twice to select the current word (the one the insertion 
pointer is blinking inside of).

 ✓ Press the F8 key thrice (three times) to select the current sentence.

 ✓ Press the F8 key four times to select the current paragraph as a block 
of text.

 ✓ Press the F8 key five times to select the entire document, from top to 
bottom.

 ✓ No matter how many times you press F8, be aware that it always drops 
anchor. So, pressing F8 once or five times means that Word is still in 
extended selection mode. Do something with the block or press Esc to 
cancel that mode.

Blocking the whole dang-doodle document
The biggest block you can mark is an entire document. Word has a specific 
command to do it, to select all text in a document: From the Home tab, locate 
the Editing area. (Click the Editing button when the entire Editing area isn’t 
visible.) Then choose Select➪Select All. Instantly, the entire document is 
marked as a single block o’ text.

From the keyboard, you can use Ctrl+A to select an entire document or just 
press the F8 key five times. Or, you can even use the obscure Ctrl+5 (the 5 on 
the numeric keypad) key combo.
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Deselecting a Block
When you mark a block of text and change your mind, you must unmark, or 
deselect, the text. Here are a few handy ways to do it:

 ✓ Move the insertion pointer. It doesn’t matter how you move the insertion 
pointer, with the keyboard or with the mouse — doing so unhighlights 
the block. Note that this trick doesn’t exit the F8 key’s extended selection 
mode.

 ✓ Press the Esc key and then the ← key. This method works to end 
extended selection mode.

 ✓ Press Shift+F5. The Shift+F5 key combo is the “go back” command (see 
Chapter 3), but it also deselects a block of text and returns you to the 
text you were editing before making the selection.

Manipulating Blocks of Text
You can block punches, block hats, block and tackle, play with building 
blocks and engine blocks, take nerve blocks, suffer from mental blocks, jog 
for blocks, and, naturally, block text. But what can you do with those marked 
blocks of text?

Why, plenty of things! You can apply a format to all text in the block, copy a 
block, move a block, search through a block, proof a block, print a block, and 
even delete a block. The information in this section explains those tricks.

 ✓ Blocks must be selected before you can manipulate them. See the first 
half of this chapter.

 ✓ When a block of text is marked, various Word commands affect only the 
text in that block.

Copying a block
After a block is marked, you can copy it into another part of your document, 
to duplicate the text. The original block remains untouched by this opera-
tion. Follow these steps to copy a block of text from one place to another:

 1. Mark the block.

  Detailed instructions about doing this task are offered in the first part of 
this chapter.
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  2. From the Home tab, choose the Copy tool from the Clipboard area.

   Or, you can use the common Ctrl+C keyboard shortcut for the Copy 
command.

  You get no visual clue that the text has been copied; it remains selected.

 3. Move the insertion pointer to the position where you want to place 
the block’s copy.

  Don’t worry if there’s no room! Word inserts the block into your text.

  4. Choose the Paste tool from the Clipboard area.

   Or, you can use the common Ctrl+V keyboard shortcut for the Paste 
command.

The block of text you copy is inserted into your text just as though you had 
typed it there by yourself.

 ✓ See the later section “Setting the pasted text format” to find out what to 
do about the wee li’l clipboard icon that appears by the pasted text.

 ✓ After you copy a block, you can paste it into your document a second 
time. That’s because whenever a block of text is cut or copied, Word 
remembers it. You can yank that block into your document again at any 
time — sort of like pasting text again after it has already been pasted in. 
You use Ctrl+V, the Paste shortcut. Pasting text again simply pastes down 
a second copy of the block, spit-spot (as Mary Poppins would say).

 ✓ You can paste the block into another document you’re working on or 
even into another application. (This is a Windows trick, which most 
good books on Windows discuss.)

 ✓ Refer to the section “Collecting and Pasting,” near the end of this chap-
ter, for more copy and paste choices.

Moving a block
  To move a block of text, you select the text and then cut and paste. This pro-

cess is almost exactly the same as copying a block, described in the previous 
section, although in Step 2 you choose the Cut tool rather than the Copy tool 
or press the Ctrl+X keyboard shortcut for the Cut command. Otherwise, all 
steps are the same.

Don’t be alarmed when the block of text vanishes! That’s cutting in action; 
the block of text is being moved, not copied. You see the block of text again 
when you paste it in place.
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 Don’t panic! If you screw up, remember that the Ctrl+Z Undo shortcut undoes 
a block move.

Setting the pasted text format
  When you paste text in Word, the Paste Options icon appears near the end of 

the pasted block of text, as shown in the margin. Don’t let it annoy you! That 
button allows you to select formatting for the pasted block because occasion-
ally the block may contain formatting that, well, looks quite ugly after it’s 
pasted in.

To work the Paste Options button, click it with the mouse or press and 
release the Ctrl key on the keyboard. You see a menu of options, illustrated 
in Figure 6-2.

 

Figure 6-2: 
Pasting 
options.

 

Press Ctrl to
see the menu.

Keep Source Formatting

Merge Formatting

Keep Text Only

Table 6-3 summarizes the available paste options.

Table 6-3 Paste Option Options

 Icon Keyboard 
Shortcut

Name Description

   K Keep Source 
Formatting

The formatting is fine; 
don’t do a thing.

   M Merge 
Formatting

Reformat the pasted 
block so that it looks 
like the text it’s being 
pasted into.

   T Keep Text 
Only

Just paste in the 
text — no formatting.
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To keep only text with a copied or cut block (no formatting), you can press 
the Ctrl key and then the T key after pasting. That’s two separate keys, not 
Ctrl+T.

Using the Paste Options icon is utterly optional. In fact, you can continue 
typing or working in Word and the icon bows out, fading away like some neb-
bish who boldly asked a power blonde to go out with him and she utterly 
failed to recognize his existence. Like that.

 You can choose the Set Default Paste command after clicking the Paste 
Options icon to direct Word on how to permanently deal with pasted text. 
That’s a handy trick, especially when you find yourself repeatedly choosing 
the same Paste Options format.

Copying or moving a block with the mouse
When you have to move a block only a short distance, you can use the mouse 
to drag-move or drag-copy the block. This feature works best when you’re 
moving or copying a block to a location that you can see right on the screen. 
Otherwise, you’re scrolling your document with the mouse while you’re play-
ing with blocks, which is like trying to grab an angry snake.

  To move any selected block of text with the mouse, just drag the block: Point 
the mouse cursor anywhere in the blocked text and then drag the block to its 
new location. Notice how the mouse pointer changes, as shown in the 
margin. That means you’re moving the block of text.

  Copying a block with the mouse works just like moving the block, except that 
you press the Ctrl key as you drag. When you do that, a plus sign appears in 
the mouse pointer (see the margin). That’s your sign that the block is being 
copied and not just moved.

 ✓ The Paste Options icon appears after you “drop” the chunk of text. Refer 
to the preceding section for more information on the Paste Options icon.

 ✓ When you drag a block of text with the mouse, you’re not copying it to 
the Clipboard. You cannot use the Paste (Ctrl+V) command to paste in 
the block again.

 ✓ A linked copy is created by dragging a selected block of text with the 
mouse and holding down both the Shift and Ctrl keys. When you release 
the mouse  button, the copied block plops down into your document 
with a dark highlight. That’s your clue that the copy is linked to the orig-
inal; changes in the original are reflected in the copy and vice versa.
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Collecting and Pasting
When you cut or copy a block of text, the block is placed into a storage area 
known as the Clipboard. The block of text remains on the Clipboard until it’s 
replaced by something else — another block of text or a graphic or anything 
cut or copied in Windows. (The Clipboard is a Windows feature, which is how 
you can copy and paste between Windows applications.)

In Word, however, the Clipboard can hold more than one thing at time. You 
can copy, copy, copy and then use the special Clipboard pane to selectively 
paste text back into your document. The technique, collect and paste, is dis-
cussed in this section.

Looking at the Clipboard pane
To view the Clipboard pane, click the dialog box launcher found in the lower 
right corner of the Clipboard group on the Home tab, right next to the word 
Clipboard. The Clipboard pane then appears in the writing area of the Word 
window, perhaps looking similar to the one shown in Figure 6-3.

 

Figure 6-3: 
The 

Clipboard 
task pane.

 

The scrolling list contains the last several items you copied, not only from 
Word but perhaps from other programs as well.

Pasting items from the Clipboard task pane is covered in the next section.
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 ✓ You can use the Copy command multiple times in a row to collect text 
when the Clipboard task pane is visible.

 ✓ Word’s Clipboard can hold only 24 items. If any more than that number 
is copied or cut, the older items in the list are “pushed off” to make 
room for the new ones. The current number of items is shown at the top 
of the task pane.

 ✓ Other programs in Microsoft Office (Excel and PowerPoint, for example) 
also share this collect-and-paste feature.

 ✓ You can close the task pane when you’re done with collect and paste: 
Click the X in the upper right corner of the task pane window.

Pasting from the Clipboard pane
To paste any collected text from the Clipboard pane into your document, 
simply click the mouse on that chunk of text. The text is copied from the 
Clipboard and inserted into your document at the insertion pointer’s loca-
tion, just as though you typed it yourself.

After you paste, the Paste Options icon appears next to the pasted text. Refer 
to the section “Setting the pasted text format,” earlier in this chapter, to find 
out what do to with that thing.

 ✓ You can click the Paste All button to paste every item from the 
Clipboard into your document.

 ✓ Click only once! When you double-click, you insert two copies of the text.

Cleansing the Clipboard pane
You’re free to clean up Word’s Clipboard whenever the Clipboard pane is 
visible. To remove a single item, point the mouse at that item and click the 
downward-pointing triangle to the right of the item. Choose Delete from the 
shortcut menu and that lone item is zapped from the Clipboard.

To whack all items on the Clipboard, click the Clear All button at the top of 
the Clipboard task pane.

 You cannot undo any clearing or deleting that’s done in the Clipboard task 
pane.
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Chapter 7

Spell It Write
In This Chapter
▶ Understanding document proofing

▶ Dealing with typos and spelling errors

▶ Adding or ignoring unknown words

▶ Correcting words automatically

▶ Fixing grammatical boo-boos

▶ Reviewing your document quickly

▶ Customizing proofing options

▶ Checking AutoCorrect settings

There’s no such thing as spelling in English. Spelling in English evolved 
over time. Even the venerable Bard, William Shakespeare, spelled his 

own name several different ways. It wasn’t until the notion of the “dictionary” 
that spelling became more or less standardized.

The same feeling of randomness can be applied to English grammar. Despite 
all those schoolteachers and editors out there, English is not Latin. English 
grammar has more exceptions than it has rules. That makes English a remark-
ably flexible and poetic language, but also makes it frustrating to discern 
meaning or ply some type of consistency from our mother tongue.

Word tries its best to remedy the situation: It comes with document proof-
ing tools. They include on-the-fly and in-your-face spelling and grammatical 
checkers. This chapter describes how they work, when to use them, and 
when to ignore them.

Hue Right Grate
Word’s document proofing tools are as technologically advanced as the pro-
grammers at Microsoft can make them. As the title of this section suggests, 
however, there’s something to be said about context.
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 Just because it appears that your document contains no errors doesn’t mean 
that everything is perfect. You have no better way to proof a document than 
to read it with human eyes.

Check Your Spelling
Spell-checking in Word works the second you start typing. Offending or 
unknown words are immediately underlined with the red zigzag of shame. 
Word can also be employed to scan the entire document word-by-word for 
your attempts at mangling the English language, Word can be trained to use 
the AutoCorrect feature to automatically correct your common typos and 
misspellings. This section describes the details.

Dealing with on-the-fly spell checking
Word has an internal library consisting of tens of thousands of words, all 
spelled correctly. Every time you type a word, it’s checked against that dic-
tionary. When the word isn’t found, it’s marked as suspect in your document. 
The mark is a red zigzag underline, as shown in Figure 7-1. What to do, what 
to do?

 

Figure 7-1: 
The word 
bilsters is 

flagged as 
misspelled.

 

My advice: Keep typing. Don’t let the “red zigzag of a failed elementary educa-
tion” perturb you. Focus on getting your thoughts up on the screen rather 
than on stopping and fussing over inevitable typos.

When you’re ready, say, during one of those inevitable pauses that takes 
place as you write, go back and fix your spelling errors. Here’s what to do:

 1. Locate the misspelled word.

  Look for the red zigzag underline.

 2. Right-click the misspelled word.

  Up pops a shortcut menu and the Mini toolbar, shown in Figure 7-2.
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Figure 7-2: 
Choose the 

properly 
spelled 

word from 
the list.

 

 3. Choose from the list the word you intended to type.

  In Figure 7-2, the word blisters fits the bill. Click that word and it’s auto-
matically inserted into your document, to replace the spurious word.

If the word you intended to type isn’t on the list, don’t fret. You may have to 
use a real dictionary or take another stab at spelling the word phonetically 
and then correct it again.

 ✓ When the word is spelled correctly and Word is just too stupid to recog-
nize it, you can add the word to its dictionary. See the next section.

 ✓ Word turns off automatic proofing when your document grows over a 
specific size. For example, on my computer, when the document is more 
than 100 pages long, automatic spell checking is disabled. A warning 
appears to alert you when this happens. Note that you can still manu-
ally spell-check, which is covered in the section “All-at-Once Document 
Proofing,” later in this chapter.

Dealing with words incorrectly 
flagged as being misspelled
Occasionally, Word’s spell checker bumps into a word it doesn’t recognize, 
such as your last name or perhaps your city. Word dutifully casts doubt on 
the word, by underlining it with the notorious red zigzag. Yes, this case is one 
of those where the computer is wrong.

Two commands are on the spell-checker’s right-click menu (refer to Figure 
7-2) to deal with those false negatives: Ignore All and Add to Dictionary.
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Ignore All: Select this command when the word is properly spelled and you 
don’t want Word to keep flagging it as misspelled.

For example, your science fiction short story has a character named Zadlux. 
Word believes it to be a spelling error, but you (and all the people of the 
soon-to-be-conquered planet Drebulon) know better. After you choose the 
Ignore All command, all instances of the suspect word are cheerfully ignored, 
but only in that one document.

Add to Dictionary: This command adds words to Word’s custom dictionary, 
which is a supplemental list of spelled-correctly words used to proof a 
document.

For example, I once lived on Pilchuck Avenue, which Word thinks is a mis-
spelling of the word Paycheck. If only. So, when I right-click the incorrectly 
flagged word, I choose the Add to Dictionary command. Presto — the word 
Pilchuck is added to Word’s custom dictionary. I’ll never have to spell-check 
that word again.

 ✓ If the word looks correct but is red-wiggly-underlined anyway, it could 
be a repeated word. They’re flagged as misspelled by Word, so you can 
either choose to delete the repeated word or just ignore it.

 ✓ Word ignores certain types of words — for example, words with num-
bers in them or words written in all capitals, which are usually abbre-
viations. For example, Pic6 is ignored because it has a 6 in it. The word 
NYEP is ignored because it’s in all caps.

 ✓ You can adjust how spell-checking works, especially if you feel that it’s 
being too picky. See the section “Control Word’s Proofing Options,” later 
in this chapter.

Undoing the Ignore All command
Choosing the Ignore All command means that all instances of a given mis-
spelled word or typo are ignored in your document. This statement holds 
true even when you save that document and open it again later. So, if you 
make a mistake and would rather have the ignored word regarded once 
more, do this:

 1. Choose the Options command from the File tab’s menu.

  The Word Options window appears.

 2. Choose Proofing on the left side of the window.

 3. Scroll down the right side of the window (if necessary) until you can 
see the Recheck Document button; click that button.

  A warning dialog box appears, reminding you of what you’re about to do.
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 4. Click the Yes button.

  Everything you’ve told Word to ignore while proofing your document is 
now ignored. It’s the ignore-ignore command!

 5. Click the OK button to return to your document.

By following these steps, you direct Word to not only un-ignore all previously 
ignored words but also any grammatical errors you’ve chosen to ignore. You 
have no way to undo this command.

 The steps for undoing the Ignore All command affect only the current docu-
ment. The Ignore All command affects only the current document.

Removing words from the 
custom dictionary
When you choose the Add to Dictionary command, the given word is placed 
into the custom dictionary. Recognizing that people may change their minds, 
Word allows you to edit its custom dictionary, to remove words you may 
have added accidentally.

To remove unwanted words from the custom dictionary, follow these steps:

 1. Click the Word Options button on the File tab’s menu.

  The Word Options window shows up.

 2. From the left side of the window, choose Proofing.

 3. Click the button labeled Custom Dictionaries.

  The Custom Dictionaries dialog box appears.

 4. Select the CUSTOM.DIC dictionary file.

  It’s probably the only item in the list.

 5. Click the button labeled Edit Word List.

  You see a scrolling list of words you’ve added to the custom dictionary.

 6. Find and select the word you want to remove from the dictionary.

  The word is selected by clicking it once.

 7. Click the Delete button.

 8. Repeat Steps 6 and 7 if you want to remove more words.

 9. Click the OK button when you’re done editing the dictionary.

  Close any other open windows.
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AutoCorrect Your Common Typos
Some typos and spelling errors are never graced by the red zigzag. That’s 
because Word quickly fixes hundreds of common typos and spelling errors 
on the fly. It’s done by the AutoCorrect feature, and you have to be quick to 
see it.

Understanding AutoCorrect
There’s nothing to using AutoCorrect; it happens automatically. In Word, try 
to type the word mispell. You can’t! Word uses AutoCorrect and suddenly 
you see misspell.

Most commonly misspelled words can be found in AutoCorrect’s repertoire: 
beleive, suposed, recieve, and so on. Try a few. See whether you can baffle 
Word!

In addition to fixing spelling errors, AutoCorrect helps you enter special char-
acters. For example, type (C) and AutoCorrect properly inserts the © copy-
right symbol. Ditto for (TM) for the trademark. Typing--> is translated into an 
arrow, and even :) becomes a happy face.

Beyond spelling, AutoCorrect fixes some common punctuation. It automati-
cally capitalizes the first letter of a sentence. AutoCorrect capitalizes I when 
you forget to, properly capitalizes the names of days, fixes the iNVERSE cAPS 
lOCK pROBLEM, plus other common typos.

The 25 most frequently misspelled words

a lot atheist grammar maneuver ridiculous

accidentally collectible gauge no one separate

acquire consensus independent occurrence supersede

amateur definite kernel realize their

argument embarrass liaison receive weird
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Creating your own AutoCorrect entries
One joy of using AutoCorrect is that you can add your own commonly mis-
spelled words to its list. For example, I’m always goofing up the word brief. I 
before E? E before I? Never mind! I need to fix the spelling error only once by 
placing my typo and the proper spelling into AutoCorrect’s repertoire. This 
task is cinchy:

 1. Right-click the misspelled word.

  Normally, you choose the proper spelling from the list. But that fixes the 
word only once. Instead:

 2. Click the AutoCorrect item.

  Up pops a submenu containing various corrections, as shown in Figure 7-3.

 3. Choose the properly spelled word from the AutoCorrect submenu.

  The word is added to the AutoCorrect list, and Word, as a special favor, 
corrects the word in your text as well.

 

Figure 7-3: 
Auto-

Correcting a 
werd.

 

Whenever your typo is encountered, Word automatically corrects it for you. 
But you must remember to use the AutoCorrect item from the spell-check-
thingy pop-up menu on your first sighting of the misspelled word rather than 
just choose the corrected word from the list.
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 If possible, try to add only lowercase words with AutoCorrect. When you add 
a word with an initial capital letter, such as Werd, AutoCorrect replaces only 
words with an initial capital letter. When you use AutoCorrect on a word that’s 
in all lowercase, the word is fixed every time.

Undoing an AutoCorrect correction
  You can reverse AutoCorrect instant changes, but only when you’re quick. The 

secret is to press Ctrl+Z (the Undo command) immediately after AutoCorrect 
makes its correction. The change is gone, but also note the blue rectangle 
under the first letter of the still-corrected word, as shown in the margin.

The AutoCorrect blue rectangle is your key to access AutoCorrect options 
and change the way AutoCorrect behaves: Point the mouse at the rectangle 
to see a button, which you can then click to see various AutoCorrect options, 
shown in Figure 7-4.

 

Figure 7-4: 
Adjusting 
an Auto-

Correction.
 

Here are your options:

 ✓ Change Back to “whatever”: Undo the AutoCorrection.

 ✓ Stop Automatically Correcting “whatever”: Remove the word from the 
AutoCorrect dictionary so that it’s not corrected automatically again. 
(But it may still be flagged as incorrect by the spell checker.)

 ✓ Control AutoCorrect Options: Display the AutoCorrect dialog box, 
which is used to customize various AutoCorrect settings and to edit 
or create new entries in the AutoCorrect library. Refer to the section 
“Control Word’s Proofing Options,” later in this chapter.

Grammar Be Good
Mark Twain once referred to spelling in the English language as “drunken.” If 
that’s true, English grammar must be a hallucination. To help you to detox, 
Word comes with a grammar checker. It’s just like having your eighth grade 
English teacher inside your computer — only it’s all the time and not just 
third period.
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Word’s grammar checker works on the fly, just like the spelling checker. The 
main difference is that words are underlined with a green, not red, zigzag 
underline. The grammar checker also flags improperly used words with a 
blue zigzag underline. Either way, you’re getting a hint of Word’s sense of 
grammatical justice, which, as I’ve written elsewhere, is merely a suggestion, 
given the illusionary nature of English grammar in the first place.

As with a spelling error, right-click the green-underlined text. The pop-up 
menu that appears either explains why the sentence is wrong or offers an 
alternative sentence you can choose. You also have an option to ignore the 
error, which I find myself using quite a bit.

 ✓ When you select About This Sentence from the pop-up menu, the Office 
Help system attempts to explain which part of the English Language 
Book of Rules you offended.

 ✓ Sometimes you may be puzzled about a word that the grammar checker 
finds wrong. Don’t give up! Always check the entire sentence for a poten-
tial error. For example, the grammar checker may suggest had in place 
of have. Chances are good that have is correct but another word in the 
sentence has an unwanted s attached.

 ✓ You can customize or even turn off grammar checking. Refer to the sec-
tion “Control Word’s Proofing Options,” later in this chapter.

All-at-Once Document Proofing
You can cheerfully ignore all of Word’s on-the-fly document proofing, and 
instead opt to do a once-over scan for spelling and grammatical errors. This 
process can take place when you’re done writing, just before printing or pub-
lishing your document. I consider it a final scan, kind of like ironing out the 
wrinkles in a freshly laundered shirt. Here’s how it works:

 1. Click the Review tab.

 2. In the Proofing group, click the Spelling & Grammar button.

  The Spelling and Grammar dialog box appears, as shown in Figure 7-5. It 
displays English language offenses one at a time, flagging the spelling or 
grammar errors as they occur in your document.

  Here’s what you can do:

 • To fix the error, edit the text in the box.

 • Use the Ignore button (or buttons) to skip the error, or click the 
Next Sentence button to continue moving through the document.

 • Choose a proper spelling from the list and then click the Change 
button.

12_487723-ch07.indd   8512_487723-ch07.indd   85 3/27/10   10:37 AM3/27/10   10:37 AM



86 Part II: Your Basic Word 

 3. Continue checking your document until Word says that you’re done.

 

Figure 7-5: 
Proofing a 
document 

one mistake 
at a time.

 

If you find this method easier, and more gentle to your spelling-challenged 
ego, you can turn off on-the-fly spelling and grammar checking. The next sec-
tion explains how to do it. If you choose that option, don’t forget to proof 
your document before you finish your work.

 ✓ You can easily enter a trancelike state while you’re document proof-
ing. You might find yourself clicking the Ignore button too quickly. My 
advice: Use the Undo button. It lets you go back and change some text 
you may not have paid attention to.

 ✓ A proofing button (an animation, actually) is on the status bar. If you 
click the button, shown in the margin, Word takes you to the next man-
gled chunk of English in your document. Using that button is another 
way to hop through and proof your document.

Control Word’s Proofing Options
All document proofing options and settings are kept in one place, buried 
deep in Word’s bosom. Here’s how to get there:

 1. Click the File tab.

 2. Choose Options from the File tab’s menu.

 3. In the Word Options window, choose Proofing from the left side.

The right side of the window contains options and settings for document 
proofing. The following sections describe what you can do there.

When you’re done working in the Word Options window, click the OK button 
to lock in whichever changes you’ve made.
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Changing spell-check and 
grammar settings
After you find yourself in the Word Options window, the Proofing corner, you 
can peruse and change the way Word reacts to your mangling of the mother 
tongue. Here are some highlights:

 ✓ To turn off on-the-fly spell checking, remove the check mark by the item 
Check Spelling As You Type.

 ✓ To disable grammar checking, remove the check mark by the item Mark 
Grammar Errors As You Type.

 ✓ Click the Settings button by the Writing Style drop-down list to custom-
ize and hone the grammatical transgressions that Word marks. (I typi-
cally disable the Fragments warning because Word is often wrong when 
flagging fragments.)

Perusing AutoCorrect options
You can click the AutoCorrect Options button in the Word Options window 
to view the AutoCorrect dialog box and its slew of automatic word-correcting 
and typo-fixing options, as shown in Figure 7-6.

 

Figure 7-6: 
Oodles of 

AutoCorrect 
options.
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Here are some things you can do:

 ✓ The AutoCorrect tab lists all problems that AutoCorrect fixes for you, 
plus common typo corrections. That’s also where you can remove the 
AutoCorrect entries you detest.

 ✓ If you don’t like how Word changes Web page addresses in your docu-
ment into real hyperlinks, remove the check mark by the option Internet 
and Network Paths with Hyperlinks on the AutoFormat tab.

 ✓ The AutoFormat tab also harbors those insidious options that automati-
cally create bulleted lists and heading styles in Word; remove the appro-
priate check marks to disable those unwanted features.

 ✓ Also refer to the AutoFormat As You Type tab to kill off additional auto-
matic numbering and bulleted list features in Word.
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Chapter 8

Documents and Such
In This Chapter
▶ Understanding files

▶ Creating a new document

▶ Saving documents

▶ Using the proper filename

▶ Updating (resaving) a document

▶ Opening a document

▶ Inserting one document inside another

▶ Closing a document

▶ Retrieving a lost document

I like the word document. It’s elegant. It’s much better than saying “a file”  
 or “that thing I created with my word processor.” It makes everything 

from a shopping list to a note excusing little Jimmy’s absence because you 
thought he might have impetigo but it turned out to be jelly stuck to his chin 
from the night before — it makes all that trivial text somehow seem more 
important.

The thing you create in Word, from a tiny note to a Pulitzer prize-winning 
autobiography, is a document. It starts off new, and then a document is saved 
for long-term storage on the PC’s mass storage system. You can also retrieve 
documents already saved, even if they’re created by other folks, and open 
them in Word for more editing, reviewing, and printing, for example.

What Is a File?
To understand documents, you must first recognize the importance of files. 
This concept is vital to grasp if you ever want your computer experience to 
be a pleasant one. In fact, most of the trouble people have with computers 
comes from not understanding what a file is.
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Your computer stores all kinds of information. In addition to storing word 
processing documents, the computer can store graphical images, music and 
video, and all sorts of things. It also stores the programs you run, games, and 
even Windows itself. Those items are all stored inside the digital container 
known as a file.

Most of what the computer does is to help you access and organize the files — 
the stuff you collect and create. Oh, I could go into a good, long diatribe about 
files and computer storage, and utterly bore you with computer science. I won’t.

 After a Word document is saved, it exists as a file. Documents are files. They 
exist as unique and separate from other items on the computer, including the 
word processor. Word is merely the device you use to create the document or 
file; Word itself is not the document.

Think of the relationship this way: A pianist uses sheet music to play a tune, 
but the sheet music isn’t part of the piano. Just as you can store or mail sheet 
music, you can store a Word document file (on an optical disc, for example) 
or send it via e-mail. The Word document that exists on your computer’s 
hard drive as a file is its own, unique thing.

 ✓ Working with files is a task you do in Windows, not in Word. That topic 
includes renaming files, deleting them, moving and copying them, as 
well as doing other nerdy things.

 ✓ For more information on understanding files as well as mass storage and 
other basic computer concepts, I highly recommend reading my book 
PCs For Dummies. The more you know about your computer, the happier 
you are as a computer user.

A New Document
When you start your word processing day, Word automatically presents you 
with a blank sheet of paper — a blank document — on which you can start 
writing. That’s what most folks do.

After Word has already started and you’re ready to begin another new docu-
ment, you summon the electronic equivalent of a fresh, blank sheet of paper. 
Here’s how to do it, to start a new document, in Word:

 1. Click the File tab.

  The Word window changes to display the File tab menu.

 2. Choose the New command from the left side of the window.

  Word lists a slew of options for starting a new document, many of which 
may appear confusing to you, which is, I believe, the program’s intent. 

13_487723-ch08.indd   9013_487723-ch08.indd   90 3/27/10   10:36 AM3/27/10   10:36 AM



91 Chapter 8: Documents and Such

What you want is the Blank Document item, which is conveniently 
chosen for you, as shown in Figure 8-1.

 

Figure 8-1: 
Plucking out 

a new 
document.

 

 3. Click the Create button to start a new, blank document.

  The Create button is found on the right side of the window, beneath that 
obnoxiously large, blank sheet of paper.

After you click the Create button (or press the Enter key), the Word window 
returns to normal and you see a blank page, ready for typing.

You can repeat these steps as often as you need new documents; Word lets 
you work with several documents at a time. See Chapter 24 for information 
on multiple-document mania.

 ✓ Ah, the shortcut: Press Ctrl+N to quickly summon a new, blank docu-
ment in Word.

 ✓ Another way to start your work is to open a document on disk. To do 
this, use the Open command from the File tab menu, covered later in 
this chapter.

 ✓ The New Document window contains numerous options for starting 
something new in Word. Rather than use the Blank Document choice, 
lots of folks use templates to start documents. Templates help save time 
by predefining document layout and formatting (and sometimes even 
text). See Chapter 16 for more information.
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Save Your Stuff!
It doesn’t matter whether you’ve written a masterpiece — the most impor-
tant thing you can do to a document is save it. Create a permanent copy of 
what you see onscreen by saving the document as a file on the PC’s storage 
system. That way, you can use the document again, keep a copy for business 
reasons, publish it electronically, or just keep the thing for sentimental rea-
sons. All those tasks require saving!

Saving a document the first time
Don’t think that you have to wait until you finish a document to save it. In 
fact, you should save almost immediately — as soon as you have a few sen-
tences or paragraphs. Save! Save! Save!

To save a document that hasn’t already been saved to disk, follow these 
steps:

 1. Click the File tab.

 2. Choose the Save As command.

  The Save As dialog box appears, similar to the one shown in Figure 8-2.

 3. Type a name for your document in the File Name box.

  Word automatically selects the first line or first several words of your 
document as a filename and puts it in the Save dialog box. If that’s okay, 
you can move to Step 4. Otherwise, type a name in the File Name box.

How big can a Word document be?
There’s no upper limit on how many pages you 
can have in your document. Theoretically, a 
Word document can be thousands of pages 
long. Even so, I don’t recommend that you make 
your documents that big.

The longer a document is in Word, the more apt 
the computer is to screw things up. So, rather 
than advise you to make a single long docu-
ment, I recommend that you split your work 

into smaller, chapter-size documents. Those 
documents can then be organized into a single 
master document in Word, where page num-
bers and references can be used as though the 
smaller documents were one larger document.

See Chapter 25 for more information on man-
aging several smaller documents into a single 
large document.
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Figure 8-2: 
The Save As 

dialog box.
 

  Be descriptive! The more concisely you name your document, the easier 
it is to recognize it by that name in the future.

 4. Choose a location for your file (optional).

  Use the various gizmos in the Save As dialog box to choose a specific 
folder for your document. (Folders are a part of file organization. My 
book PCs For Dummies explains how to use folders, if you’re unfamiliar 
with the concept.)

 5. Click the Save button.

  The file is now safely stored in the PC’s storage system.

At this point, you can keep working. As you work, continue to save; refer to 
the section “Saving or updating a document,” later in this chapter.

 ✓ There’s no need to quit after you save a document. Indeed, the idea is to 
save as you go.

 ✓ The only time you need to use the Save As dialog box is when you first 
create a document. After that, you can use the Save command merely to 
update your document, by storing the latest modifications as you write.

 ✓ Your clue that the file has been successfully saved is that the name 
you’ve given it (the filename) now appears on the document’s title bar, 
near the top of the screen.
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 ✓ Always save your document, even after you type only a few lines of text.

 ✓ The Save As command can also be used to save a document with a new 
name or to a different location on disk. 

 ✓ Some older versions of Windows use a type of Save As dialog box that’s 
different from the one shown earlier (refer to Figure 8-2). Though the 
dialog box looks different, it has the same features and is used in the 
same way.

 ✓ Do not save a document to removable media, such as an optical disc or 
memory card. Instead, save the document to the computer’s main stor-
age devices, the hard drive. Then, using Windows, copy that document 
to the removable media. Otherwise, Word may lose your document or 
the computer may crash if you remove the media before you’re done 
working on the document.

Dealing with document-save errors
Saving a document involves working with both Word and the Windows oper-
ating system. This process doubles the chances of something going wrong, 
so it’s high time for an error message. A potential message you may see is

The file whatever already exists

You have three choices:

 ✓ Replace Existing File: Nope.

 ✓ Save Change with a Different Name: Yep.

 ✓ Merge Changes into Existing File: Nope.

After choosing the middle option, type a different file name in the Save As 
dialog box.

Another common problem occurs when a message that’s displayed reads 
something like this:

The file name, location, or format ‘whatever’ is not valid 
. . .

That’s Word’s less-than-cheerful way of telling you that the filename contains 
a boo-boo character. To be safe, stick to letters, numbers, and spaces when 
you’re naming a file. Check the nearby sidebar, “Complicated — but impor-
tant — information about filenames.” Then click OK and try again.
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Saving or updating a document
Every so often as you continue to work on your document, you should save 
again. That way, any changes you’ve made since the last time you saved are 
remembered and recorded on the PC’s storage system permanently. I gener-
ally save my documents dozens of times a day, usually when the phone rings 
or when I need to step away and the cat is lurking too closely to the keyboard 
or, often, when I’m just bored.

To resave a document that has already been saved to disk, choose the Save 
command from the File tab menu. You get no feedback, and the Save As 
dialog box doesn’t show up. That’s because you’ve already given the file a 
name; the Save command merely updates the existing file on disk.

 ✓ The fastest way to save a document is to use the Ctrl+S keyboard shortcut.

  ✓ You can also click the Save icon on the Quick Access toolbar to save a 
document to disk.

 ✓ The most bizarre command for saving a document? Shift+F12. Weird.

Forgetting to save before you quit
When you’re done writing in Word, you close the document, close the 
window, or just quit Word outright. No matter how you call it quits, when the 
document hasn’t yet been saved or was changed since the last save, you’re 
asked to save again, as shown in Figure 8-3.

Complicated — but important — 
information about filenames

Word lets you be creative in your writing, but 
your creativity is limited in naming a document 
as it’s saved to disk. Here are the rules:

 ✓ A filename can be longer than 200 ridicu-
lous-something characters; even so, keep 
your filenames short but descriptive.

 ✓ A filename can include letters, numbers, 
and spaces and can start with a letter or 
number.

 ✓ A filename can contain periods, commas, 
hyphens, and even underlines.

 ✓ A filename cannot contain any of these 
characters: \ / : * ? “ < > |

Word automatically appends a filename exten-
sion to all documents you save — like a last 
name. You may or may not see this extension, 
depending on how you’ve configured Windows. 
No matter: You don’t need to manually type the 
extension yourself; just concern yourself with 
giving the document a proper and descriptive 
filename.
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Figure 8-3: 
Your last 

chance to 
save.

 

Here are your options:

Yes: The document is saved. If you’ve been bad and haven’t saved the docu-
ment even once, the Save As dialog box appears when you choose Yes. See 
the earlier section “Saving a document the first time.”

No: Don’t save the document. Any changes made since the document was 
last saved are lost, or if the document was never saved, the entire thing is 
lost forever.

Cancel: Word returns you to your document for more editing and stuff.

I recommend choosing the Yes option.

The text that appears about a temporary draft version may not show up 
every time. See the later section “Recover a Draft” for how to deal with the 
temporary draft versions of unsaved documents.

Open a Document
Saving a document to disk means nothing unless you have a way to retrieve 
it. You have several ways to open a document that was previously saved as a 
file on disk. This section mulls the possibilities.

Using the Open command
Open is the standard computer command used to fetch a document that 
already exists on the PC’s storage system. You use Open to hunt down docu-
ments that were previously saved and open them like you’re unwrapping a 
present. The document is then displayed in Word’s window as though it has 
always been there.

To grab a file from disk — to open it — follow these steps:
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 1. Choose the Open command from the File tab menu.

  The Open dialog box materializes, as shown in Figure 8-4.

 

Figure 8-4: 
The Open 

dialog box.
 

 2. Choose the document’s name with the mouse.

  The Open dialog box — vast and wild as it is — contains a list of docu-
ments previously saved to disk (refer to Figure 8-4). Your job is to find 
the one you want to open.

  Using the Open dialog box, you can examine various folders on your 
PC’s hard drive, and on any computer network your PC is connected to, 
to scour for files to open.

 3. Click the Open button.

  Word opens the highlighted file, carefully lifting it from your PC’s stor-
age system and slapping it down on the screen.

After the document is open, you can edit it, just look at it, print it, or do what-
ever you want.

 ✓ Opening a document doesn’t erase it from the PC’s storage system. In 
fact, the original copy of the file stays on the storage system until you 
use the Save command to save the document again.

 ✓ When you open a document, there’s no need to use the Save As com-
mand to save it again. Simply use the Save command (shortcut: Ctrl+S). 
That’s because the document already has a filename.
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 ✓ The shortcut key for the Open command is Ctrl+O.

 ✓ Avoid opening a file on any removable media, such as a digital memory 
card or an optical disc. Although it’s possible, it can lead to headaches 
later if you remove the media before Word is done with the document. 
Because of that, I recommend that you use Windows to copy the docu-
ment from the removable media to the PC’s hard drive. Then open it in 
Word.

Opening a document icon
  One way to work on a document is to find its icon in Windows and double-

click to open the document. Merely locate a Word document icon in any 
folder window, from the desktop, or on the Start button’s recently opened file 
list and then double-click, and Word loads that document for editing.

Accessing recently opened files
 Word remembers the last several files you’ve been working on. It keeps them 

in the Recent list on the File tab menu, as shown in Figure 8-5. Chances are 
good that you probably need to open one of them, so choosing one from the 
File tab menu is a handy way to open that document quickly.

 

Figure 8-5: 
Recently 

opened files 
on the File 
tab menu.
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Those pushpins by the document’s name allow you to permanently pin a 
document to the File tab menu. Click a pushpin to “push it in.” That makes 
the document stick around in the list. Clicking the pushpin again allows the 
document to fade away after a while.

A list of recently opened files appears in Windows 7 on a Jump List: Right-
click the Word icon on the taskbar and you see the jump list pop up; choose 
a recently opened file from that list.

Opening more than one 
document at a time
Word places no limit on the number of documents you can have open at a 
time. For example, I’m writing this chapter in one window, and I have two 
more Word documents open in other windows. If you’re like me and tend to 
work on multiple documents at a time, you can open them all by using the 
Open command. The secret is simply to select multiple documents and then 
open them.

For example, in the Open dialog box (refer to Figure 8-4), press and hold the 
Ctrl key as you click to select multiple documents to open. Click the Open 
button and they all open in their own, separate windows in Word.

Likewise, you can use the Ctrl key to select multiple Word documents in a 
folder window in Windows. Press the Enter key to instantly open all those 
documents.

Also see Chapter 24, which covers working with multiple documents in Word.

Opening one document inside another
A handy trick to pull with the Open command is to stick one document 
smack dab into the middle of another document. For example, you may have 
your biography, résumé, or curriculum vitae in a file on disk and want to add 
that information to the end of a letter begging for a job. If so, or in any other 
circumstances that I can’t think of right now, follow these steps:

 1. Position the insertion pointer where you want the other document’s 
text to appear.

  The text is inserted at that spot.

 2. Click the Insert tab.
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 3. From the Text group, choose Object➪Text from File.

  A dialog box similar to the Open dialog box opens (refer to Figure 8-4).

 4. Choose the icon representing the document you want to insert.

  You can also use the gadgets and gizmos in the dialog box to locate a 
file in another folder or on another disk drive or even on someone else’s 
computer on the network. Such power!

 5. Click the Insert button.

The document you selected is inserted into the current document, just as 
though you had typed (and formatted) the whole thing right there with your 
stubby little fingers.

 ✓ The resulting combined document still has the same name as the first 
document; the document you inserted remains unchanged.

 ✓ You can insert any number of documents into another document, one at 
a time. There’s no limit.

 ✓ Inserting text from one document into another is often called boilerplat-
ing. For example, you can save a commonly used piece of text in a docu-
ment and then insert it into other documents as necessary. This process 
is also the way sleazy romance novels are written.

 ✓ Biography. Résumé. Curriculum vitae. The more important you think you 
are, the more alien the language used to describe what you’ve done.

Close a Document
When you’re done writing a document, you need to do the electronic equiva-
lent of putting it away. That electronic equivalent is the Close command: 
Choose the Close command from the File tab menu, or use the handy Ctrl+W 
keyboard shortcut.

If you haven’t saved your document recently, Word prompts you to save 
before you close; click the Yes button and the document is saved. (If it 
hasn’t yet been saved — shame on you! — you see the Save As dialog box, as 
described earlier in this chapter).

When the document has been saved, closing it simply removes it from view. 
At that point, you can quit Word, start up a new document, open a document 
on disk, or just put away Word and hit another game of Spider Solitaire.
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 ✓ Refer to Chapter 1 for more quitting options.

 ✓ You don’t have to choose the Close command. You can choose the 
Exit command from the File tab menu if you’re done with Word, which 
is almost the same thing: You’re prompted to save your document if 
it needs saving; otherwise, the Exit Word command quits Word rather 
than keeps the window open.

 ✓ You can also just close the Word program window, which closes the 
document. When you close the last open Word program window, you 
also quit Word.

Recover a Draft
Computers crash. Users forget to save in a pinch. Or, perhaps some other 
type of disaster has befallen your unsaved Word document. When the planets 
are properly aligned and the word processing gods are smiling, it’s possible 
to recover those lost documents, the ones that Word calls drafts. Here’s how:

 1. Click the File tab.

 2. Choose Recent from the list.

  You see the list of recent documents (refer to Figure 8-5). When unsaved 
drafts are available, you see a link at the bottom of the list: Recover 
Unsaved Documents.

 3. Click the link Recover Unsaved Documents.

  An Open dialog box appears.

 4. Choose from the list a document to recover.

  The document may have an unusual name, especially when it has never 
been saved.

 5. Click the Open button to open and recover the document.

The document you recover might not be the one you wanted it to be. If so, 
try again and choose another document. You might also find that the docu-
ment doesn’t contain all the text you typed or thought would be there. You 
can’t do anything about it, other than remember to save everything in the first 
place!

 The recovery of drafts is possible because of Word’s AutoRecover feature. 
Refer to Chapter 31 for more information on AutoRecover.
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Chapter 9

Publish Your Document
In This Chapter
▶ Getting the printer ready to print

▶ Previewing your document before printing

▶ Printing a specific part of a document

▶ Printing multiple copies of a document

▶ Using another printer

▶ Canceling the Print command

▶ Checking document compatibility

▶ Sending a document as an attachment

▶ Making a document compatible for sharing

▶ Creating a PDF document

A long time ago, the final step in creating a document with a word pro
 cessor was printing. After writing, editing, formatting, and proofing 

(with lots of document-saving along the way), you printed your masterpiece 
to show the world. The process was simply called “printing” because there 
was little else you could do with the document after you were done working 
on it. Times have changed.

Today, the final step in the word processing saga is publishing. No, it doesn’t 
mean that you need to get an agent or shop your book to big New York pub-
lishers or face a slew of rejection letters. Publishing a Word document means 
printing, but it also includes other electronic ways of sharing your document: 
sending it by e-mail, posting it to a Web site, sticking it on a blog somewhere, 
or even good ol’ printing. It’s all publishing.

Your Document on Paper
Getting it down on paper has been the goal of writers ever since paper was 
invented. The word processor, the best writing tool ever invented, is also the 
first tool to utterly avoid paper. You can change that situation, however, by 
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using the most traditional method to publish your document: Print it. You 
use a printer, either attached directly to your computer or available on a net-
work, to create a hard copy of your document. You can use a thousand-dollar 
computer to accomplish what anyone else can do with a little ink and some 
paper.

Preparing the printer
Before you print a document, I recommend following these steps to ensure 
that the printer is ready to print something:

 1. Make sure that your printer is plugged in and properly connected to 
your computer.

  Refer to my book PCs For Dummies for more information on connecting 
and using a printer and using various printer tips and stuff like that.

 2. Make sure that your laser printer has enough toner or that your ink 
printer’s cartridges are brimming with ink.

  Laser printers should have a good toner cartridge installed. If the laser 
printer’s Toner Low indicator is on, replace the toner at once.

  Most ink printers let you know when they’re out of ink, or you notice 
that the image appears streaked or faded or is missing information. 
Replace the ink cartridge at once.

 3. Check the printer for paper.

  The paper can feed from the back or top or enter from a paper tray, or 
it can be manually fed one sheet at a time. However your printer eats 
paper, make sure that you have it properly stocked before you print.

 4. Turn on the printer.

  You can try to print with the printer turned off, but it takes quite a long 
time.

 5. Your printer must be online or selected before you can print 
anything.

  This is weird: Some printers can be on but not ready to print. The power 
is on, but unless the printer is online or selected, it ignores the com-
puter. To force those types of printers to listen to the computer, you 
must press the Online, Ready, or Select (or similar) button.

When you’re certain that the printer is up to the task, you can proceed with 
the printing operation in Word.
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Previewing a document
Before you print, I recommend previewing the look of the final document. 
Yeah, even though the material you’ve written is supposed to look the same 
on the screen as it does on the paper, you may still see surprises: missing 
page numbers, blank pages, or half pages, for example. The best way to find 
those surprises before printing is to peruse your document in Full Screen 
Reading view.

  To get into Full Screen Reading view, click the Full Screen Reading button 
found on the taskbar (and shown in the margin). The screen changes to show 
your document, as depicted in Figure 9-1.

 

Figure 9-1: 
Previewing 

your 
document.

 

Print Page back Close windowPage forward

Page back Page forward

Take note of how your text looks on the page. Look at the margins. If you’re 
using footnotes, headers, or footers, look at how they lay out. The idea is to 
spot something dreadfully wrong before you print.

14_487723-ch09.indd   10514_487723-ch09.indd   105 3/27/10   10:37 AM3/27/10   10:37 AM



106 Part II: Your Basic Word 

Click the Close button when you finish perusing and previewing your 
document.

 ✓ Though you can edit and do other things in Full Screen Reading view, I 
recommend that you switch back to either Print Layout or Draft view for 
editing; click the appropriate button on the status bar.

 ✓ Use the View Options button (refer to Figure 9-1) to control how your 
document appears in Full Screen Reading view.

 ✓ The Zoom tool on the status bar can also be used to zoom in or out. In 
fact, you can zoom out to where you see the entire document displayed 
as tiny pages on the screen.

 ✓ Sideways printing, paper sizes, and other document-related options are 
set when you format your document’s pages. These are Word functions, 
not ones you set when you print. Refer to Chapter 13.

Printing the whole document
Printing the document is easy to do:

 1. Make sure that the printer is on and ready to print.

 2. Save your document.

  Ha! Surprised you. Saving before you print is always a good idea. Click 
the little Save button on the Quick Access toolbar for a quickie save.

 3. Click the File tab.

 4. Choose the Print command from the File tab’s window.

  You see the document previewed in the File tab window, as shown in 
Figure 9-2. That’s the Print Settings window, and the various interesting 
items available in that window are pointed out in the figure.

 5. Click the Print button.

  The File tab window closes and the document spews from your printer.

Printing may take some time — a long time. Fortunately, you can continue 
working while the document prints.

 ✓ The keyboard shortcut to display the Print window (refer to Figure 9-2) 
is Ctrl+P.

 ✓ If nothing prints, don’t use the Print command again! There’s probably 
nothing awry; the computer is still thinking or sending information to 
the printer. If you don’t see an error message, everything will probably 
print, eventually.
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 ✓ The computer prints one copy of your document for every Print com-
mand you incant. If the printer is just being slow and you impatiently 
click the Print button ten times, you print ten copies of your document. 
(See the section “Canceling a print job,” later in this chapter.)

 ✓ Information on printing only a page or block or another part of a docu-
ment, is found in the next several sections.

 ✓ When your document is formatted using a unique paper size, the printer 
may prompt you to load that paper size. Printing on paper of different 
sizes is a printer-specific function, not something that Word does. But 
you set the paper size in Word as part of the page formatting. Refer to 
Chapter 13.

 ✓ Manual-feed printers beg for paper before they can print. The printer 
may say “Feed me paper!” or the ever-popular “PC Load Letter.” Like 
a dutiful mother, you must comply: Stand by the printer, line up the 
paper, and shove it into the printer’s gaping maw until your document 
has finished printing. Fortunately, there’s no need to burp the printer 
after manually feeding it paper.

 ✓ Aside from saving your document, you may consider proofreading it 
before you print. See Chapter 7.

 

Figure 9-2: 
The Print 
Settings 
window.

 

Print the document

Number of copies Document previewChoose printer

Set pages
to print

Page through
preview

Zoom document
preview
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Printing a specific page
Follow these steps to print only one page of your document:

 1. Move the insertion pointer so that it’s sitting somewhere on the page 
you want to print.

  Check the page number on the status bar to ensure that you’re on the 
right page.

 2. Choose the Print command from the File tab menu or press Ctrl+P.

 3. Click the button beneath the Settings heading and choose Current 
Page from the menu.

  The button is illustrated in Figure 9-2.

 4. Click the Print button.

The single page prints with all the formatting you applied, including foot-
notes and page numbers and everything else, just as though you plucked that 
page from a complete printing of the entire document.

 Printing a single page in this manner is useful for when you goof up (or the 
printer goofs up) one page in a document and you need to reprint only that 
page. Printing only a single page doesn’t waste paper.

Printing a range of pages
Word enables you to print a range of pages, odd pages, even pages, or a 
hodgepodge combination of random pages from within your document. To 
print a range or group of pages, summon the Printing window by choosing 
the Print command from the File tab menu.

Deleting that extra blank page at 
the end of a document

Occasionally, you may be surprised when your 
document prints and has one extra page — a 
blank page. And, it bothers you because you 
cannot get rid of it! Until now:

To remove the ugly blank page that often roots 
at the end of your document, press Ctrl+End. 

With the insertion pointer at the end of your 
document, keep pressing the Backspace key 
until the extra page is gone. How can you tell? 
Keep an eye on the total page count on the 
status bar. When that page count decreases by 
one, you know that the extra page is gone.
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Your key to printing a range (or hodgepodge) of pages is the Print What 
button (refer to Figure 9-2).

To print various pages, choose the command Print Custom Range from the 
button just beneath the Settings heading (refer to Figure 9-2). Then use the 
Pages text box to input the pages you want to print. For example:

To print pages 3 through 5, for example, type 3-5.

To print pages 1 through 7, type 1-7.

To print pages 2 and 6, type 2,6.

To print page 3, pages 5 through 9, pages 15 through 17, and page 19 
(boy, that coffee went everywhere, didn’t it?), you type 3, 5-9, 15-17, 19.

Click the big Print button when you’re ready to print. Only the pages you 
specify churn from the printer.

Printing a block
After you mark a block of text onscreen, you can beg the Print command to 
print only that block. Here’s how:

 1. Mark the block of text you want to print.

  See Chapter 6 for all the block-marking instructions in the world.

 2. Choose the Print command from the File tab menu.

 3. From the button beneath the Settings heading, choose the item Print 
Selection.

  The Print Selection item is available only when a block is selected in 
your document.

 4. Click the Print button.

The block you selected prints at the same position, with the same formatting 
(headers and footers) as though you had printed the entire document.

Printing more than one copy of something
Imagine how silly it would be to send your résumé to a company but add that 
you need your résumé returned because you have only one copy. No, I’m not 
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trying to convince you that buying a photocopier is necessary. Why do that 
when Word can easily print multiple copies of any document? Here’s how:

 1. Choose the Print command from the File tab menu.

 2. Enter the number of copies in the Copies box.

  For three copies, for example, click the box and type 3.

 3. Click the big Print button to print your copies.

Under normal circumstances, Word prints each copy of the document one 
after the other. This process is known as collating. However, if you’re printing 
seven copies of a document and you want Word to print seven copies of page 
1 and then seven copies of page 2 (and so on), choose the option Uncollated 
from the Collated menu button, found under the Settings heading in the Print 
Settings window.

Choosing another printer
Your computer can have more than one printer attached. Even small offices 
and home offices have computers networked and sharing printers. In any 
case, you can use the Print Settings window in Word to choose which printer 
to use to print your document.

In the Print Settings window, choose a different printer from the Printer but-
ton’s drop-down menu. A list of available printers appears; simply choose a 
printer from the list. Make other settings in the window as well, and then click 
the big Print button. Your document prints on the printer you’ve chosen.

 ✓ Yes, you also should check to ensure that the printer you’ve chosen is 
on, selected, stocked with paper, and ready to print.

 ✓ Setting up or adding printers is a task you do in Windows, not in Word.

 ✓ Faxing works just like printing, although you’re printing to a fax machine 
over a phone line. In Word, simply choose the fax printer from the list of 
printers. (You install a fax printer in Windows, not in Word.)

 ✓ For more information on printing and faxing, I recommend my book PCs 
For Dummies.

Canceling a print job
Because you might need to quickly cancel your printing, here goes:

  1. Double-click the li’l printer icon by the current time on the taskbar.
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  That little icon appears whenever you print something in Windows. 
When you open the icon, the printer’s window is displayed. It lists any 
documents waiting to be printed, as shown in Figure 9-3.

 

Figure 9-3: 
The printer 

queue.
 

 2. Click the name of your Word document job on the list.

 3. Choose Document➪Cancel.

  The command may be Document➪Cancel Printing in some versions of 
Windows.

 4. Click Yes to terminate the job.

  The command may be named OK in some versions of Windows.

 5. Close the printer’s window when you’re done.

  Choose Printer➪Close to make the window run away from the desktop. 
You’re zapped back to Word, ready for more editing action.

Note that it may take a while for the printer to stop printing. That’s because 
the printer has its own memory and a few pages of the document may be 
stored there and continue to print even after you tell the printer to stop. 
(Stupid printer — stupid.)

 ✓ Stopping a print job is a Windows task, not anything that Word has con-
trol over.

 ✓ If you’re using a network printer, you may not be able to cancel printing. 
Oh, well.

 ✓ You can use your printer’s window (refer to Figure 9-3) to cancel more 
jobs if you’re in an especially vicious mood: Just repeat Steps 2 through 
4 for each job you want to sack.

 ✓ To cancel all documents (the printer jobs) waiting to print, choose 
Printer➪Cancel All Documents.

 ✓ Many printers feature a Cancel button. It may have the word Cancel 
on it, or it might just be a big red button or a button with a red X on it. 
Pressing that button does, after a spell, stop printing. In fact, if your 
printer has that button, follow the steps in this section first and then 
click the Cancel button on the printer.
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Electronic Publishing
Mr. Bunny likes to live in the forest. It’s his home. The forest is full of trees 
and friendly critters. It’s also home to predators who would love to eat Mr. 
Bunny, but that’s not my point. My point is that you can do your part to help 
save Mr. Bunny’s home by publishing your documents electronically. Keep 
that statement in mind: It’s not always necessary to print your documents.

Preparing a document for sharing
There are lots of interesting things you might have put in your Word docu-
ment that you don’t want published. Those items include comments, revi-
sion marks, hidden text, and other items useful to you or your collaborators, 
which would mess up a document you share with others. The solution is to 
use Word’s Check for Issues tool, like this:

 1. Ensure that your document is finished, finalized, and saved.

 2. Click the File tab.

  In the File tab window, the Info area should be highlighted. If not, click 
the word Info.

 3. Click the Check For Issues button.

 4. Choose Inspect Document from the Check for Issues button menu.

  The Document Inspector window shows up. All items are checked.

 5. Click the Inspect button.

  After a few moments, the Document Inspector window shows up 
again, listing any issues, as shown in Figure 9-4. The issues shown are 
explained, which allows you to cancel out of the Document Inspector to 
fix individual items.

 6. Click the Remove All button next to any issues you want to clear up.

  Remember that this step is entirely optional. Now that you know what 
the issues are, you can always click the Close button and return to your 
document to manually inspect them.

 7. Click the Close button, or click Reinspect to give your document 
another once-over.

 8. Click the Back button to return to your document.

You can go forward with publishing your document or just continue working.
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Figure 9-4: 
Your 

document is 
inspected.

 

Sending a Word document by e-mail
E-mailing your Word document is a snap — as long as you’re using Microsoft 
Outlook as your e-mail program. That opening statement also implies that 
your organization uses an “Exchange Server.” If that’s you, great — you can 
follow these steps to e-mail your document:

 1. Save your document one more time.

 2. Click the File tab.

 3. Choose the Share command.

 4. Choose Send Using E-Mail.

 5. Click the Send As Attachment button.

  At this point, Outlook takes over and you compose your e-mail message. 
When you send the message, your Word document is sent along as well.

If you don’t use Outlook (and I don’t blame you), you can always send a Word 
document just as you send any e-mail file attachment. The key is to save the 
document and remember its filename and location so that you can find it 
later. To attach a Word document to an e-mail message using just about any 
e-mail program, follow these general steps:

 1. Compose your e-mail message as you normally do.

 2. Use the Attach command to find the Word document and attach it to 
the message.
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 3. Send the message.

Also see the following section.

Saving a Word document 
in a sharable format
Not everyone can read Word documents. In fact, users of older versions of 
Word might not be able to read the Word documents you create in Word 
2010. To ensure that the files are compatible, you can publish your docu-
ments in a more compatible or universal file format. Obey these steps:

 1. Finish your document.

  Yes, that includes saving it one last time.

 2. Click the File tab.

 3. Choose the Share command from the File tab menu.

 4. Choose Change File Type.

  Use the options in the Save Document list to save your document using 
another file type, one that would be more compatible than Word’s own 
document file format. Here are my suggestions:

  Word 97-2003 Document (*.doc): This is the most compatible Word file 
format, ideal for sharing your documents with anyone who has Word. 
Even Macintosh users can read Word documents saved in this file 
format.

  Rich Text Format (*.rtf): This file format is compatible with every word 
processing program now available. In fact, RTF was created so that doc-
uments can be shared between different computers and programs.

  Single File Web Page (*.mht, *.mhtml): You’re basically creating a Web 
page document in Word. Almost anyone with a Web browser, which is 
just about everyone who uses a computer, can read documents saved in 
this format.

 5. Use the Save As dialog box to save your document in the special file 
format.

  You can, if you want, change the document’s filename and location. The 
Save As Type area of the Save As dialog box has preselected the file type 
you’ve chosen.

 6. Click the Save button to save your document.

The document is now saved using the new file type. It’s ready for sharing on 
the Internet, as a Web page attachment or however you need to get it out 
there.
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 ✓ You can save the document in plain-text format in Step 4: Choose the 
option Plain Text (*.txt). Even so, rarely does anyone use the plain-text 
format any more. That format stores no formatting, no fonts, no images. 
It’s just plain old text, but the option is there in case you’re requested to 
save a document that way.

 ✓ After saving a document in the new file format, you will have changed 
the document’s filename in Word. Check the window’s title bar to con-
firm. To continue editing the original document, you need to close the 
current document and then reopen that original document.

 ✓ Yes, it’s okay to save the document using the same filename as Word 
originally chose. That’s because the file type is different; two files can 
share the same name as long as they are of different types.

 ✓ Also see Chapter 24 for more information on using and sharing docu-
ments with unusual file formats.

Saving a Word document as a PDF
Another common file format is PDF, the Adobe Acrobat Portable Document 
Format. It’s quite popular, especially on the Internet. Word lets you publish 
PDF documents easily by following these steps:

 1. From the File tab menu, choose the Share command.

 2. Choose the option Create PDF/XPS Document.

 3. Click the big button labeled Create a PDF/XPS.

  The Publish As PDF or XPS dialog box appears.

 4. If necessary, choose PDF (*.pdf) from the Save As Type drop-down list.

  You could also choose the XPS file format but, honestly, no one uses it.

 5. Give your document a new filename, if you want, or specify a new 
location for saving the PDF file.

 6. Click the Publish button to create the PDF file.

The document is saved as a PDF file, and then an Adobe Acrobat window 
opens to display the document.

 ✓ Unlike saving your document in another file format, saving it as a PDF 
doesn’t change the document’s name in Word. (See the preceding section.)

 ✓ You need a copy of the Adobe Reader program to view PDF files. Don’t 
worry: It’s free. Go to www.adobe.com/acrobat.
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In this part . . .

It all began a long time ago, when someone decided to 
scratch a line beneath a word or two. I’m sure whoever 

did it was making a point. He added emphasis, but in real-
ity he launched the vast and encompassing topic of text 
formatting. O what hath he wrought!

Part of composing text is formatting the text. You can for-
mat characters, paragraphs, margins, tabs, pages, and 
entire documents. There’s so much to do, in fact, that 
some people spend more time on formatting than they do 
on writing. I suppose they think that as long as the docu-
ment looks good, who cares what they have to say?
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Chapter 10

Character Formatting
In This Chapter
▶ Understanding text formatting

▶ Choosing a font

▶ Applying basic text formats

▶ Changing text size

▶ Adding color to your words

▶ Exploring the Font dialog box

▶ Changing text case

▶ Undoing text formatting

Just as your body is composed of millions of cells, documents are com-
posed of thousands of characters. Like a cell, a character is the basic 

building block of the document. Characters include letters, symbols, and 
Aunt Eunice, who claims to talk with squirrels and even knits sweaters for 
them.

The most basic element you can format in a document is text — the letters, 
numbers, and characters you type. You can format text to be bold, under-
lined, italicized, little, or big or in different fonts or colors — all sorts of 
pretty and distracting attributes. Word gives you a magnificent amount of 
control over the appearance of your text. This chapter contains the details.

How to Format Characters
You can change the format of your text in two ways:

 ✓ Choose a text-formatting command first, and then type the text. All the 
text you type is formatted as chosen.

 ✓ Type the text first and then select the text as a block and apply the 
formatting. This technique works best when you’re busy with a thought 
and need to return to format the text later.
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You use both methods as you compose text in your document. Sometimes, 
it’s easier to use a formatting command and type the text in that format. For 
example:

 1. Type this line:

The cake was

 2. Press Ctrl+I to activate italic text.

 3. Type this word:

really

 4. Press Ctrl+I again, which turns off italic.

 5. Continue typing:

disgusting.

The final sentence looks like this:

The cake was really disgusting.

For more complex formatting, type the text first, go back, mark the text as a 
block, and then apply the formatting. Even so, either way works.

See Chapter 6 for more information on marking blocks of text.

Basic Character Formatting
Word stores some of the most common text-formatting commands on the 
Home tab, in the Font group, as shown in Figure 10-1. The command buttons 
in that group carry out most of the basic text formatting you use in Word. 
This section mulls over the possibilities.

 ✓ Text can also be formatted by using the Mini toolbar, which appears 
whenever you select text. Refer to Chapter 6.

 ✓ The Font group can help you quickly determine which formatting is 
applied to your text. For example, in Figure 10-1, the text where the 
insertion pointer is blinking is formatted in the Calibri font. The number 
11 tells you that the text is 11 points tall. If the B button were high-
lighted, you would also know that the text was formatted in bold. (These 
text formats are discussed throughout this section.)
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Figure 10-1: 
Text-

formatting 
gizmos.

 

Changing the font
The most basic attribute of text is its typeface, or font. The font sets up the 
way your text looks — its overall text style. Although deciding on a proper 
font may be agonizing, and indeed many graphic artists are paid well to 
choose just the right font, the task of selecting a font in Word is quite easy. It 
generally goes like this:

 1. On the Home tab, in the Font group, click the down arrow to display 
the Font Face list.

  A menu of font options appears, as shown in Figure 10-2.

 

Figure 10-2: 
The Fonts 

list.
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  The top part of the menu shows fonts associated with the document 
theme. The next section contains fonts you’ve chosen recently, which 
is handy for reusing fonts. The rest of the list, which can be quite long, 
shows all fonts in Windows that are available to Word.

 2. Scroll to the font you want.

  The fonts in the All Fonts part of the list are displayed in alphabetical 
order as well as in context (as they appear when printed).

 3. Click to select a font.

 You can also use the Font menu to preview the look of fonts. Scroll through 
the list to see which fonts are available and how they may look. As you move 
the mouse over a font, any selected text in your document is visually updated 
to show how that text would look in that font. (Note that no changes are made 
until you select the new font.)

 ✓ When no font is displayed in the Font group (the listing is blank), it 
means that more than one font is being used in the selected block of 
text.

 ✓ You can quickly scroll to a specific part of the menu by typing the first 
letter of the font you need, such as T for Times New Roman.

 ✓ Graphic designers prefer to use two fonts in a document — one for the 
text and one for headings and titles. Word is configured this way as well. 
The font you see with Body after its name is the current text, or body, 
font. The font marked as Heading is used for headings. These two fonts 
are part of the document theme.

 ✓ Refer to Chapter 16 for more information on document themes.

 ✓ Fonts are the responsibility of Windows, not Word. Thousands of fonts 
are available for Windows, and they work in all Windows applications.

Applying character formats
The Font group lists some of the most common character formats. They’re 
applied in addition to the font. In fact, they enhance the font. Use them as 
you see fit:

  To make text bold, press Ctrl+B or click the Bold command button.

Use bold to make text stand out on a page — for titles and captions or when 
you’re uncontrollably angry.

  To make text italic, press Ctrl+I or click the Italic command button.

Italic has replaced underlining as the preferred text-emphasis format. 
Italicized text is light and wispy, poetic and free.
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  Underline text by pressing Ctrl+U or click the Underline command button. 
You can click the down arrow next to the Underline command button to 
choose from a variety of underline styles or set an underline color.

  Strike through text by clicking the Strikethrough command button. (There’s 
no keyboard shortcut for this one.)

I don’t know why strikethrough text made it to the Font group. If I were king 
of Microsoft, I would have put small caps up there instead. But, who am I? 
Strikethrough is commonly used in legal documents, and when you mean to 
say something but then change your mind think of something better to say.

  Make text subscript by pressing Ctrl+= (equal) or clicking the Subscript com-
mand button.

Subscript text appears below the baseline, such as the 2 in H2O. Again, I’m 
puzzled about how this formatting command ranks up there with bold and 
italic. I suppose that there’s a lot of subscripting going on somewhere.

  Make text superscript by pressing Ctrl+Shift+= (equal sign) or clicking the 
Superscript command button.

Superscript text appears above the line, such as the 10 in 210.

More text formats are available in Word, such as small caps, outline, and 
shadow. These can be accessed from the Font dialog box. Refer to the sec-
tion “Text Formatting with the Font Dialog Box,” later in this chapter.

 ✓ Basic character formatting affects only selected text or any new text you type.

 ✓ To turn off a text attribute, use the command again. For example, press 
Ctrl+I to type in italic. Then press Ctrl+I again to return to normal text.

 ✓ You can mix and match character formats. For example, press Ctrl+B 
and then Ctrl+I to apply bold and italic text. You press Ctrl+B and Ctrl+I, 
or the command buttons, to turn off those attributes again.

 ✓ The best way to use superscript or subscript is to write text first. Then 
go back, mark as a block the text you want to superscript or subscript, 
and then use these commands. So 42 becomes 42 and CnH2n+1OH 
becomes CnH2n+1OH. Otherwise, when you apply super- or subscript, 
the text you modify tends to be rather teensy and hard to edit. Better to 
write it first and then format.

 ✓ If you can remember that Ctrl+= adds subscript, just press the Shift key 
to apply Ctrl+Shift+= for superscript — if you can remember.

 ✓ When will the Underline text attribute die? I’m baffled. Honestly, I think 
we’re waiting for the last typewriter-clutching librarian from the 1950s 
to pass on before underlining is officially gone as a text attribute. And 
please don’t fall prey to the old rule about underlining book titles. It’s 
Crime and Punishment, not Crime and Punishment.
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Using less-common character attributes
Here are a few more text attributes: Call them second-string players. You may 
not use these as often as bold or italics, but Word makes them available to 
you just as well:

To switch to all caps text, press Ctrl+Shift+A. This is a text format, not 
applied by pressing the Shift or Caps Lock key. In fact, like other formats, it 
can be removed.

To set double-underlined text, press Ctrl+Shift+D. This text is double-underlined.

You create hidden text by pressing Ctrl+Shift+H. Hidden text is good for 
what it says — hiding text in a document. Of course, you don’t see the text 
onscreen, either. To show hidden text, click the Show/Hide command button 
(in the Paragraph Group on the Write tab) as described in Chapter 2, in the 
section about spots and clutter in your text. The hidden text shows up in the 
document with a dotted underline.

To get small caps, press Ctrl+Shift+K. Small caps is ideal for headings. I use it 
for character names when I write a script or play:

Bill. That’s a clever way to smuggle a live grenade into prison.

To underline just words, and not the spaces between words, press 
Ctrl+Shift+W. Word underline looks like this.

Text Transcending Teeny to Titanic
Text size is considered a text format in Word. You can choose the size of 
your text, from indecipherably small to monstrously huge. Of course, more 
common is the subtle text-size adjustment; rare is the student who hasn’t 
fudged the length of a term paper by inching up the text size a notch or two.

Understanding points
Word (and Windows) deals with text size as measured in points. It’s a typeset-
ting term. One point is equal to 1⁄72 inch. Don’t bother memorizing it. Instead, 
here are some point pointers:

 ✓ The bigger the point size, the larger the text.

 ✓ Most printed text is either 10 or 12 points tall.
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 ✓ Headings are typically 14 to 24 points tall.

 ✓ Most fonts can be sized from 1 point to 1,638 points. Point sizes smaller 
than 6 are generally too small for a human to read.

 ✓ Seventy-two points is equal (roughly) to 1-inch-high letters.

 ✓ The point size of text is a measure from the bottom of the descender 
to the top of the ascender — from the bottom of the lowercase p to the 
top of the capital E, for example. So, the typical letter in a font is smaller 
than its given font size. In fact, depending on the font design, text for-
matted at the same size but with different fonts (typefaces) may not 
appear to be the same size. That’s just one of those typesetting oddities 
that causes regular computer users to start binge drinking.

Setting the text size
Text size is set in the Font group on the Home tab. Just to the right of the 
Font box is the Size box (refer to Figure 10-1). Clicking the down arrow dis-
plays a list of font sizes for your text, as shown in Figure 10-3.

 

Figure 10-3: 
Select a font 

size from 
this list.

 

The Size menu lists only common text sizes. To set the text size to a value 
that isn’t listed or to a specific value, type the value into the box. For exam-
ple, to set the font size to 11.5, click in the Size box and type 11.5.

 You can preview the new text size by pointing the mouse at an item on the 
Size menu. The word under the insertion pointer, or a selected block of text, is 
updated on the screen to reflect the new size. Click to choose a size or press 
Esc to cancel.
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Nudging text size
Sometimes, choosing text size is like hanging a picture: To make the picture 
level on the wall, you have to nudge it just a little bit this way and that. Word 
has similar tools for nudging the text size larger or smaller, two of which are 
found in the Font group.

  To increase the font size, click the Grow Font command button or press 
Ctrl+Shift+>.

The Grow Font command nudges the font size up to the next value as listed 
on the Size menu (refer to Figure 10-3). So, if the text is 12 points, the Grow 
Font command increases its size to 14 points.

  To decrease the font size, click the Shrink Font command button or press 
Ctrl+Shift+<.

The Shrink Font command works in the opposite direction of the Grow Font 
command, by reducing the text size to the next-lower value as displayed on 
the Size menu (refer to Figure 10-3).

I remember the Grow and Shrink keyboard commands easily because the 
greater-than symbol is > and the less-than symbol is <. Just think, “I’m making 
my text greater than its current size” when you press Ctrl+Shift+> or “I’m 
making my text less than its current size” when you press Ctrl+Shift+<.

 When you want to increase or decrease the font size by smaller increments, 
use these shortcut keys:

Ctrl+] Makes text one point size larger

Ctrl+[ Makes text one point size smaller

More Colorful Characters
Adding color to your text doesn’t make your writing more colorful. All it does 
is make you wish that you had more color ink when it’s time to print your 
document. Regardless, you can splash around color on your text and there’s 
no need to place a drop cloth in the document’s footer.

  Text color is applied by clicking the Font Color command button. The bar 
below the A on the Font Color command button indicates which color is 
applied to text.
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To change the color, you must click the menu arrow just to the right of the 
Font Color command button. A color menu appears, as shown in Figure 10-4; 
as you move the mouse pointer over various colors, selected text in your 
document is updated to reflect that color. When you find the color you like, 
click it. That color then becomes the new text color associated with the Font 
Color command button.

 

Figure 10-4: 
Selecting a 

color 
for text.

 

 ✓ Theme colors are associated with the document theme. Refer to 
Chapter 16.

 ✓ Select the More Colors item to display the special Colors dialog box. Use 
the dialog box to craft your own, custom colors.

 ✓ The Automatic color refers to the color defined for the text style you’re 
using. Refer to Chapter 15 for more information on styles.

 ✓ The Font Color command affects only the text color, not the back-
ground. To color the background, you use the Shading command, cov-
ered in Chapter 18.

 ✓ Colored text prints only when a color printer is available and readily 
stocked with color ink. Refer to Chapter 9 for more information on print-
ing documents.

 ✓ Be careful with the colors you use! Faint colors can make your text 
extremely difficult to read. Choose your text color wisely.

 ✓ Be careful not to confuse the Font Color command button with the Text 
Highlight Color command button, to its left. Text highlighting is a text 
attribute, but it’s best used for document markup. See Chapter 26.

Text Formatting with the Font Dialog Box
Word has a place where all your font-formatting delights are kept in a neatly 
organized fashion. It’s the Font dialog box, shown in Figure 10-5.
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Figure 10-5: 
The neatly 
organized 

Font dialog 
box.

 

To summon the Font dialog box, click the Dialog Box Launcher button in the 
lower-right corner of the Font group or press Ctrl+D.

The Font dialog box contains all the commands for formatting text, including 
quite a few that didn’t find their way into the Font group. As with all text for-
matting, the commands you choose in the Font dialog box affect any new text 
you type or any selected text in your document.

When you’re done setting up your font stuff, click the OK button. Or, click 
Cancel if you’re just visiting.

 ✓ The best benefit of the Font dialog box is the Preview window, at the 
bottom. That window shows you exactly how your choices affect text in 
your document.

 ✓ The Font names +Body and +Heading refer to the fonts selected by the 
current document theme. This is done so that you can use Word’s 
theme commands to quickly change body and heading fonts for an 
entire document all at one time.

 ✓ Use the festive attributes — such as Shadow, Outline, Emboss, or 
Engrave — for titles and headings.

 ✓ You can use the Advanced tab in the Font dialog box to set options for 
changing the size and position of text on a line.

 ✓ The Font dialog box can also be accessed from the Find dialog box or 
the Find and Replace dialog box. This feature helps you to search for, or 
search and replace, specific text formatting in a document.
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 ✓ You can mark all similar text formatting in a document as a block by 
right-clicking a bit of text and choosing Styles➪Select Text with Similar 
Formatting. That way, you can universally change similar text in a docu-
ment without doing a search-and-replace for text formats. Also see 
Chapter 6 for more block-marking information.

 ✓ The Set As Default button in the Font dialog box is used to change the 
font that Word uses when you’re creating a new document. If you prefer 
to use a specific font for all your documents, choose the font (plus other 
text attributes) in the Font dialog box and then click the Set As Default 
button. Click the Yes button to answer the question about changing the 
Normal template. Afterward, all documents start with the new default 
font you’ve selected.

Changing Text Case
Believe it or not, upper- and lowercase have something to do with a font. 
Back in the old days of mechanical type, a font came in a case, like a brief-
case. The top part of the case, the upper case, held the capital letters. The 
bottom part of the case held the non-capital letters. So, in a way, changing 
the case of text is a font-formatting trick.

  To change the case of text in Word, use the Change Case command button in 
the Font group. Choosing that button displays a menu of options, shown in 
Figure 10-6. Select the text you want to change, and then choose the proper 
item from the Change Case command button. Your text is modified to match 
the menu item that’s selected.

 

Figure 10-6: 
Change 

Case com-
mand button 

menu.
 

 You can also use the Shift+F3 command to change the case of selected text. 
But that keyboard shortcut cycles between only three of the menu options 
shown in the figure: ALL CAPS, lowercase, and Capitalize Each Word.

16_487723-ch10.indd   12916_487723-ch10.indd   129 3/27/10   10:44 AM3/27/10   10:44 AM



130 Part III: Formatting 

Removing Character Formatting
So many Word formatting commands are available that it’s possible for your 
text to look more like a pile of formatting remnants than anything readable in 
any human language. Word understands this problem, so it created the Clear 
Formatting command to let you peel away all formats from your text, just like 
you peel the skin from a banana:

  To peel away formatting from a block of selected text, or the text the inser-
tion pointer is on, or future text you type, use the Clear Formatting command 
button in the Font group or press Ctrl+spacebar.

The Clear Formatting command removes any formats you’ve applied to the 
text: font, size, text attributes (bold or italic), and color.

 ✓ Another key combination for Ctrl+spacebar is Ctrl+Shift+Z. Remember 
that Ctrl+Z is the Undo command. To undo formatting, all you do is add 
the Shift key, which may make sense — well, heck, if any of this makes 
sense.

 ✓ The Clear Formatting command removes the ALL CAPS text format but 
doesn’t change the case of text you’ve created by using Shift, Caps Lock, 
or the Change Case command in Word.

 ✓ Technically, the Ctrl+spacebar command restores characters to the for-
matting defined by the style you’re using. So, if the Body style is 12-point 
Calibri, pressing Ctrl+spacebar restores that font and size. Don’t let this 
information upset or confuse you! Instead, turn to Chapter 15 for more 
information on Word styles.
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Paragraph Formatting
In This Chapter
▶ Understanding paragraph formatting

▶ Finding paragraph-formatting commands

▶ Aligning paragraphs left, center, right, and full

▶ Changing line spacing

▶ Adding room between paragraphs

▶ Indenting a paragraph

▶ Making a hanging indent

▶ Double-indenting a paragraph

▶ Using the Ruler

Paragraphs are goodly sized chunks of text. In school, you were probably 
taught that a paragraph must consist of one or more sentences express-

ing a thought. Or something. Anyway, I view a paragraph, formatting-wise, 
as a veritable text sandwich, bulky enough to qualify for its own round of 
formatting commands: A paragraph has left and right margins, a top and a 
bottom, a before and an after, plus space in the middle.

Word provides ample tools for formatting paragraphs of text. There’s a 
simple way, for example, to automatically indent the first line of a paragraph. 
Imagine! That and other amazing formatting tricks, all designed to impress 
and inspire, are found in this handy chapter.

How to Format a Paragraph
You can format a paragraph in Word several ways:

 ✓ Use a paragraph-formatting command and then type a new paragraph in 
that format.

 ✓ Use the formatting command in a single paragraph to format that para-
graph. (Place the insertion pointer in a paragraph, and then use a for-
matting command.)
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 ✓ Use the formatting command on a block of selected paragraphs to 
format them all together.

Then again, what is a paragraph? It’s a chunk of text larger than a character, 
word, or sentence, but a paragraph can be a single character, word, and sen-
tence. The secret is the Enter key: A paragraph is a chunk of text that ends 
when you press the Enter key. So, as long as you type a single character, 
word, or sentence and then press Enter, you have a paragraph.

 ✓ Paragraph formatting commands affect either the paragraph the inser-
tion pointer lurks in or any paragraphs marked as a block (selected).

 ✓ Refer to Chapter 6 for specific and entertaining block-marking instructions.

 ✓ You can format all paragraphs in a document by first selecting the entire 
document. The quick way to do it is to press the Ctrl+A key combination.

 ✓ To format individual characters or the text inside a paragraph, refer to 
Chapter 10.

 ✓ Some folks like to see the Enter key symbol (¶) in their documents, visu-
ally marking the end of each paragraph. You can do this in Word by 
choosing the Options command from the File tab menu. Click Display 
on the left side of the Word Options dialog box. On the right side, put a 
check mark by Paragraph Marks. Click OK. Now, every time you press 
the Enter key, a ¶ symbol appears at the end of the paragraph.

Where the Paragraph Formatting 
Commands Lurk

Word gathered some of the most popular paragraph-formatting commands 
into the Paragraph group, found on the Home tab. Figure 11-1 illustrates the 
Paragraph group, although you should note that Word may show a differ-
ent arrangement of the command buttons depending on the Word window’s 
width.

 

Figure 11-1: 
Home tab 

Paragraph 
stuff.

 
Dialog Box

Launcher button
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In an odd twist, indenting and paragraph spacing are found in another 
Paragraph group, this one on the Page Layout tab, shown in Figure 11-2.

 

Figure 11-2: 
Page 

Layout tab 
Paragraph 

things.
 

Because many of the paragraph-formatting commands require you to enter 
values, there also exists a Paragraph dialog box, shown in Figure 11-3. In it, 
you find some finer controls that the command buttons just don’t offer.

 

Figure 11-3: 
The 

Paragraph 
dialog box.

 

To summon the Paragraph dialog box, click the Dialog Box Launcher button 
(shown in Figure 11-1), found in the lower-right corner of the Paragraph 
group. Or, you can use the forgettable keyboard shortcut Alt+H, P, G.

The commands in the various paragraph-formatting locations are covered 
throughout the rest of this chapter.

17_487723-ch11.indd   13317_487723-ch11.indd   133 3/27/10   10:44 AM3/27/10   10:44 AM



134 Part III: Formatting 

Click the Cancel button or press the Esc key to dismiss the Paragraph 
dialog box.

The Mini toolbar, which shows up after you select text, also contains a smat-
tering of paragraph-formatting buttons. Refer to Chapter 6 for more informa-
tion on the Mini toolbar.

Paragraph Justification and Alignment
Paragraph alignment has nothing to do with politics, and justification has 
nothing to do with the right or wrong of how paragraphs are formatted. 
Instead, both terms refer to how the left and right edges of the paragraph 
look on a page. The four options are Left, Center, Right, and Fully Justified, 
each covered in this section.

Line up on the left!
Much to the pleasure of southpaws the English-speaking world over, left-
aligning a paragraph is considered normal: The left side of the paragraph is 
all even and tidy, and the right side is jagged, not lined up.

  To left-align a paragraph, press Ctrl+L or click the Align Left command 
button.

 ✓ This type of alignment is also known as ragged right.

 ✓ Left-aligning a paragraph is how you “undo” the other types of alignment.

Everyone center!
Centering a paragraph places each line in that paragraph in the middle of the 
page, with an equal amount of space to the line’s right or left.

  To center a paragraph, press Ctrl+E or use the Center command button.

  ✓ Centering is ideal for titles and single lines of text. It’s ugly for para-
graphs and makes reading your text more difficult.

 ✓ You can center a single word in the middle of a line by using the center 
tab. Refer to Chapter 12 for the details.
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Line up on the right!
A right-aligned paragraph has its right margin nice and even. The left margin, 
however, is jagged. When do you use this type of formatting? I have no idea, 
but it sure feels funky typing a right-aligned paragraph.

  To flush your text along the right side of the page, press Ctrl+R or click the 
Align Right command button.

 ✓ This type of alignment is also known as ragged left or flush right.

 ✓ You can right-justify text on a single line by using a right-align tab. Refer 
to Chapter 12 for more info.

Line up on both sides!
Lining up both sides of a paragraph is full justification: Both the left and right 
sides of a paragraph are neat and tidy, flush with the margins.

  To give your paragraph full justification, press Ctrl+J or click the Justify com-
mand button.

 ✓ Fully justified paragraph formatting is often used in newspapers and 
magazines, which makes the thin columns of text easier to read.

 ✓ Word makes each side of the paragraph line up by inserting tiny slivers 
of extra space between the words in a paragraph.

Make Room Before, After, 
or Inside Paragraphs

Word lets you add “air” to the space before or after or in the middle of your 
paragraphs. In the middle of the paragraph you have line spacing. Before and 
after the paragraph comes paragraph spacing. Figure 11-4 shows you where 
the spacing can be found. The following sections describe how to control 
that spacing.
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Figure 11-4: 
Spacing in 

and around 
a para-
graph.

 

A case in point: You don’t really need to buy pots, pans, or cooking utensils. 
Any man with a well-stocked garage can make do.  For example, a putty 
knife works great as a spatula. There’s been many times I’ve cooked up a nice 
omelette using an oil pan and a screwdriver. Why pay more for something 
you don’t need when you have everything in your tool chest?

Line spacing

Space before

Space after

Setting the line spacing
Changing the line spacing inserts extra space between all lines of text in a 
paragraph. Because Word adds the space below each line of text in the para-
graph, the last line in the paragraph will also have a little extra space after it.

  The Line Spacing command button displays a menu listing common line-spacing 
commands, as shown in Figure 11-5. Choose a new line-spacing value from 
that list to change the line spacing for the current paragraph or all paragraphs 
selected as a block.

 

Figure 11-5: 
Choose line 

spacing 
from this 

menu.
 

 ✓ Word sets line spacing at 1.15 as its standard, or default. Supposedly, 
that extra .15 lines of text makes text more readable than using single 
spacing, or 1.0.

 ✓ In double spacing, or the line spacing value 2.0, one line of text appears 
with one blank line below it. Triple spacing, 3.0, makes one line of text 
appear with two blank lines below it.
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 ✓ Ah! The keyboard shortcuts:

 • To single-space, press Ctrl+1.

 • To double-space, press Ctrl+2.

 • To use 11⁄2-spaced lines, press Ctrl+5.

 ✓ Yes, Ctrl+5 applies 11⁄2-line spacing, not 5-line spacing. Use the 5 key on 
the typewriter area of the computer keyboard. Pressing the 5 key on the 
numeric keypad activates the Select All command.

 ✓ There’s no such thing as having no line spacing. If you want to “remove” 
fancy line spacing, select some text and press Ctrl+1 for single spacing.

 ✓ When you want text to stack up one line atop another line, you use the 
soft return. See the section in Chapter 4 about soft and hard returns.

Setting specific line spacing options
To set the line spacing to a value other than the items shown in the previ-
ous section (refer to Figure 11-5), you summon the Paragraph dialog box, as 
described earlier in this chapter and shown in Figure 11-3.

In the Spacing area of the dialog box, the Line Spacing drop-down list is used 
to set various line-spacing values: Single, 1.5, and Double, just like the Line 
Spacing command button menu.

Additional options in the Line Spacing drop-down list require you to also use 
the At box. Values you set in the At box indicate line spacing as described in 
this list:

 ✓ At least: The line spacing is set to the specified value, which Word treats 
as a minimum value. Word can disobey that value and add more space 
whenever necessary to make room for larger type, different fonts, or 
graphics on the same line of text.

 ✓ Exactly: Word uses the specified line spacing and doesn’t adjust the 
spacing to accommodate for larger text or graphics.

 ✓ Multiple: This option is used to enter line-spacing values other than 
those specified in the drop-down list. For example, to set the line spac-
ing to 4, choose Multiple from the Line Spacing drop-down list and type 
4 in the At box. Word’s 1.15 line spacing value is set with the Multiple 
option.

 You can specify values in the At box in increments of 0.1. So, when you 
want to tighten up text on a page, select all paragraphs on that page, choose 
Multiple from the Line Spacing drop-down list, and then type 0.9 in the At box. 
Or, to add more room subtly, type 1.2.
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Click the OK button to confirm your settings and close the Paragraph 
dialog box.

Making space between paragraphs
It’s a silly thing to do: Press Enter twice to end a paragraph. People say that 
they need the extra space between the paragraphs, but what they don’t real-
ize is that Word can add that space for you, automatically. Here’s how:

 1. Position the insertion pointer in the paragraph or paragraphs that you 
want more air around, or mark a block of paragraphs to affect them 
all.

 2. Check the point size of your text.

  It’s listed on the Home tab, in the Font group.

 3. Click the Page Layout tab.

 4. Use the After button in the Paragraph group to add space after the 
paragraph .

  As you adjust the value, the paragraphs grow extra spacing.

For example, if your text size is 12, click the up arrow next to After until the 
value 12 appears in the box. This action adds 12 points, or one blank line, of 
space after each paragraph you type.

The space you add to the paragraph becomes part of its format, just like line 
spacing would, although the space afterward appears only after the para-
graph’s text. (You can see this space if you select the paragraph as a block.)

Most of the time, space is added following a paragraph, as just described. 
Word also lets you add space before a paragraph. For example, you can do 
this to further separate a document heading or subhead from the preceding 
paragraph. To add the space before, repeat the preceding steps and put a 
value in the Before box in Step 4.

 ✓ You can manually enter values in the After (or Before) box. But remem-
ber that the values are points, not inches or potrzebies.

 ✓ The spacing before or after a paragraph can also be set in the Paragraph 
dialog box.

 ✓ This trick is a great way to spread out a list of bullet points or numbered 
steps without affecting the line spacing within the bullet points or steps.

 ✓ Refer to Chapter 10 for more information points as they relate to text 
size.
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 ✓ Adding space before or after a paragraph isn’t the same as double-
spacing the text inside the paragraph. In fact, adding space around a 
paragraph doesn’t change the paragraph’s line spacing.

Paragraph Indentation
Do you suffer from the shame of manual paragraph indenting? It’s a hidden 
secret. Yes, even though computers enjoy doing tasks automatically, too 
many Word users still begin a paragraph of text by pressing the Tab key. It’s 
ugly, but it’s a topic that must be discussed.

Word can indent your paragraphs for you: left side, right side, both sides, 
or maybe just the first line. It can even outdent the first line, which is truly 
something to behold. This section discusses various paragraph-indenting 
and -outdenting options.

Indenting the first line of a paragraph
To have Word automatically indent the first line of every paragraph you type, 
heed these steps:

 1. Conjure up the Paragraph dialog box.

  Refer to the section “Where the Paragraph Formatting Commands Lurk,” 
earlier in this chapter, for proper conjuring incantations plus a bonus 
picture of what the Paragraph dialog box looks like (refer to Figure 11-3).

 2. In the Indentation area, locate the Special drop-down list.

 3. Select First Line from the list.

 4. Enter an amount in the By box (optional).

  Unless you’ve messed with the settings, the box should automatically 
say 0.5”, which means that Word automatically indents the first line of 
every paragraph a half-inch — one tab stop. Type another value if you 
want your indents to be more or less outrageous. (Items are measured 
here in inches, not in points.)

 5. Click OK.

  The selected block, or the current paragraph (and the remaining para-
graphs you type), all automatically has an indented first line.
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To remove the first-line indent from a paragraph, repeat these steps and 
select (none) from the drop-down list in Step 3. Then click the OK button.

  Word’s AutoCorrect feature can perform these steps for you, but it’s tricky. 
First you must type the paragraph. Then go back to the start of the para-
graph and press the Tab key. This action instantly fixes the paragraph inden-
tation (if AutoCorrect is on), and you see the AutoCorrect icon on the screen. 
Here’s the secret: Ignore the AutoCorrect icon and your paragraph indenting 
is fixed. Ta-da!

 You have two ways to separate paragraphs from each other in a document. The 
first is to add space between each paragraph, which is covered in the earlier 
section “Making space between paragraphs.” The second way is to indent each 
paragraph’s first line, as covered in this section. Choose one or the other — no 
need to use both.

Making a hanging indent (an outdent)
A hanging indent isn’t in imminent peril, nor can it affect the outcome of an 
election. Instead, it’s a paragraph in which the first line sticks out to the left 
and the rest of the paragraph is indented. It’s a preferred way to present 
paragraph lists — like this:

Snore putty: It works every time. Just apply a little snore putty to your part-
ner’s mouth and nostrils. In just moments, that rattling din is gone and you’re 
back to sleeping comfortably.

To create such a beast, position the insertion pointer in the paragraph you 
want to hang and indent. Press Ctrl+T, the Hanging Indent keyboard shortcut.

Because you probably won’t remember Ctrl+T all the time (who could?), 
paragraphs can also be hanged and indented in the Paragraph dialog box. 
Follow the steps from the previous section, but in Step 3 choose Hanging 
from the drop-down list.

 ✓ As a bonus, every time you press Ctrl+T, your paragraph is indented by 
another half-inch.

 ✓ To undo a hanging indent, press Ctrl+Shift+T. That’s the unhang key 
combination, and it puts your paragraph’s neck back in shape.

Indenting a whole paragraph
Just as you can indent the first line of a paragraph, you can indent every 
line of a paragraph, by moving the paragraph’s left margin over to the right 

17_487723-ch11.indd   14017_487723-ch11.indd   140 3/27/10   10:44 AM3/27/10   10:44 AM



141 Chapter 11: Paragraph Formatting

a notch, just like Mr. Bunny: Hop, hop, hop. This technique is popular for 
typing block quotes or nested paragraphs.

  To indent a paragraph one tab stop from the left, click the Increase Indent 
command button in the Home tab’s Paragraph group or press Ctrl+M.

  To unindent an indented paragraph, click the Decrease Indent command 
button in the Home tab’s Paragraph group or press Ctrl+Shift+M.

Each time you use the Increase Indent command, the paragraph’s left edge 
hops over one tab stop (typically, one half-inch). To undo this and shuffle the 
paragraph back to the left, use the Decrease Indent command.

When you want to get specific, you can set the left and right indents for a 
paragraph by using the Page Layout tab’s Paragraph group. (Refer to Figure 
11-2). The Left item sets the indentation for the paragraph’s left edge. The 
Right item sets the indentation for the paragraph’s right edge.

 ✓ Indenting a paragraph doesn’t affect the paragraph’s alignment.

 ✓ To indent both the left and right sides of a paragraph set both left and 
right indents to the same value.

 ✓ To undo any paragraph indenting, set both Left and Right indent values 
to zero.

 ✓ Although the Ctrl+M and Ctrl+Shift+M shortcuts aren’t mnemonic, their 
only difference is a Shift key. So, after you get used to using them (hope-
fully, before the afterlife), they’re easy to remember.

 ✓ Setting positive values for the paragraph’s indent in the Page Layout 
tab’s Paragraph group moves the paragraph’s edges inward. Setting neg-
ative values moves the edges outward. When the values are set to zero, 
the paragraph’s margins match the page’s margin.

 ✓ You cannot decrease the indent beyond the left margin of the page.

 ✓ Refer to Chapter 13 for more information on the page margins.

 ✓ Use the Mirror Indents check box in the Paragraph dialog box to set 
the inside (toward the fold between the pages) and outside (toward the 
edges) margins so that an indented paragraph on one page mirrors the 
paragraph on the opposite page.

 ✓ Do not try to mix left and right indenting with a first-line indent or hang-
ing indent while drowsy or while operating heavy equipment.

Who Died and Made This Thing Ruler?
Paragraph formatting can be confusing. Two places on the Ribbon are for 
paragraph formatting, or if you opt instead to use the Paragraph dialog box, 
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your mind may go into shock from the abundance of options. A more graphi-
cal, and therefore more fun, way to manipulate a paragraph’s indentation and 
margins is to use the Ruler.

  The Ruler may be hidden in your copy of Word. To show the Ruler, click the 
View Ruler button, found atop the vertical (right) scroll bar. Likewise, to hide 
the Ruler, click the button again.

The Ruler appears on the top of the writing part of the Word window, shown 
in Figure 11-6. In Print Layout view, a vertical ruler also shows up and runs 
down the left side of the window. (That ruler is just for show.)

 

Figure 11-6: 
The Ruler.

 

Tab gizmo

First Line indent

Left Indent

Hanging indent

Right Indent

The dark gray part of the Ruler (outside ends) is beyond the page margins. 
The lighter gray part is inside the page margins, and the Ruler measures that 
space from the left, starting with zero inches.

On the Ruler, and illustrated in Figure 11-6, you find four gizmos that control 
paragraph indenting: one downward-pointing triangle, two upward-pointing 
triangles, and one block. Those gizmos reflect the current paragraph format-
ting, and they can be manipulated with the mouse to change the paragraph 
formatting. The next few paragraphs describe the settings they control:

  To adjust a paragraph’s right margin, grab the Right Indent guy on the ruler 
and drag him to the right or left.

  To adjust the paragraph’s left margin, grab the Left Indent thing on the Ruler 
and slide it to the left or right. Note that this gizmo moves both the Hanging 
Indent and First Line Indent guys together.

  The paragraph’s first line can be set independently of the left margin by drag-
ging the First Line Indent doojobbie to the left or right.

  The Hanging Indent thing controls all lines in the paragraph except for the 
first one. Normally, you don’t mess with this gizmo: Use the Left Indent guy to 
set the paragraph’s left margin. The exception is for creating a hanging 
indent, which is probably why this gizmo has such a clever name.
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 ✓ The Ruler measures from the page’s left margin, not from the left edge of 
the page.

 ✓ The page’s left margin is set when you format a page of text. See Chapter 13.

 ✓ The Tab gizmo is used to set the various tab stops used in Word. This 
confusing and frustrating subject is covered in Chapter 12.

 ✓ The Ruler works fine for visually setting indents, but when you need to 
be precise, use the Paragraph dialog box.

Paragraph-formatting survival guide
This table contains all the paragraph-formatting 
commands you can summon by holding down 

the Ctrl key and pressing a letter or number. By 
no means should you memorize this list.

Format Key Combination Command Button

Center Ctrl+E

Fully justify Ctrl+J

Left-align (flush left) Ctrl+L

Right-align (flush right) Ctrl+R

Indent Ctrl+M

Unindent Ctrl+Shift+M

Hanging indent Ctrl+T

Unhanging indent Ctrl+Shift+T

Line spacing Alt+H, K

Single-space lines Ctrl+1

1.15 line spacing Ctrl+0

Double-space lines Ctrl+2

11⁄2-space lines Ctrl+5
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Chapter 12

Tab Formatting
In This Chapter
▶ Understanding tabs

▶ Setting left tab stops

▶ Using right, center, and decimal tabs

▶ Working in the Tabs dialog box

▶ Setting leader tabs

▶ Fixing the default tab stops

▶ Removing tabs and tab stops

The tab is one of the handiest and most overlooked and frustrating 
things in all of Word. By using tabs, you can quickly line up text, create 

lists, and format tables nice and neat. Yet most folks don’t bother with tabs 
because, honestly, Word doesn’t handle them in anything approaching a logi-
cal, friendly manner. Because of that frustration, and even though the tab is a 
part of paragraph formatting, I decided to create a special chapter just on the 
topic of using tabs in Word.

Once Upon a Tab
On my ancient Underwood typewriter, the Tab key is on the right side of the 
keyboard and is named Tabular Key. Elsewhere, I’ve seen it named Tabulator. 
In each case, the root word is table. The Tab key is used to help build tables 
or to organize information in a tabular way.

Pressing the Tab key in Word inserts a tab character into your document. 
That tab character works like a wide space character, where its size is deter-
mined by the tab stop. The tab stop is a predefined location marked across a 
page — say, every half-inch — although in Word you can set tab stops at any 
interval.
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It’s the tab stop that makes the Tab key work: Press the Tab key, and the inser-
tion pointer hops over to the next tab stop. That way, you can line up text on 
multiple lines with tabs and tab stops, keeping things nice and even — definitely 
much nicer than trying to fudge and line up text with the spacebar.

  Tabs can be set in Word by using the Tabs dialog box or, better, by using the 
Ruler, shown in Figure 12-1. To make the Ruler visible, click the View Ruler 
button, which is found roosting atop the vertical scroll bar (and shown in the 
margin).

 

Figure 12-1: 
Important 
tab things 

on the Ruler.
 

Tab gizmo

Left tab Center tab Right tab

Tab stops appear as tiny black symbols clinging on the Ruler , as shown in 
Figure 12-1. Three tab stops are set in the figure: a left tab stop at the half-
inch mark, a center tab stop at the 3-inch mark, and a right tab stop at the 
51⁄2-inch mark.

You manipulate tab stops on the Ruler by using the mouse. That’s the easy 
part. The difficult part is that Word has five different types of tab stops:

  The left tab is the traditional type of tab stop.

  The center tab centers text, mostly for titles or headers.

  The right tab right-justifies text.

  The decimal tab aligns numbers by their decimal parts.

  The bar tab isn’t a tab stop, but is, rather, a decorative ornament.

Setting a tab involves two steps:

 1. Ensure that the Tab gizmo on the left end of the Ruler displays the 
type of tab stop you want.

  Clicking the Tab gizmo displays a different tab type. (The Tab gizmo also 
displays some paragraph-indent symbols, covered in Chapter 11.)

 2. Click the Ruler at the exact spot where you want the tab stop set.

For example, to set a left tab stop, you choose the left tab from the Tab gizmo 
and then click the Ruler where you want that tab stop positioned. Click the 
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3-inch mark, and the plump L of the left tab stop settles down at that position 
nicely.

Later sections in this chapter discuss each of the five different types of tab 
stops, when and how to set them, as well as how to set tabs in the Tabs 
dialog box.

 ✓ You use Backspace or Delete to remove a tab character, just as you 
delete any character in a document.

 ✓ Format tabs for a single line of text or for only the first line of a para-
graph. For anything more complex, use Word’s Table command. See 
Chapter 19.

 ✓ Anytime you press the spacebar more than once, you need a tab. Believe 
me, your documents will look prettier and you’ll be happier after you 
understand and use tabs rather than spaces.

 ✓ Tabs are paragraph-level settings. Tab settings affect only the paragraph 
that the toothpick cursor is blinking in. To set tabs for several para-
graphs, you must first select the paragraphs as a block. Refer to Chapter 
6 for more blocky stuff.

 ✓ When you’re selecting several paragraphs, you may spot a light gray, or 
phantom, tab stop on the Ruler. The phantom indicates a tab stop that’s 
set in one paragraph but not in all. To apply the tab stop to all selected 
paragraphs, click the phantom tab stop once. Otherwise, you can 
remove the tab stop by following the instructions found in this chapter’s 
later section “Tab Stop, Be Gone!”

  ✓ Tab characters can often confuse you because, like spaces, they don’t 
show up on the screen. But you can see them, if you like. To direct Word 
to display the tab character, which looks like a tiny arrow, as shown in 
the margin, choose Options from the File tab’s menu. Click Display from 
the left side of the Word Options dialog box. On the right side of the 
window, put a check mark by the Tab Characters option. Click OK.

 ✓ The diet beverage Tab was named for people who like to keep a tab on 
how much they consume.

The Standard Left Tab Stop
The left tab stop is the traditional type of tab stop. When you press the Tab 
key, the insertion pointer advances to the left tab stop, where you can con-
tinue to type text. This works best for typing lists, organizing information in 
single-line paragraphs, or indenting the first line of a multiline paragraph. 
This section provides some examples.
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Creating a basic tabbed list
A common use for the tab stop is to create a simple two-column list, as 
shown in Figure 12-2.

 

Figure 12-2: 
Two-column 

list.
 

The following steps describe how to set up this type of list:

 1. On a new line, press Tab.

 2. Type the item for the first column.

  This item should be short — two or three words, max.

 3. Press Tab.

 4. Type the item for the second column.

  Again, make it short.

 5. Press Enter to end that line and start a new line.

  Yes, your list looks horrible! Don’t worry. Just get the data typed first 
and then format it.

 6. Repeat Steps 1 through 5 for each item in the list.

  After the list is finished, you set the tab stops visually by using the 
Ruler.

 7. Summon the Ruler, if necessary.

   Click the View Ruler button to display the Ruler, if it’s hidden.

  8. Select all lines of text that you want to organize into a two-column 
tabbed list.

  Refer to Chapter 6 for more information on marking blocks of text.

 9. Click the Tab gizmo until the Left Tab icon appears.

  If the icon already shows up in the Tab gizmo, you’re set.
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   You can see what a Left Tab icon looks like right here in the margin.

  10. Click the mouse on the Ruler at the number 1, the 1-inch position.

  This step sets a left tab stop at one inch. You see how the text you 
selected falls into place immediately.

 11. Click the mouse to set a second tab stop at the 3-inch mark.

  The list looks nice and even, in two columns (refer to Figure 12-2).

 12. Adjust the tab stops, if necessary.

  Slide the tab stops left or right on the Ruler as needed to help clean up 
your list. As you slide the tab stops, notice how a dashed vertical line 
extends through your text. That line shows you where text lines up.

These steps can also be used to create a three- or even four-column list. The 
idea is to keep the text on one line and separated by single tabs. Then use the 
tab stops on the Ruler to line up the columns and make them look pretty.

 ✓ You need only one tab between items in a column list. That’s because:

  It’s the tab stop, not the tab character, that lines up your text. As with 
using two spaces in a row, you never need two tabs in a row.

 ✓ You type the text first and then select the text and set the tab stops last.

 ✓ You can adjust tab stops for the entire block of text by using the mouse 
and the Ruler.

 ✓ For a tabbed list to work, each paragraph must be a line by itself and the 
items in each column should be only a word or two long. Any longer and 
you need to use Word’s Table command, as covered in Chapter 19.

Creating a two-tab paragraph thing
Tabs can also be used to form an item list where the paragraph text remains 
in the rightmost column. Figure 12-3 shows how the two-tab paragraph thing 
works. It combines both paragraph- and tab-formatting skills.

Follow these steps to create a similar list:

 1. On a new line, type the item for the first column.

  The shorter, the better.

 2. Press Tab.
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Figure 12-3: 
A tab-tab-
paragraph 
format for 

text.
 

 3. Type the second column’s text and press Tab.

  This step is optional; you can create a simpler tab-paragraph list, which 
looks just like the one shown in Figure 12-3, but without the Dish column 
(and spaced accordingly).

 4. Type the paragraph text.

  Unlike with the first two items, you’re free to type more text here. That’s 
because this final paragraph column will wrap (refer to Figure 12-3).

 5. Press Enter to end the line and start a new line.

  Don’t let the ugly text format fool you at this point. The text beautifies 
itself when you add the tab stops.

 6. Repeat Steps 1 through 5 for all items in the tab-paragraph list.

  When you’re done, you can set the tab stops. You need the Ruler for 
Step 7.

 7. Bid the Ruler appear, if need be.

   Click the View Ruler button to show a hidden Ruler.

  8. Select all the lines of text you want to organize into a tab-tab-para-
graph list.

  Chapter 6 discusses block-selection techniques.

  9. Slide the Hanging Indent triangle to the 3-inch position on the Ruler.

   The paragraph appears.

 10. Ensure that the left tab is chosen on the Tab gizmo.

   The margin shows the Left Tab symbol.

  11. Click the mouse to set a tab stop at 1.5 inches.

  The second column snaps into place.

 12. Adjust the tab stop and hanging indent triangle as necessary.
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  With the text still selected, you can slide the tab stop and the Hanging 
Indent things on the Ruler to the left or right to adjust the look of your 
tab-tab-paragraph. Whatever looks best works best.

You can vary these rules to have a tab-paragraph or even a triple-tab-para-
graph. The more tabs you have, the tighter the paragraph gets, so be careful. 
(The notes from the preceding section also apply to this technique.)

The Center Tab Stop
The center tab is a unique critter, and it has a special purpose: Text placed 
at a center tab is centered on a line. Unlike centering a paragraph, only text 
placed at the center tab stop is centered. This feature is ideal for centering 
something in a header or footer, which is about the only time you use the 
center tab stop.

Figure 12-4 shows an example of a center tab. The text on the left is at the 
start of the paragraph, which is left-justified. But the text typed after the tab 
is centered on the line.

 

Figure 12-4: 
A center tab 

in action.
 

Here’s how to make that happen:

 1. Start a new paragraph, one containing text that you want to center.

  Center tabs are found in one-line paragraphs.

 2. Set a center tab.

   If necessary, show the Ruler: Click the View Ruler button. Click the Tab 
gizmo until a center tab appears (refer to Figure 12-4). Click the mouse 
on the light gray part of the Ruler to set the tab. In Figure 12-4, the 
center tab is set at the center of the page, at the 3-inch position.

 3. Type some text to start the line (optional).

  The text you type should be short; it appears only at the start of the line.

 4. Press the Tab key.

  The insertion pointer hops over to the center tab stop.
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 5. Type the text to center.

  As you type, the text is centered on the line. Don’t type too much; 
remember that the center tab is a single-line thing.

 6. Press Enter to end the line of text.

Obviously, if you just want to center text on a line, centering the entire para-
graph is a better choice; see Chapter 11. Otherwise, this technique finds itself 
used mostly in page headers and footers, which are covered in Chapter 14. 
Look there for an additional example.

 ✓ You can also add a right tab stop to the line, to have text lined up left, 
center, and right, which happens a lot in headers and footers and is 
shown earlier, in Figure 12-1.

 ✓ Center tabs are best used on a single line of text, usually by themselves. 
There’s no reason to do them any other way.

The Right Tab Stop
A right tab seems useless until you’ve seen one in action. You use it to right-
justify text at a tab stop, allowing a single line of text to contain both right- 
and left-justified text. You’ve probably seen, but not recognized, examples of 
a right tab all over the place, so I give you Figures 12-5 and 12-6 to gawk at in 
the following section.

 ✓ As with the other unusual tab stops, right tab stops work best on a 
single line of text.

  ✓ The following two sections describe how to set up right tab stops as 
shown in Figures 12-5 and 12-6. In both cases, you use the Ruler; to show 
the Ruler in Word, click the View Ruler button, found on top of the verti-
cal scroll bar.

Making a right-stop, left-stop list
To create a centered, two-column list with a right tab stop and a left tab stop, 
as shown in Figure 12-5, obey these steps:

 1. Start out on a blank line, the line you want to format.

 2. Choose the right tab stop from the Tab gizmo.

   Keep clicking the Tab gizmo with the mouse until the right tab stop 
appears.
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Figure 12-5: 
Right tab 
stops are 

used to 
center-align 

this list.
 

 3. Click the mouse at the 3-inch position on the Ruler.

 4. Choose the left tab stop from the Tab gizmo.

   Click, click, click until you see the left tab stop.

 5. Click the mouse at the 31⁄8-inch position on the Ruler.

  Use Figure 12-5 as your guide. Don’t fret — you can change the tab stop 
positions when you’re just about done.

 6. Press the Tab key.

  The insertion pointer hops over to the 3-inch stop, the right tab stop.

 7. Type your text.

  The text is right-justified at the right tab stop.

 8. Press the Tab key.

 9. Type your text.

  The text is left-justified (normal).

 10. Press Enter to end the line of text.

 11. Repeat Steps 6 through 10 for each line in the list.

As long as you limit the text to one line, the list should look great (refer to 
Figure 12-5).

To make adjustments, select the list as a block (see Chapter 6) and use the 
mouse to adjust the tab stops on the Ruler. As you move the tab stops, a 
dashed line extends through your text, showing you where the text lines up. 
Or, to be more precise, you can use the Tabs dialog box as covered later in 
this chapter.

Building a two-column right stop list
Another type of right tab stop list is shown in Figure 12-6. This type is com-
monly found in dramatic programs but works just as well for a variety of pur-
poses. Here’s how to concoct such a thing:
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Figure 12-6: 
Right tab 

stops right-
align the 

second 
column of 

this list.
 

 1. Start out with a blank line of text.

 2. Ensure that the Tab gizmo on the Ruler shows the right tab stop.

  Refer to Figure 12-6.

 3. Click the mouse at the 4-inch position on the Ruler.

  The position is just a guess at this point. Later, you can adjust the right 
tab stop setting to a more visually appealing one.

 4. Type the left column text.

  The text is left-justified, like normal.

 5. Press the Tab key.

  The insertion pointer hops to the right tab stop.

 6. Type the right column text.

  The text you type is right-justified, pushing to the left as you type.

 7. Press Enter to end the line of text.

 8. Repeat Steps 4 through 7 for each line in the list.

Afterward, you can mark the text as a block and then use the mouse to drag 
the right tab stop back and forth to whatever looks more visually appealing.

  ✓ You can drag the left indent toward the center of the page to offset the 
list from the left margin.

  ✓ Also refer to the section “Setting leader tabs,” later in this chapter, for 
information about adding a dotted leader to the right tab stop.

The Decimal Tab
The decimal tab is used to line up columns of numbers. Although you can 
use a right tab to do this job, the decimal tab is a better choice. Rather than 
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right-align text, as the right tab does (see the previous section), the decimal 
tab aligns numbers by their decimal portion — the period in the number, 
shown in Figure 12-7.

 

Figure 12-7: 
Lining up 
numbers 
with the 

decimal tab.
 

Here’s how to work with such a beast:

 1. Start a blank line of text.

 2. Choose the Decimal tab stop from the Tab gizmo on the Ruler.

   The Decimal tab stop icon is shown in the margin.

  3. Set the tab stop on the Ruler by clicking the mouse at the 3-inch position.

 4. Type the left column text.

 5. Press the Tab key.

 6. Type the numerical amount.

  The number is right-justified until you press the period key. After that, 
the rest of the number is left-justified. The effect is lined up that the 
value is at the decimal tab stop by the period in the number.

 7. End that line of text by pressing Enter.

 8. Repeat Steps 4 through 7 for each line in the list.

When you type something without a period in it (refer to Figure 12-7), it’s 
shown right-justified.

 You can adjust your text by selecting all lines as a block and then using the 
mouse to move the decimal tab stop on the Ruler.

The Bar Tab
Aside from being a most excellent pun, the bar tab isn’t a true tab stop in 
Word. Instead, consider it a text decoration. Setting a bar tab merely inserts 
a vertical line into a line of text, as shown in Figure 12-8. Using this feature is 
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much better than using the pipe (|) character on the keyboard for drawing a 
vertical line in your document.

 

Figure 12-8: 
The mysteri-
ous bar tab.

 

The setup to create the three-column text shown in the figure is similar to 
the one presented earlier in this chapter for a two-column list (see the earlier 
section “The tabbed list”), though Figure 12-8 shows a three-column list with 
the first column at the start of a line.

  You set a bar tab the same way you set any other type of tab. But, rather than 
insert a tab, you insert a black vertical line in the text. The line always 
appears, even when no text or tab is used on a line, as you can see in the last 
row of text (empty) in Figure 12-8.

In Figure 12-8, observe that a left tab stop is set immediately after the bar 
tab to help organize text on a line. This is normally how bar tabs are used, 
although, for all practical purposes, it’s just easier in Word to surrender here 
and use the Table function instead; see Chapter 19.

The Tabs Dialog Box
If setting tabs on the Ruler is the right-brain approach, using the Tabs dialog 
box is the left-brain method of setting tab stops in Word. The Tabs dialog 
box, shown in Figure 12-9, gives you more precision over using the Ruler by 
itself.

Getting to the Tabs dialog box is a journey, the type of journey that ends with 
an “All I got was this stupid Tabs dialog box T-shirt.” The simplest way to 
beckon forth the Tabs dialog box is to double-click the mouse on a tab in the 
middle of the Ruler (on the light gray part). Of course, that technique also 
sets a tab stop, which can be frustrating.

The other way to open the Tabs dialog box is to summon the Paragraph 
dialog box: Click the Dialog Box Launcher button in the lower right corner 
of the Paragraph group, on the Home tab. When the Paragraph dialog box is 
visible, click the Tabs button in the lower left corner to bring forth the Tabs 
dialog box.
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Figure 12-9: 
The Tabs 

dialog box.
 

Setting a tab in the Tabs dialog box
When you need for your tab stops to be precise and the Ruler is proving 
unruly, follow these steps to set tabs in the Tab dialog box:

 1. Enter the exact tab stop position in the Tab Stop Position box.

  For example, type 1.1875 to set a tab at exactly that spot.

 2. Choose the type of tab stop from the Alignment area.

  The standard tab stop is named Left. Other types of tab stops are cov-
ered elsewhere in this chapter.

 3. Click the Set button.

  The Set button — not the OK button — creates the tab stop. After you 
click Set, the tab stop is placed on the list below the Tab Stop Position 
dialog box. (You may notice that numbers are rounded to the nearest 
hundredth; Word interprets 1.1875 as 1.19, for example.)

 4. Continue setting tabs.

  Repeat Steps 1 through 3 for as many tabs as you need to set.

 5. Click OK.

The tabs you set affect the current paragraph or a selected group of para-
graphs. If the Ruler is visible, you can see the tabs and adjust them by using 
the mouse.

 You must click the Set button to set a tab! I don’t know how many times I click 
OK, thinking that the tab stop is set when it isn’t.

18_487723-ch12.indd   15718_487723-ch12.indd   157 3/27/10   10:41 AM3/27/10   10:41 AM



158 Part III: Formatting 

Setting leader tabs
You can do only one task in Word in the Tabs dialog box that you cannot do 
with the Ruler: Set a leader tab.

What is a leader tab?

A leader tab produces a row of dots, underlining (in a fashion) the tab charac-
ter. Three styles are available:

Fearless dot leader tabs ..................................................................................180

Zipper line leader tabs  _  _  _  _  _  _  _  _  _  _  _  _  _  _  _  _  _  _  _  _  _  180

U-boat underline leader tabs _____________________________________180

You can apply a leader tab to any tab stop in Word other than the bar tab. To 
do so, refer to other sections in this chapter that tell you how to set the vari-
ous types of tab stops—specifically, the right tab stop. To add the dot leader 
to the tabbed list you’ve created, follow these steps:

 1. Select the text as a block.

  Refer to Chapter 6 for block-marking directions.

 2. Bring forth the Tabs dialog box.

 3. Select the tab stop from the Tab Stop Position list.

  For example, in Figure 12-6, the right tab stop shows up in the Tab Stop 
Position list as 4". Click to select that item in the list.

 4. In the Leader area, choose the leader style.

  None means “no leader,” and it’s selected already. Choose one of the 
other three options.

 5. Click the Set button.

  Don’t click OK before you set the tab stop to add the leader. This step is 
the one you’ll screw up most often.

 6. Click OK.

  After clicking the Set button, you can click OK to close the Tabs dialog 
box and gawk at your text.

 The leader tab that uses the underline character is also the best way to create 
fill-in-the-blanks forms. Use the Tabs dialog box to set a left tab stop at the 
far right margin (usually, 6.0 inches). Choose an underline leader for that tab. 
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Click Set and then OK. Back in your document, type the prompt for the fill-in-
the-blanks line, such as

Your name:

Rather than type a zillion underlines, just press the Tab key. Instantly, a line 
extends from the colon to the right margin.

Tab Stop, Be Gone!
Removing a tab stop is as easy as dragging the Tab Stop icon from the Ruler: 
Point and click at the tab stop and drag the mouse downward, and the tab 
stop is gone.

The Tabs dialog box can also be used to remove tab stops. It’s especially 
good for those times when you may have several tab stops close together 
and plucking one out with the mouse would be tiresome. In the Tabs dialog 
box, choose the tab stop position in the Tab Stop Position list and then click 
the Clear button. Poof! It’s gone!

Clicking the Clear All button in the Tabs dialog box removes all tabs from the 
Ruler in one drastic sweep.

To delete a Tab character, of course, simply back up over it with the 
Backspace key.

18_487723-ch12.indd   15918_487723-ch12.indd   159 3/27/10   10:41 AM3/27/10   10:41 AM



160 Part III: Formatting 

18_487723-ch12.indd   16018_487723-ch12.indd   160 3/27/10   10:41 AM3/27/10   10:41 AM



Chapter 13

Page Formatting
In This Chapter
▶ Setting the page size

▶ Choosing landscape or portrait layout

▶ Setting margins for your document

▶ Automatically numbering your pages

▶ Changing page numbers

▶ Creating a new page

▶ Coloring a page

▶ Adding a watermark

Back in the old days, page formatting meant fitting your document on a 
sheet of paper. You could choose from two paper sizes, letter and legal, 

and you could print normal or sideways. That was in the old days.

Today, you don’t just print a document, you publish it. You can put the thing 
on paper, or you can distribute your document to the world electronically. 
Because the final destination need not be paper, a document’s page size 
becomes nontraditional. You can use Word’s page formatting tools to set the 
size of the paper or the direction the text flows and use other fun features 
such as page numbers, all covered in this chapter.

Describe That Page
Page formatting starts with the size of the page, which is normally the size 
of the paper you’re printing on. As far as Word is concerned, page and paper 
are similar concepts, though in theory you can set the page size to anything, 
which is covered in this section.
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Setting page size
When Word starts out, it assumes that your document is destined to be 
printed on a sheet of paper and that the paper will be the standard size for 
your region, such as 81⁄2-by-11 inches in the United States and the A4 size 
just about everywhere else. As the computer user, you have every right to 
disagree with Word and choose a different page size for your document, and 
you’re not limited to the standard paper sizes, either.

To set the page size, click the Page Layout tab and use the Size button in 
the Page Setup group. Clicking the Size button displays the page Size menu, 
shown in Figure 13-1. Choose a page size from the list.

 

Figure 13-1: 
The Size 

menu.
 

For example, if you want to print on that tall, legal-size paper, choose Legal 
from the list. Your entire document is then updated to reflect the new page 
size.

 ✓ To select a size not shown on the menu, choose the More Paper Sizes 
command, found at the bottom of the Size menu. You can then manually 
set the page size by using the Paper tab in the Page Setup dialog box. See 
the later section “Using the Page Setup dialog box,” for more information.

 ✓ Page-size changes are reflected in the entire document, from first page 
to last — unless you divide your documents into sections, that is. Then 
you can use different page sizes within each section. Refer to Chapter 14 
for information on sections.
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 ✓ If you plan to print on a nonstandard page size, you need to find that 
specific paper size, possibly at an office supply store, plus have a printer 
that can swallow that specific paper size.

 ✓ A typical sheet of paper, at least in the United States, measures 8 1⁄2 
inches across by 11 inches tall. Most of the rest of the world uses the A4 
paper-size standard, which is slightly longer and a tad narrower.

Setting orientation (landscape 
or portrait)
Word assumes that you want your document’s text to print from left to right 
on a page that’s taller than it is wide. That’s what it considers normal. It’s also 
called portrait mode because the page orientation is vertical, like a portrait.

Word can also be told to print longways, or in landscape mode. To perform 
this trick, you choose Landscape from the Orientation command in the Page 
Layout tab’s Page Setup group, shown in Figure 13-2.

 

Figure 13-2: 
Setting page 

orientation.
 

Choosing Orientation➪Landscape directs Word to shift the paper orientation 
for every page in your document. This doesn’t mean that the text is sideways 
any more than it means that the text prints wide on a page (though I suppose 
you could look at it as printing sideways).

To change the pages back, choose Orientation➪Portrait.

 ✓ Changing between Portrait and Landscape modes may require you to 
adjust the document’s margins; see the next section.

 ✓ Make the decision to have your document in landscape mode before you 
do any extensive formatting. That mode affects your paragraphs and 
other “lower-level” formatting, so you should have it done first, before 
you start composing text.

 ✓ Scientists and other people in white lab coats who study such things 
have determined that human reading speed slows drastically when 
people must scan a long line of text, which happens when you use 
Landscape mode. Reserve Landscape mode for printing lists and tables 
and items for which normal paper is too narrow.
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 ✓ Consider using multiple columns in Landscape mode. See Chapter 20.

 ✓ Also see the section “Using the Page Setup dialog box,” later in this 
chapter, for more page-orientation settings and options.

Configuring the page margins
Every page has margins. They provide the air around your document — that 
inch or so of breathing space that sets off the text from the rest of the page. 
As with other things in Word, these margins can be adjusted, fooled, cajoled, 
or otherwise obsessed with.

Word automatically sets page margins at 1 inch from every edge of the page. 
Most English teachers and book editors want margins of this size because 
these people love to scribble in margins. (They even write that way on blank 
paper.) In Word, you can adjust the margins to suit any fussy professional.

To change the margins, you use the Margins button, found in the Page Setup 
group on the Page Layout tab. Clicking the Margins button displays a menu 
full of common margin options, as shown in Figure 13-3.

 

Figure 13-3: 
The Margins 

menu.
 

Specific margins can be set by clicking the Custom Margins button at the 
bottom of the Margins menu. Doing so displays the Margins tab in the Page 
Setup dialog box, where specific margin information can be entered, includ-
ing information on printing more than one page on a sheet of paper. Refer to 
the next section for more information.

19_487723-ch13.indd   16419_487723-ch13.indd   164 3/27/10   10:40 AM3/27/10   10:40 AM



165 Chapter 13: Page Formatting

 ✓ Margins on a page are covered in this chapter. To set the indents for 
a single paragraph, you use a paragraph-formatting command. See 
Chapter 11.

 ✓ The stars on the Margin menu’s icons represent popular or recent 
margin choices you’ve made.

 ✓ Keep in mind that most laser printers cannot print on the outside half-
inch of a piece of paper — top, bottom, left, or right. This space is an 
absolute margin; although you can tell Word to set a margin of 0 inches 
right and 0 inches left, text still doesn’t print there. Instead, choose a 
minimum of 0.5 inches for the left and right margins.

 ✓ Likewise, many ink printers have a taller top or bottom margin require-
ment. If you attempt to print outside that area, a dialog box appears, 
informing you of your offense.

Using the Page Setup dialog box
As with many features in Word, when you want more control over page for-
matting, you must flee from the Ribbon interface and use an old-fashioned 
dialog box. In this case, it’s the Page Setup dialog box, shown in Figure 13-4.

 

Figure 13-4: 
The Margins 

tab in the 
Page Setup 
dialog box.
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To summon the Page Setup dialog box, click the Dialog Box Launcher in the 
lower right corner of the Page Setup group on the Page Layout tab. Or, you 
can use the keyboard shortcut: Alt+P, S, P.

The Page Setup dialog box sports three tabs: Margins for setting margins, 
Paper for selecting the page size, and Layout for dealing with other page-
formatting issues.

Click the OK button to confirm your changes and close the Page Setup 
dialog box.

 ✓ To print on three-hole paper, use the Margins tab in the Page Setup 
dialog box to set the gutter margin to about half an inch. That moves 
the entire margin “frame” one half-inch from where the three holes are 
punched. You can set the Gutter Position to Left option, unless the holes 
are punched on the top of the page, in which case you set the Gutter 
Position to Top option.

 ✓ Changes made to a page’s format — size, orientation, and margins — 
normally affect an entire document. By using the Apply To drop-down 
list in the Page Setup dialog box, however, you can determine which 
portion of a document will be affected by the margin change. You have 
three options:

 • Whole Document changes the margins for your whole document, 
from bonnet to boot.

 • This Point Forward makes the new margins take place from the 
insertion pointer’s position onward.

 • This Section means applies the margins only to the current sec-
tion. (See Chapter 14 for more information on sections.)

Dangerous treading in the Multiple Pages area of 
the Page Setup dialog box

Nestled on the Margins tab of the Page Setup 
dialog box is the Pages area (refer to Figure 
13-4). The Multiple Pages drop-down list tells 
Word how to use the paper on which your doc-
ument is printed. Surprisingly, you have more 
than one way to print a document on a page. 
The following definitions help, as does the little 
preview page at the bottom of the Page Setup 
dialog box:

Normal means one page per sheet of paper. 
You can’t get more normal than that.

Mirror Margins is used when your printer is 
smart enough to print on both sides of a sheet of 
paper. That way, every other page is flip-flopped 
so that your margins always line up. For example, 
the gutter may be on the left side of one page, but 
on the right for the page’s back side.

2 Pages per Sheet splits the paper right down 
the center and forces Word to print two “pages” 
per sheet of paper. Note that this option works 
best when used in landscape mode.
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Page Numbering
I’m still puzzled by people who manually number their pages when they use 
a computer and a word processor. Such a thing is silly beyond belief. That’s 
because

Your word processor numbers your pages for you!

Memorize it. Live it. Be it.

Adding an automatic page number
Not only can Word automatically number your pages, but it also lets you 
place the page number just about anywhere on the page and in a variety of 
fun and interesting formats.

Start your page numbering odyssey thus:

 1. Click the Insert tab.

 2. In the Header & Footer area, click the Page Number command button.

  A menu drops down, listing various page-numbering options. The first 
three are locations: Top of Page, Bottom of Page, and Page Margins, or 
the sides of the page.

 3. Choose where to place the page numbers.

  I want my page numbers on the bottom of the page, so I regularly 
choose the Bottom of Page option.

 4. Pluck a page-numbering style from the scrolling list.

  You can see oodles of samples, so don’t cut yourself short by not scroll-
ing through the menu. You can even choose those famous page X of Y 
formats.

Book Fold is Word’s attempt to create a multi-
ple-page booklet by printing the proper pages 
on both sides of a sheet of paper. This option 
works best if you have a printer capable of 
printing on both sides of a sheet of paper. The 
Sheets Per Booklet option that appears helps 
tell Word how long your booklet is.

Despite these options, Word is a poor book-
binding program. If you’re into any type of pub-
lishing, consider getting a desktop publishing 
program, such as Adobe InDesign or Microsoft 
Publisher, which are far better equipped to deal 
with this topic.
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Dutifully, Word numbers each page in your document, starting with 1 for the 
first page, up to however many pages long the thing grows. Plus, if you delete 
a page, Word renumbers everything for you. Insert a page? Hey! Word renum-
bers everything for you again, automatically. As long as you insert the page 
number by following the preceding set of steps, Word handles everything.

 ✓ The page numbers are placed into the document’s header or footer, 
so you don’t see them on the screen unless you’re using Word in Print 
Layout view. Even when you work in Draft view, the page numbers are 
still there.

 ✓ Headers and footers are parts of a page that you can format with all 
sorts of interesting elements, including your own page number style or 
even page numbers on both the top and bottom of the page. Refer to 
Chapter 14 for details.

 ✓ To change the page number format, simply choose a new one from the 
Page Number menu.

 ✓ Page numbers can be removed just as easily: See the section “Removing 
page numbers,” later in this chapter.

 ✓ See Chapter 23 for information on inserting a page number into your 
document’s text as opposed to in a header or footer.

Starting off with a different page number
You and I know that the first page of a document is page 1, but Word doesn’t 
care. It lets you start numbering your document at whichever page number 
you want. If you want to start numbering your document at page 42, you can 
do so, if you follow these instructions:

 1. Click the Insert tab.

 2. In the Header & Footer area, choose Page Number➪Format Page 
Numbers.

  The Page Number Format dialog box materializes, as shown in Figure 13-5.

 3. Click the Start At radio button and type the beginning page number in 
the box.

 4. Click OK to close the Page Number Format dialog box.

Word starts numbering your document at the specified page number. So, if 
you enter 47 in Step 3, the first page of your document is now page 47, the 
next page is 48, and so on.

When you want the page number to jump in the middle of your document 
from, say, page 5 to page 16 or (more likely) from page iv to page 1, you use 
sections to divide the document. You can start page numbering over again, 
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and at any number or in a new section. See Chapter 14 for more information 
on sections.

 

Figure 13-5: 
Gain more 

control over 
page num-
bers here.

 

Numbering with roman numerals
When the urge hits you to regress a few centuries and use roman numerals to 
tally a document’s pages, Word is happy to oblige. Summon the Page Number 
Format dialog box (refer to Figure 13-5) by following Steps 1 and 2 in the pre-
ceding section. Simply choose the style you want from the Number Format 
drop-down list.

Removing page numbers
To strip out page numbers you’ve inserted into your document, choose the 
Remove Page Numbers command from the Page Number menu (in the Header 
& Footer group on the Insert tab).

The Remove Page Numbers command rids your document of only those page 
numbers you’ve inserted by using the Page Number menu. If you’ve manually 
added a page number in a header or footer, you must manually delete it. See 
Chapter 14.

New Pages from Nowhere
As you type your document, Word keeps adding new, blank pages for you 
to write on. These pages are appended to the end of the document, so even 
if you’re typing in the midst of a chapter, the extra pages keep appearing so 
that no text is lost and nothing falls off the edge. That’s all normal and good.

For those times when you need to stick a blank page in the middle of a docu-
ment, Word provides two interesting commands. This section explains them.
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Starting on a new page
To start typing on a new page in your document, you insert a manual page 
break, or hard page break. The simplest way to do this is to press the 
Ctrl+Enter key combination. Word then begins a new page On That Very Spot. 
All text before the insertion pointer is on the previous page, and all text after-
ward is on a new page.

You can also insert a hard page break by choosing the Page Break command 
from the Pages group on the Insert tab.

  In Print Layout view, a hard page break looks like any other page break. The 
only way to know the difference is to switch to Draft view and use the Show/
Hide command (found in the Home tab and shown in the margin). In Draft 
view, the words Page Break appear before the break in your document. 
That’s your clue that you have a hard page break.

Keep these points in mind when you’re dealing with hard page breaks:

 ✓ Never, never, never start a new page by repeatedly pressing the Enter 
key until a new page pops up. That just leads to trouble later as you edit 
your document.

 ✓ Pressing Ctrl+Enter inserts a hard page-break character in your docu-
ment. That character stays there, always creating a hard page break no 
matter how much you edit the text on previous pages.

 ✓ You can delete a hard page break by pressing either the Backspace or 
Delete key. If you do this accidentally, just press Ctrl+Z to undelete.

 ✓ If you set hard page breaks, switch to Full Screen Reading view to pre-
view your document before you print it. Sometimes, the process of 
editing moves text around, making the hard page breaks unnecessary 
and awkward. Refer to Chapter 9 for more information on Full Screen 
Reading view.

 ✓ You can also insert a hard page break by choosing Breaks➪Page from 
the Page Setup group. Remember that this command is on the Page 
Layout tab, not on the Insert tab.

 ✓ Don’t fall into the trap of using hard page breaks to adjust your page 
numbering. You can use the power of the computer to alter page num-
bers without having to mess with page formatting. See the earlier sec-
tion “Starting off with a different page number.”

Inserting a whole, blank page
To shove a fresh, blank sheet of paper into the middle of a document, you 
can use the Blank Page command button, found in the Insert tab’s Pages 
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group. That command inserts two hard page breaks into a document, which 
creates a blank sheet of paper.

 I don’t recommend using this command unless you truly need a blank page in 
the midst of a document (you plan never to write on that page). Putting graph-
ics on the page is fine. Adding a table, or any other one-page element, to the 
blank page is also fine. But because the blank page is inserted by using two 
hard page breaks, writing on it leads to formatting woes down the line.

Page Froufrou
Page formatting happens above your text, below your text, to the sides of 
your text, and even behind your text. This section demonstrates the things 
you can format on a page that appear behind your words.

Coloring pages
To color your document’s pages, use the Page Color command button from 
the Page Layout tab’s Page Background group. Clicking that button displays 
a menu full of colors, some based on the document theme and some based 
on standard colors, or you can choose your own color by choosing the More 
Colors menu command. Gradients, or multiple colors, can be chosen by using 
the Fill Effects menu command.

As you move the mouse over the various colors on the Page Color menu, 
your document’s page color is updated to reflect that new color (but only 
in Page Layout view). The text color may change as well (for example, from 
black to white) to remain visible.

The color you choose is produced by your printer, but you must direct the 
printer to print the page color by following these steps:

 1. Click the File tab.

 2. Choose Options from the File tab menu.

 3. Choose Display from the left side of the Word Options window.

 4. In the Printing Options area, put a check mark by the item labeled 
Print Background Colors and Images.

 5. Click OK.

  You can now print the background color.

The color, because it’s generated by Word and isn’t part of the paper you’re 
printing on, doesn’t cover the entire printed page. That’s because your 
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printer cannot mechanically access the outside edge of a page, so a white 
border (or whatever other color the paper is) appears around your colored 
page. At this point, you need to ask yourself whether it’s easier to use col-
ored paper rather than expensive printer ink or toner.

 ✓ To remove page coloring, choose the No Color command from the Page 
Color menu.

 ✓ See Chapter 10 for information on coloring text.

Adding a watermark
When finer papers are held up to the light, they show a watermark, an image 
embedded into the paper. The image is impressive but faint. Word lets you 
fake a watermark by inserting faint text or graphics behind every page in 
your document. Here’s how:

 1. Click the Page Layout tab.

 2. In the Page Background group, click the Watermark button.

  A menu plops down with a host of predefined watermarks that you can 
safely duck behind the text on your document’s pages.

 3. Choose a watermark from the long, long list.

  The watermark is applied to every page in your document.

Sadly, you have few options for customizing the watermark. You can choose 
the More Watermarks command from the Watermark menu, which displays 
the Printed Watermark dialog box. In there, you can choose between a pic-
ture or text watermark. The picture item is handy because you can choose 
any graphical image that’s available on your computer (such as a company 
logo) to use as a watermark. The text item, however, lets you choose only 
predefined bits of text.

To rid your document’s pages of the watermark, choose the Remove 
Watermark command from the Watermark menu.

If the watermark doesn’t show up in the printed document, you may need to 
enable the Print Background Text and Images setting. Refer to the steps in 
the preceding section.
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Chapter 14

Document Formatting
In This Chapter
▶ Breaking your document into chunks

▶ Getting the most from sections

▶ Placing a cover page on your document

▶ Adding a header or footer

▶ Creating unique headers and footers

▶ Suppressing the header and footer on the first page

▶ Working with headers and footers in sections

▶ Deleting a header or footer

I don’t do much document formatting on my shopping lists or my kids’ 
 chore charts; it’s not necessary. For the important stuff — the real docu-

ments — it’s useful to employ some of Word’s fancy document-formatting 
tricks. I’m talking about big-picture stuff that includes the handy-yet-weird 
concept of sections as well as headers and footers. The formatting informa-
tion in this chapter might not be stuff you use all the time, but it’s there for 
when you need to make documents look extra spiffy.

The Oft Misunderstood Yet 
Useful Concept of Sections

Most of the Word page-formatting commands affect every page in a docu-
ment: The settings for margins, page orientation, paper size, and other types 
of formatting apply themselves not to a single page but rather to every 
dang doodle page, from 1 to N, where N is the mathematical variable best 
expressed as “I don’t know how huge this value could be.”

Sometimes, however, you need a document that isn’t formatted the same way 
page after page. For example, you may want to number pages 1–4 in Roman 
numerals and then start over on page 5 with page 1 in human numerals. Or, 
you may want the first page of a document to be an unnumbered cover page. 
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Or, you may need to display a table on page 14 in landscape orientation. All 
these tricks are possible when you understand the section concept.

Understanding sections
A section is a part of a document that contains its own page formatting. For 
example, all documents have one section. That’s the way they’re born. All the 
page-formatting commands affect all the pages in the document the same way 
because the document has only one section. That’s expected. It’s a given. But 
it doesn’t always have to be that way.

Figure 14-1 shows how a document can use two sections. The first section is 
four pages long and uses Roman numeral page numbers. The second section 
starts on page 5, where the page number format is restored to normal but 
starting at page number 1.

 

Figure 14-1: 
Document 

with two 
sections.

 i ii iii

Section 1 Section 2

iv 1 2 3 4 5 6

The document illustrated in Figure 14-2 has four sections. The first is the 
cover page, followed by a regular document format. Section 3, however, 
contains one page in landscape format. That’s followed by Section 4, which 
reverts to the regular format.

 

Figure 14-2: 
Document 

with four 
sections.

 1 2

Section 1 Section 3 Section 4Section 2

3 4 5 6 7 8 9

It if weren’t for sections, you couldn’t change the page format or the format for 
a document’s headers or footers; everything would be the same. So a section 
isn’t necessary in every document, but when you need one, it’s truly a blessing.

 ✓ A section is basically a chunk of your document where page formatting is 
different from or unique to the rest of your document.

 ✓ Text and paragraph formatting, as well as any styles you may create, 
don’t give a hoot about sections. Sections affect only page formatting. 
See Chapter 13 for more information on page formatting.
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Creating a section
Breaking up your document isn’t hard to do. Word has wisely placed all its 
breaking commands on the Breaks menu: Click the Page Layout tab and then 
click the Breaks command button, found in the Page Setup group. The menu 
is shown in Figure 14-3. Page-breaking commands are at the top of the menu; 
section breaks are at the bottom.

 

Figure 14-3: 
Ways to 

break text 
or an entire 
document.

 

The simplest way to create a new section is to choose Next Page from the 
Breaks menu. This command creates a page break, by starting a new page as 
a new section in your document.

  In Print Layout view, the section break appears just like any other page 
break. To determine whether a page break is a real page break or something 
else, you must switch to Draft view and use the Show/Hide command: click 
the Show/Hide command button on the Home tab or press Ctrl+Shift+8.

In Draft view, the section break appears with the text Section Break 
(Next Page) in the middle of a double row of dots.

After the section is created, you can then modify the page layout and format 
for each of the sections, a topic that’s covered in the next section.

 ✓ Use the Continuous section break to mix formatting styles within a page. 
For example, if you have columns of text sharing a page with regular 
text, the Continuous section break is the ideal way to separate the indi-
vidual formats. See Chapter 20 for more information on columns.
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 ✓ You can use the Even Page and Odd Page options to start the next sec-
tion on the next even or odd page — ideal for those futile times when 
you try to use Word to bind a book or pamphlet.

 ✓ Column and Text Wrapping breaks have nothing to do with sections. 
Text Wrapping breaks work like soft returns (see Chapter 2), except that 
they’re designed to be used on text that wraps around a figure or table. 
See Chapter 20 for information on column breaks.

Using a section
To apply a specific page format to one section only, use the dialog box asso-
ciated with the format, such as the Page Setup dialog box. In the dialog box, 
look for the Apply To drop-down list. To apply the format to the current sec-
tion, choose This Section. That way, the format controls only the pages in the 
current section.

 To determine which section you’re in, right-click the status bar (at the bottom 
of Word’s window). A pop-up Status Bar Configuration menu appears. Near 
the top, you see the item named Section, and on the right you see the cur-
rent section number. To see that information always displayed on the status 
bar, choose Section from the menu; otherwise, press the Esc key to make the 
pop-up menu go away.

Deleting a section break
A section break is just like a character in your document. To delete the break, 
you can use the Backspace or Delete keys. For example: Position the inser-
tion pointer just before the section break and then press the Delete key. This 
technique works best in Draft view with the Show/Hide command working to 
display the section breaks.

 ✓ The Show/Hide command’s keyboard shortcut is Ctrl+Shift+8.

  ✓ Deleting a section removes any formatting, including headers and foot-
ers, that were unique to that section.

 ✓ If you accidentally delete a section break, you lose any special format-
ting you applied to the section. In this case, press the Undo shortcut, 
Ctrl+Z, before you do anything else.
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Add a Cover Page (Sneaky and Quick)
I’d guess that the most popular use of section breaks is to thwack down a 
title or cover page to a document. Typically, you don’t want page numbers 
or header or footer information on the title page, so making that page its own 
section is ideal. But conniving Word to create a single page section and then 
fussing with headers and footers isn’t anyone’s idea of a fun time. Therefore, 
it pays to use Word’s Cover Page menu. Here’s how it works:

 1. Click the Insert tab.

 2. In the Pages group, click the Cover Page button.

  A fat, fun menu full of various cover-page layouts appears.

 3. Choose a cover-page layout that titillates you.

  That cover page is immediately inserted as the first page in your docu-
ment. Then Word displays it onscreen for further editing.

 4. Click the bracketed text on the cover page.

 5. Type the required replacement text.

  For example, click [Type the document title]. Then type your 
document’s real title. The text you type replaces the bracketed text.

 6. Repeat Steps 4 and 5 until the cover page looks the way you like it.

You can change a cover page at any time by choosing a new one from the 
Cover Page menu, although I recommend removing the old one first: To 
remove a cover page you’ve inserted, choose the Remove Current Cover Page 
command from the Cover Page menu. It helps to have the insertion pointer 
on the cover page to delete it.

 ✓ The Cover Page menu doesn’t create a new section in your document. 
If you’re using headers and footers, they appear on the inserted cover 
page. To avoid this situation, position the insertion pointer at the top 
of page 2 (after the cover page), and from the Page Layout tab, choose 
Break➪Continuous. You can then modify the header and footer as 
described elsewhere in this chapter.

 ✓ As you learn more about Word, you can even modify or add elements to 
the cover page after it’s inserted. Refer to Chapter 22 for more informa-
tion about Word’s drawing commands.

 ✓ Leaving the bracketed text on your title page is tacky. Your boss doesn’t 
want to see a report that has [Company Name] on it rather than your 
company’s real name.

20_487723-ch14.indd   17720_487723-ch14.indd   177 3/27/10   10:44 AM3/27/10   10:44 AM



178 Part III: Formatting 

Headers and Footers
Documents can have headers and headings, footers and footnotes. You can 
easily confuse things — until you read these handy bullets and peruse this 
section.

 ✓ A header is text that appears at the top of every page. It’s contained in a 
special, roped-off part of the page where you can place special text.

 ✓ A heading is a text style used to break up a long document, to introduce 
new concepts and help organize the text. See Chapter 15 for more infor-
mation on headings.

 ✓ A footer is text that appears at the bottom of every page. Like the 
header, it has its own, special area and contains special text.

 ✓ A footnote is a tiny bit of text that appears at the bottom of a page, usu-
ally a reference for some bit of text on that page. See Chapter 21.

 ✓ Headers and footers contain elements such as your name and the 
document name and the date, page number, title, and phone number. 
(“Hurry! Buy now! Operators are standing by!”)

 ✓ Headers can also be called eyebrows. Weird, huh?

 ✓ Footers can include page numbers, a chapter or document title, and soft, 
cushiony insoles.

The following sections refer to both headers and footers. Even when the 
information appears to be about only the header, it also applies to footers.

Adding a header or footer
You can use a header. You can use a footer. You can use them both. You can 
use neither. Either way, the technique is the same:

 1. Click the Insert tab.

 2. From the Header & Footer group, choose the Header button.

  A list of preformatted headers is displayed.

 3. Choose the format you want from the list.

  The header is added to your document, saved as part of the page 
format.

  If Word is in Draft view, it immediately switches to Print Layout view so 
that you can edit the header. (Headers and footers don’t appear in Draft 
view.)
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  Notice the new tab on the screen? When you’re editing a header, the 
Header & Footer Tools Design tab appears. Refer to the following section 
for details.

 4. Click any bracketed text.

 5. Type the required replacement text.

  For example, replace [Type text] with the title of your document.

 6. Repeat Steps 4 and 5 for all bracketed text in the header.

  7. When you’re done, click the Close Header and Footer command button 
in the Close group on the far right side of the Ribbon.

In Print Layout view, you can see the header or footer displayed in ghostly 
gray text. In Draft view, you can’t see a header or footer, even though it’s still 
there. (You can also use Full Screen Reading view, as covered in Chapter 9, to 
see the header or footer.)

 ✓ You can also exit from editing a header by double-clicking the mouse in 
the main part of your document

 ✓ You don’t have to go to page 1 to insert a page number in the header. 
Word is smart enough to put the proper number on the proper page, no 
matter where you’re editing the header in your document.

 ✓ Headers and footers are geared to sections in your document. 
Therefore, as long as you’re in the same (or only) section, you can edit 
the header or footer for that section.

 ✓ The Header and Footer command buttons are found on the Insert tab, 
not on the Page Layout tab.

Editing a header or footer
Face it: Word’s preset designs for the header are dull. Splashy, but dull. And, 
chances are good that they don’t contain all the information you want or 
need. That’s no problem. You can edit the header using what Word created 
as a starting point, or you can just quickly whip up your own header. It’s 
easy. Here’s how:

 1. Click the Insert tab.

 2. In the Header & Footer group, choose Header➪Edit Header.

  When you edit the header, Word tosses you into a special mode of 
operation. The header appears on the screen as part of the page in Print 
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Layout view. Plus, the Header & Footer Tools Design tab appears with 
groups customized for creating and editing headers.

 3. Use the Go to Header or Go to Footer command button to switch 
between the header and footer for editing.

 4. Edit or modify the header.

  Items in the header are edited just like anything else in Word. You can 
add or edit text and format that text by using any of Word’s text- and 
paragraph-formatting commands, including tabs. (See Chapters 10, 11, 
and 12.)

  You can modify any graphics in the header, although I recommend that 
you read Chapter 22 before doing so.

  Word preformats headers with center and right tabs at the center and 
far right side of the page. You can then press the Tab key and type some 
text to have the text automatically centered at the bottom (or top) of the 
header or footer.

 5. Use the command buttons on the Design tab’s Insert group for special 
items.

  Here are some of the more useful special items you can insert into a 
header (the inserted items appear wherever the insertion pointer is 
located):

 • Page number: Choose Quick Parts➪Page Numbers and choose 
a page number format from the list. The page number text then 
appears in the header. If you want to center the page number, 
press the Tab key and then insert the page number.

 • Date & Time: Clicking the Date & Time button displays a Date and 
Time dialog box, which lists various date, time, and combination 
formats. Choose one and then click the OK button to insert that 
date or time text into the header.

 • Graphics: Use the Picture button to browse for graphical images 
on your PC’s hard drive, which you can insert into the header. Or 
use the ClipArt button. Be sure to brush up on graphics in Word by 
reading Chapter 22 first.

 • Fields: The most versatile thing you can insert into a header or 
footer is a field; choose Quick Parts➪Field from the Insert group. 
Fields, however, require extra explanation. Refer to Chapter 23 for 
details.

  6. Click the Close Header and Footer command button when you’re 
done.

  You’re back in your document.
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The header is the same on every page in your document. Word is happy to 
oblige, however, whenever you want a different header, such as for the first 
page or alternating pages or for different sections in a document. The last few 
sections in this chapter explain the details.

 ✓ In Print Layout view, you can quickly edit any header or footer by dou-
ble-clicking its ghostly gray image.

 ✓ If you need a header only for a page number, I highly recommend using 
the batch of page-numbering tricks I cover in Chapter 13 as an easier 
alternative to working with headers directly.

Making odd and even headers or footers
This book is formatted with odd and even headers: The header on the odd 
(left) pages contains the page number and then the part number and title. On 
the (right) even pages, the header shows the chapter number and title and 
then the page number. You can pull off this type of trick in your document as 
well.

To force Word to accept odd and even headers, obey these steps:

 1. Click the Insert tab.

 2. From the Header & Footer group, choose Header➪Edit Header.

  The Header & Footer Tools Design tab is displayed on the screen.

 3. Click to put a check in the box by Different Odd & Even Pages, found 
in the Options group.

  This step tells Word that you want two sets of headers: one for odd 
pages and one for even pages. Notice how the tag identifying the header 
changes:

  The tag tells you which header you’re editing; in this case, it’s the Odd 
Page header.

   

 4. Create the header for the odd pages.

  Refer to the preceding section for notes on making a header or footer. 
Remember that the footer can contain any formatted text you would oth-
erwise stick into a Word document.
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 5. Click the Next button, found in the Navigation group.

  Word displays the even page’s header, allowing you to create or edit its 
contents. The Header tag changes to reflect which header you’re editing:

   

  By the way, you click the Next button to move from the odd header to 
the even header. You must click the Previous button to return to the 
odd header from the even header.

 6. Click the Go To Footer button to edit the footer’s odd and even pages.

  Edit the footer’s contents and click the Next button to ensure that you 
work on both the odd and even footers (as you do in Steps 4 and 5 for 
the header).

 7. Click the Close Header and Footer button when you’re done.

Removing the odd/even header option is as simple as deselecting the 
Different Odd & Even Pages option in the Options group (the opposite of Step 
3). When you do that, the even-page header and footer are deleted, leaving 
only the odd header and footer.

Removing the header and 
footer from the first page
Most people don’t want the header or footer on the first page, which is usu-
ally the title page or a cover page. Suppressing the header for that page is 
easy. Just follow these steps:

 1. Click the Insert tab.

 2. From the Header & Footer group, choose Header➪Edit Header.

 3. In the Options group, select Different First Page.

  You see the Header tag change to First Page header, and the Footer tag 
change likewise. That’s your visual clue that the first page of the docu-
ment sports a different header from the one in the rest of the document.

   

  You can still edit the First Page header, if you like. It’s merely different, not  
necessarily empty.
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Working with headers and 
footers in document sections
Just as Superman is limited in his powers by the crippling force of kryptonite, 
the mighty header is limited in its scope and power by the limiting force of 
the document section. A header, or footer, can exist within only one section. 
Creating a new section creates a new set of headers and footers.

Word flags each set of headers and footers in the tag just below or above the 
header or footer area, such as this:

   

  This tag helps you determine which section’s header or footer you’re editing.

To switch to the next section’s header, click the Next button.

To switch to the previous section’s header, click the Previous button.

 A source of frustration with multiple sections exists when you use the Link to 
Previous option. What this option does is set one section’s header to match 
the previous section. That way, you can keep the same header in multiple sec-
tions. For example, sometimes you merely want to change the page orienta-
tion, not the header, in the middle of a document. At other times, the Link to 
Previous button may be source of frustration because it causes changes made 
in one section to be either replaced in another section or ignored.

As a hint, when the Link to Previous option is selected, the header is tagged 
on the left side with the following:

  That’s a big clue to why you may be unable to edit a header, when such a 
thing causes you frustration.

    

 ✓ A header is a section-long element. By placing multiple sections in your 
document, you can have multiple headers. Refer to the first part of this 
chapter for information on sections.

 ✓ You use multiple sections to change headers throughout a document or 
to suppress the header on a single page and then “pick it up” again after 
that page.
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 ✓ To suppress the header on the first page of a document, follow the 
instructions in this chapter’s earlier section “Removing the header and 
footer from the first page.”

 ✓ Changing a header in one section doesn’t affect any other section in the 
document — unless you’re using the Link to Previous option.

 ✓ When you have selected the Different First Page option (as you do in the 
earlier section “Removing the header and footer from the first page”), 
note that each section has its own first-page header and footer, which 
are different from (and separate to) the other headers in that section.

 ✓ The Different Odd & Even Pages option affects all sections of a document.

Removing a header or footer
The simplest way to remove a document header is to use the 
Header➪Remove Header command. Here’s how it’s done:

 1. Open the page where the header exists.

  Use Print Layout view for this step so that you can see the ghostly image 
of the header at the top of the page.

 2. Click the Insert tab.

 3. From the Header & Footer group, choose Header➪Remove Header.

  The header is gone.

This trick removes only the header for the current section. To remove head-
ers in other sections, you must repeat these steps when the insertion pointer 
is in that section.

To remove a footer, choose Footer➪Remove Footer in Step 3.

Another way to remove a header is to delete all text in a header: Press Ctrl+A 
to select all the text when editing the header, and then press the Delete key. 
Poof! The header is gone.

 I recommend removing the header on any pages in your document that 
change orientation. That’s because the header prints on the “wrong” edge 
of the page, which is inconsistent with the rest of the document. Because 
the page (or pages) with a different orientation is in its own section anyway, 
simply delete the header for that section. Then the reoriented pages can con-
tinue with headers and footers throughout the rest of the document.
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Chapter 15

Word Formatting Styles
In This Chapter
▶ Understanding styles

▶ Using Quick Styles

▶ Finding where Word hides styles

▶ Switching between style sets

▶ Removing styles

▶ Creating your own styles

▶ Modifying styles

▶ Assigning a style shortcut key

▶ Organizing styles between documents

I assume that some people never format their documents. That’s okay. 
Boring, but okay. Other people format every detail of every document, 

using just about all the formatting commands available in Word. It’s those 
folks for whom I write this chapter. That’s because Word employs something 
called styles. You can use preset styles to instantly format your prose. Or, if 
you fancy creating text formatting, you can make your own styles. It’s easy, 
and it’s a powerful way to instantly change the look of your entire document.

The Big Style Overview
Styles are a traditional ingredient of the word processing stew, designed to 
save you formatting toil. The idea is to save time. So when you change your 
mind and decide that you want all figure captions in your document to be 
left-aligned rather than centered, you make only one change and it’s done. 
That’s the beauty of styles.

 ✓ A style is nothing more than a clutch of text and paragraph formats. You 
give the style a name, and then you use it to format your text. Or, you 
can format your text first and then make a style to match.

21_487723-ch15.indd   18521_487723-ch15.indd   185 3/27/10   10:43 AM3/27/10   10:43 AM



186 Part III: Formatting 

 ✓ In addition to the formatting information, styles have names. The names try 
to give you a clue to how to use the style, such as Heading 1 for the docu-
ment’s first heading, or Caption, which is for figure and table captions.

 ✓ All text in Word has a style. As configured, Word uses the Normal style 
to format text. Unless you specify otherwise, Word uses the Normal 
style — typically, the Calibri font, 11 points, left-aligned paragraphs, 
line spacing at 1.15, and no indenting, with 10 points of air after each 
paragraph.

 ✓ Styles are part of the document template. See Chapter 16 for more 
information.

 ✓ Using styles is optional. They do, however, make formatting your docu-
ments easier.

Understanding style types
Word sports five different types of styles, each customized to format a differ-
ent document element in Word:

  ✓ Paragraph: The paragraph style contains both paragraph and text for-
matting attributes: indents, tabs, font, text size, — you name it. It’s the 
most common type of style.

  ✓ Character: The character style formats only characters, not paragraphs. 
All character formatting mentioned in Chapter 10 can be stuffed into a 
character style.

  ✓ Linked: The linked style is a combination style that can be applied to 
both paragraphs and individual characters. The difference depends on 
which text is selected when you apply the style.

  ✓ Table: The table style is applied to tables, to add lines and shading to 
the table cells’ contents. Refer to Chapter 19 for more information on 
tables in Word.

  ✓ List: The list style is customized for presenting lists of information. The 
styles can include bullets, numbers, indentation, and other formats typi-
cal for the parts of a document that present lists of information. See 
Chapter 21 for info on lists.

These style types come into play when you create your own style as well as 
when you’re perusing styles to apply to your text. For example, if you want 
to create a new look for tables in your document, you make a Table style. Or, 
when you want a style to affect only text and not paragraphs, you create a 
Character style.
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